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Welcome to Photopia! 
Photopia is more than a slide show program. It’s video creation software with automated and advanced tools 

to create amazing videos for any occasion. 

Creating beautiful videos is fast and easy with a slide show creation Wizard, Templates, and pre-designed 

Slide Styles / Transitions for almost any occasion. Audio can be added from your own collection or from the 

built-in royalty-free Music Library. Photopia also provides more advanced options for direct control over 

everything from Layer Keyframes and Adjustments to audio fades and video trimming. 

This guide explains the easiest methods for creating videos then moves on to the advanced options that 

provide precise customization. No matter which method you choose, it’s easy to create stunning videos with 

Photopia. It’s even possible to use both methods in the same slide show. 

Coming to Photopia from ProShow 
Photopia was created by some of the original ProShow developers, giving them a chance to expand their 

innovative technology and features to a new platform.  

If you are a seasoned ProShow Producer user, you will find Photopia has most of the same tools as Producer, 

plus a whole lot more! 

If you were using ProShow Gold, you will find a lot of new features in Photopia. Some of these tools and 

features may be unfamiliar (ex. keyframes, masking) but in time you will probably wonder how you ever got 

along without them! 

If you were creating show with ProShow Gold, you will be jumping over ProShow Producer features to come 

right into Photopia There are a lot of tools and features that you will be unfamiliar with (keyframes, for 

example) but in time you will probably wonder how you ever got along without them! 

Product 
Comparison 
 

 Photopia includes all the 

advanced animation tools 

(Keyframes, Motion Easing, 

Masking Layers, Adjustment 



Layers) in both Director and Creator along with the ability to import Templates, Styles, and Transitions from 

third-party vendors. 

Here is a chart covering some of the key differences between Director and Creator along with how those 

features compare to ProShow. 

Starting with The Wizard 
The Wizard is a tool designed to automate the process of creating a slide show.  

A slide show made using the Wizard can be published right away or it can become the starting point for 

further customization. 

 

Starting a New Project 
Click the New Slide Show button 

from the home screen then 

choose the Wizard option in the 

New Project window. 

In this window you will want to 

give your show a Title (this can 

be changed later) and choose an 

Aspect Ratio. If you are usure 

which Aspect Ratio to use, just 

keep the 16:9 default, which is 

used for most widescreen 

monitors and TVs. 

 

 

 

There are options for 

Tags, Keywords and a 

Save location at the 

bottom of the New 

Project window. 

These are optional 

organizational tools 

that can be helpful as 

your collection of slide 

shows grows. Click the 

Create button when 

you are ready to start 

your new slide show. 



 

 

 

 

 

Welcome Window 
 

The next window is a 

Welcome screen that 

provides basic information 

about the Wizard. If you 

do not want to see this 

welcome screen each time 

the Wizard is opened, 

uncheck the “Show 

Introduction…” option at 

the bottom of the window. 

 Click the Continue to 

Wizard button to move to 

the next window. 

 

 

 

 

 

Choose your Theme 
The Select Theme 

window contains a list of 

installed Themes. Themes 

are groups of effects 

(Slide Styles and 

Transitions) the Wizard 

will use to create your 

show. 

Themes are grouped into 

categories listed on the 

left. Each individual 

Theme will display a 

thumbnail and 



description. You can search for a specific Theme using the Search bar at the top. 

Once you have a Theme selected, click the OK  

Wizard Settings 

 

This window has three sections listed on the left: Settings Content, and Music.  You’ll go through each of 

these to determine how the Wizard will build your show. 

The Wizard Settings window allows you to determine how the Wizard will build your show, by setting specific 

parameters. 

Theme – The current Theme is shown along with a Change button if you would like to select a new Theme. 

Grouping – Enable this option to let the Wizard group adjacent images into a single slide. 

Order – Enable this option to let the Wizard randomly determine the order of your images and videos. To 

manually determine the order of your images, this option should be disabled. 

Pacing –This option controls the pace, or speed, of the slide show. A lower Pacing value (below 100%) results 

in a slower slide show (longer slides) while a higher value creates a faster show (shorter slides). 

Audio Syncing – This option ensures the entire show fits the exact length of the Soundtrack. Note that the 

Audio Syncing option overrides the Pacing option when a Soundtrack is provided. The pace of your show, 

when Audio Syncing is enabled, is determined mathematically by the length of your soundtrack and the 

number of slides that must fit that length. 

UI Layout (lower left corner) –This option determines the UI Layout the program will use after the Wizard has 

successfully created (or updated) the slide show. 



When you are ready to add Content, click the Next button. 

 

Add Content (images, video, captions) 
 

The next window is 

where you will add 

image, video, and 

caption Content. 

Click the Add 

Photo / Video 

button to add 

images / videos or 

the Add Title 

button to add a 

title slide. All other 

options at the top 

are disabled until 

there is content in 

the show. 

 

 

 

Selecting the Add Photo / Video button opens the Browser window. Use the folder list on the left to navigate 

through your computer and select the folder that contains your images. Select one or more images / videos 

and click the OK button to add the selected image(s) / video(s) to your slide show. To add additional images 

or video files from other folders, click the Add Photo / Video button again. 

 

 

 



 

 

There are several options to customize your content before any Slide Styles / Transitions are applied. 

 

Re-arrange – Content can be re-arranged by clicking and dragging to a new position. 

 

Rotate – Content can be rotated in 90-degree increments. Click on the image that needs to be rotated then 

click the Rotate button. Each click rotates the image 90 degrees. 



 

 

Title Slide – Click the Add Title button to add a title slide. This is a text-only slide. Title slides are often 

included at the beginning / ending of a slide show and can also be used as section dividers. You will be able to 

customize the caption (font, color, etc.) after the Wizard has applied effects. Note that the Wizard will apply 

Slide Styles that match the number of captions in the Title slide and most Themes do not include Slide Styles 

with more than two captions. This also applies to Images / Videos with Captions. 

 

Captions – Select an Image / Video, then click the Captions button add a caption to that image / video. The 

same basic rules that apply to Title slides also apply to Captions on images / videos. You can add as many 

Captions as you’d like but most Themes will only include Slide Styles with one or two captions. 



 

Select Style – Click the Select Style button to manually apply a Slide Style to the selected content. The Wizard 

will not apply a new Slide Style to any Content with a manually applied Slide Style. This allows you to control 

which effects are used for certain content. 

You can apply specific Slide Styles to single images or 

groups of images. When applying a Style to multiple 

images, the images must be adjacent to one another 

and selected when the Slide Style button is clicked. 

 

 

 

 

 

 

 

Images in a multi-image Slide Style will be grouped 

in the Content list with the name of the applied 

Slide Style shown below the group. 

 

 

 

 

 

 

 

 



 

Manually applying a Slide Style can also be useful for video files when you want to make sure they are 

displayed full screen, instead of having a Style applied to them. 

 

Select your video file from the 

Content list, then click the Select 

Style button and choose the No Style 

option from the list of Slide Styles. 

Click the OK button and your video 

will then show that it has No Style 

applied, indicating that the Wizard 

will not apply a Slide Style to that 

video. 

 

 

 

 

Remove Style – This option 

removes any applied Slide 

Style. 

Delete – This option 

removes the selected 

content. 

Randomize – This option 

puts the selected content in 

a random order. If only one 

piece of content is selected, 

the entire Content list will 

be randomized.  

Trim Video – This option 

opens the Trim Video 

Window allowing the 

beginning / ending of the 

video to be removed. 

 

 

 

 

 



Add Your Music 
The next screen is where you will add your music. 

 

The suggested length at the top of this window shows how much music would be necessary to fill the slide 

show using the Pace you set earlier. This is only a suggestion. Using more or less music will simply make the 

slides go slower or faster (assuming the Sync Audio option is enabled). 

Click the Add Audio button to add audio tracks to your slide show. There are buttons to the right for 

duplicating, removing, previewing, and editing your audio track (in an external editor). 

Below the list of audio tracks are Fade In, Fade Out, and Cross Fade times for the audio tracks in your slide 

show. The default Fade In and Fade Out times are 0.10 seconds, which is appropriate for untrimmed songs. 

The default Cross Fade time is 2 seconds. This option, which only applies if you have more than one song, 

controls how much adjacent audio tracks overlap. When the Cross Fade is zero there can be silence between 

adjacent untrimmed audio tracks, since many audio tracks include a small amount of silence at the beginning 

/ ending. 

The Estimated Show Duration is below the fade times and includes the number of photos / songs along with 

the targeted show / music duration. These values update as audio tracks are added / removed. 

 

At the very bottom of this window, on the left-hand 

side, is a dropdown menu for the UI Layout that will be 

used when the Wizard is finished. Jump ahead to learn 

more about User Interface Layouts.  

When you are ready for the Wizard to build your show, click the Build button in the lower right-hand corner. 



 

Build and Preview the Slide Show 
 

Once the slide show has 

been built, you may 

want to make further 

changes before moving 

on to the main Photopia 

UI. There are two 

options to accomplish 

this task. 

 

Run the Wizard Again 

will reapply the same 

Theme to your content, 

which may result in 

different Slide Styles / 

Transitions being 

applied. This option is 

best if you like the 

Theme but want to see a 

different arrangement.  

Return to Wizard will take you back to the beginning of the Wizard, allowing you to start over again with a 

new Theme and new content. 

Apply + Continue will take you to the main Photopia UI, using the UI Layout chosen in the previous window. 

If you like the slide show the Wizard created, choose Apply + Continue. Once you are in the main Photopia UI 

you will be able to make a wide variety of further changes to your slide show. 

Customize Your Show 
 

After the Apply + Continue button is selected your 

slide show will open in the main Photopia UI. 

Nearly every aspect of a slide show can be changed 

from the main UI. Here are some examples: 

• Change the order of your slides  

• Apply different Slide Styles 

• Change the font and color of your captions 

• Choose different transitions 

• Change the slide and transition times. 

 

Once you are happy with your show, click on the Publish button in the upper right corner. 

 



Publish Your Show 
There are many Publish Options in Photopia. You can turn your slide show into a Blu-ray, DVD, video file, 

Stand Alone Show, and even output to a variety of social media services. If you are not sure what output 

format to choose, start with an MPEG-4 video file. The MP4 video format is one of the most widely supported 

output options available. 

Create Your Own Show, Fast 
Using only the basic features of Photopia, you can create a simple but beautiful slide show in a matter of 

minutes. This is a great way to start learning Photopia, mastering the basic features first, then moving on to 

more advanced features when you are ready. 

Start a Project 
Photopia Director will always launch to the Home Page. Eventually, this is where you will see a list of the 

projects. Starting a slide show does not require using the Wizard. You can also create a Blank Show, use a 

Template, or even Import an existing slide show. Click the New Slide Show button in the upper left-hand 

corner to get started. You will then see three options to start a new show, plus an option to import and 

convert a ProShow Show. 

 

We are going to keep it simple and start with a Blank 

Show. Give your show a title and disregard all other 

settings for now (learn more about Tags and Keywords 

here). 

 

 

 

 

 

Change the UI Layout (optional) 

When you first launch Photopia, you will come into the 

Advanced User Interface Layout. While this is where all the 

fun stuff is, (keyframes, groups, masks, and more!), all those 

advanced features can be overwhelming, at first. If this is 

your first show in a slide show program, it is recommended 

that you start in the Basic UI Layout. 

 

At the top of the screen, you will see a UI Layout button. Click this button and choose the Basic option. The 

user interface will appear less cluttered, with only a Preview / Browser window, a Slide List, and an 

information tab. 



Add Images 
You will add images and video to your slides by locating them in the Browser window. Use the file tree on the 

left-hand side of the Browser to find the folder that has your images. 

 

 

If you are working on a Mac, note that you may need to click the message in the lower-left corner of the 

Browser to mount the folder you intend to use. 

 

You can add your images one at a time by either dragging your image onto a slide marker, or by double 

clicking on your image to add it to the next slide. 



 

To add images to multiple slides, hold 

down the CTRL (or CMD) key while 

selecting them in your Browser (shown 

left), then release the CTRL (or CMD) key, 

then drag-and-drop them into the slide list 

(shown below). 

 

 

 

 

 

 

 

Multiple images can be added to a single slide by holding down your CTRL (or CMD) key to select your 

images, then continue to hold your CTRL/CMD key as you drag and drop them all into a single slide (shown 

below). 

 



Add Captions (Optional) 
 

 

Select the slide you would like to add your 

Caption to and click on the Captions button 

just below the Preview window. Enter your 

caption into the text box that pops up and 

then click Done. 

 

 

 

 

 

 

 

 

 

 

 

 

If you have added any Captions to your slide, be sure to look for Slide Styles that show the same number of 

Caption Layers that you added. Once you have applied a Slide Style, you can set the font and size of your 

caption. 



 

You can change various caption 

attributes, such as the Font, Size, 

or Color by clicking on the 

Content Tab, then selecting your 

Caption Layer.  

 

 

 

 

 

 

 

 

Apply Slide Styles and Transitions 
Slide Styles are pre-animated effects that you can add to your slides.  

Select a slide and click on the Slide Style Tab in the right-hand panel. 

 



 

Categories of Slide Styles are on the left, individual Slide Styles are on the right, with a Search Bar at the top. 

You will want to find Slide Styles that use the same number of images as your slide. If you only have one 

image in a slide, make sure you are applying a Slide Style that uses only 1 layer. If your slide has 3 images, 

look for Slide Styles that use 3 Layers. You can use the Filter option to show only the Styles that use the exact 

number of layers and captions that you have in your slide. 

You can see what your slide will look like with the selected Slide Style applied by clicking the Preview button. 

Once you have the Slide Style you want to use, click Apply. 

 

 

 

 

 



 

 

The default Transition between slides is a blend (or fade). Click on any transition in the slide list to change 

that Transition. This will bring up the Transitions window where you can search for, and preview, Transitions 

in the same way as Slide Styles. Categories are listed on the left, individual Transitions are on the right, with a 

Search bar at the top. The preview option for Transitions is a bit different than it is for Slide Styles. Instead of 

a Preview button there is a ‘play icon’ shown just below the preview area in the Transitions window. The 

same Apply button is used for both Slide Styles and Transitions. 

Add Your Soundtrack 
Photopia includes an extensive royalty-free Music Library. You can use these songs in slide shows that are 

shared on social media websites. You can also add music files from your computer. If you use a copyrighted 

song form your computer, and do not have a license to share that song, you may find that your slide show is 

removed / modified on social media websites. 



 

Click the Add Audio button to bring up the Add Audio Track(s) window with the Photopia Music Library 

selected. There are categories on the left to help you find just the right style of song for your show. Songs can 

be previewed by selecting them then clicking the ‘play icon’ just above the list of tracks. Note that you must 

be connected to the internet to add and preview songs from the Photopia Music Library if they have not 

already been downloaded. When you have selected a song, click the OK button (or double click the song) to 

add it to your slide show. 

Adding a song from your local computer can be done from the same window. Click the ‘computer icon’ in the 

top-left corner of the Add Audio Track(s) window, then use the folder list to search for the audio file you 

want to use. Select your audio file and click the OK button to add that track to your slide show. 

 

Adjust Your Timing (Quick Sync) 
You can adjust the timing of your Slides and 

Transitions to better fit your Soundtrack in several 

ways. Photopia can mathematically adjust your Slide 

and Transition times to match your total Soundtrack 

time using Quick Sync. Click on Tools > Quick Sync – 

Entire Show. This will modify your slide / transition 

times to make the total number of slides match the 

total Soundtrack duration. You can also Quick Sync 

Selected Slides. Learn more about Quick Sync. 



You can also manually adjust slide / transition times to 

better match your slides, and the layers therein, to your 

Soundtrack. In this way you can push slides backward / 

forward in time to better align your slides to certain parts 

of the songs in the slide show. 

The number boxes beneath the Slides and Transitions 

accept numbers down to 1/100th of a second. 

 

For a more visual method of adjusting the Slide and 

Transition times to match your music, use the Timeline 

View. Note that the Timeline is only available in the 

Advanced and Compact UI Layouts. 

 

Publish Your Show 
When you are happy with your slide show, you are ready to Publish it! Click on the green Publish button in 

the upper right corner to choose a publishing option. 

 

Different publishing option categories are available on the left. When you select an option, more detailed 

information about that option will appear on the right. When you have found a publishing option you would 

like to use, hit Create. 

This has been a basic overview of the slideshow creation and output processes in Photopia. Continue reading 

for further information about how Photopia works including what options are available, where to find those 

options, and how to use them. 



Learning Photopia from the Ground Up 
In previous chapters, you learned how to create a slide show quickly using either the Wizard, pre-designed 

Slide Styles, or a combination of both. The speed at which you can create this type of show is largely 

dependent on the program doing most of the work for you. It also means you have little control over the 

details in your show, individual slides, or music timing. After creating some shows with the faster methods, 

you might be ready to customize those shows even further, or you may be ready to build your own 

animations from the ground up. 

To do this, it is best to learn everything, from the ground up, to make this process easier. All the features, 

tools, and workspaces in Photopia are connected to one another. While you may be tempted to find a single 

answer to a single question, you will often find that you also need to learn something else that your question 

was connected to so that you can fully implement your vision. 

Important projects on tight deadlines are NOT a good starting point for this learning process. 

Photopia is a very robust program that cannot be mastered in a day or two. Give yourself plenty of time to 

play with all the features, learn the best workflow that fits your style, and you will be creating unique and 

beautiful shows in no time. 

Let’s start with the basics. 

The Home Page 
The Home Page is where you will start each time you launch Photopia. This is where you will find a list of all 

your Projects, the latest News from Photopia, options to import projects and shows, manage your effects, 

and check for Photopia updates. 

 



Top Icons 
At the very top of the Home Page, you will find four buttons.  

 

New Project is how you will start a new Project, of any kind.  

Import allows you to load a single file, including ProShow Shows, ProShow effects, and of course Photopia 

Projects and Effect. Once imported, the slide show will be in the list of projects and can be opened from that 

location for further editing.  To import multiple Effect files at a time, use the Manage Effects Window. 

Manage Effects opens the Manage Effects window.  

Help gives you access to online Video Tutorials as well as the Photopia User Forum and this User’s Manual. 

Hamburger Menu 
In the upper right corner of the Home Page, you will see three lines. Clicking on 

these lines gives you quick access to your Photopia Preferences, Importing 

ProShow Files, Help Options, About Photopia Information (such as the current 

build number), entering your Registration, checking to see if there are updates, 

and Export/Import Library options for transferring Projects from one computer 

to another, including Windows to Mac and vice versa. 

 

 

 

Import from ProShow 
 

This window gives you two options to import 

your ProShow files. 

Import ProShow Effects will import all 

currently installed ProShow effects into 

Photopia. If you have ProShow effects that are 

not current installed on your computer, they 

will not be imported through this option. A list 

of all the ProShow files Photopia can see is 

included. If you have a lot of ProShow files, 

this option may be the easiest to choose but it 

may also take some time to complete. 



Import ProShow Files allows you to import your ProShow Project or Slide Show files, but not effects. If you 

would like to import individual ProShow effects, use the Import button at the very top of the Home Page or 

the Import button in the Manage Effects window. 

Help 

 

The Help Center window includes the following options. 

Open User Manual – click this Open button view the interactive online manual. 

Watch Video Tutorials – click this Watch button to see a list of video tutorials that will play right from inside 

Photopia, or you can use the link at the bottom to watch them online. 

Watch 3rd Party Video Tutorials – These tutorials, from Choice Slides, are less formal in nature and will give 

more show building advice from the perspective of a professional video editor. 

Community – click this Visit button to see the online Photopia Forum where you can communicate with 

other Photopia users about your slide shows, using the program, and other topics as well. 

 

What’s New – this is a list of all updates to the program, including new features and bug fixes. 

 

About Photopia Director 
If you need to find the version number of the build you are using, it is on the About page. You will also find 

the name that your program is registered to, along with the Registration ID. 

Enter Registration 
You must be connected to the internet to use this feature. This option will let you enter a Photopia 

registration key to get the program activated. 



 

Check for Updates 
You must be connected to the internet to use this feature. This option will tell you if you are using the most 

current version of the software or if there is an update for you to download and install. If there is an update 

available, a full list of additions and changes will be displayed. 

 

 

Import / Export Libraries 
These options allow you to export entire libraries (Projects, Styles, Transitions, Wizard Themes, etc.), to 

transfer them to another computer, including moving from one platform to another (Windows and Mac). 

 

After selecting the Export Library option, 

Photopia will scan all your projects. In the 

next window you will see a list of Projects 

and Effects on the left. When Shows is 

selected (shown left), the right side of the 

screen will show your Project Groups and 

individual projects.  

 

 

 

 

 

 

 

 

When an Effect type is selected (shown right), you’ll 

see categories on the left and individual effects on the 

right.  Everything installed in your program is selected, 

by default.  If you only want to export a few items, first 

choose Select None above the Projects and Effects list. 

Then go through individual types of projects and 

effects, selecting categories, and either check 

individual effects, or select all effects in that category 

by clicking on Select All at the bottom of the effect list.  

A white box in the Projects and Effects list indicates 

that no files in that category will be included in the 

Export.  A gray box indicates that some items were 



selected to be exported, but not all items in that category.  A blue check mark means everything that is in 

that Project or Effect type will be included in your export.  

There are options at the bottom of this window to include Backups and Split larger files for easier transfer. 

Once you have selected the projects and effects you would like to export, click the Ok button, then choose a 

location and file name for the archive to be saved. 

. 

 

After you have moved the Archive file to another computer, 

you can import the Projects and Effects in the same 

manner. Choose Import Libraries from the Hamburger 

Menu. Browse to find the Archive File that you exported 

(shown left). After the Archive has imported you will see all 

the categories and individual files inside the Archive. You 

can choose to import everything by leaving the blue 

checkmarks on the categories or choose individual files 

inside the categories to import (shown below). 

 

 

 

 

 

 

 

 

 

 

 

 

Projects 
A project is more than a show. In Photopia Director there are different types of Projects, including Effects 

Projects and a Shows Project, which can have several shows in it. 

Starting a New Project 

Types of Projects 

 



The most common type of Project is a Show Project. You can also have Projects for Effects that you are 

building, such as Slide Styles, Transitions, Layer Effects, Filters, and Wizard Themes. 

Click on the New Project button on the Home Page to start a new project. The next window will give you 

three different options to start creating your show, plus options to start Effect Projects and Import ProShow 

files. You can choose to start a new show with a Wizard Theme, a Blank Show, or a Show Template. 

 

Wizard 
The Wizard uses Themes, which are a collection of Slide Styles and Transitions that will be randomly applied 

to your images. Wizard Themes provide a quick and effortless way to apply effects to an entire show, while 

still giving you control over the look, the music, and the timing. Learn more about starting a show using a 

Wizard Theme and creating your own Wizard Theme. 

Blank Show 
This option gives you the most control over your slide show. You can build your own slides using all of 

Photopia tools and effects, apply individual Slide Styles and Transitions to your slides, or a combination of 

both. Learn more about starting a blank show. 

Show Template 
Show Templates are fully designed shows with empty place markers for you to add images and video. Show 

Templates can be customized to suit your needs (adding, removing, rearranging slides). The flexibility of each 

Template depends on its design.  

 

In the Template example shown above, you can see multiple slides with place markers, a background image, 

as well as other graphic elements that were included in the Template. The Content Tab provides helpful 

information to guide you as to which place marker to add your images into and access to any Caption Layers . 



Effect Projects 
These options do not create a show. Effects Projects are for you to create your own Slide Styles, Transitions, 

Layer Effects, Templates, and Wizard Themes. Learn more about creating your own Effects. 

Import 
The import option allows you to import ProShow slideshow files. It is important to note that if your ProShow 

slide show used any Slide Styles or Transitions you should import those into Photopia first for the best results. 

 

Project Information 
You will see information regarding each 

Project next to its thumbnail image, including 

its name, the number of shows in the project, 

the number of slides in the project (for all 

slide shows combined), and the total 

duration (for all slide shows combined You 

will also see a drop-down arrow to the left of the thumbnail if the project contains multiple slide shows. If 

you have used a Tag or Keyword on a Project, you will also see those. 

 

Project Groups 
 

Project Groups help keep all your projects 

organized. You will start with two basic Project 

Groups: All Shows and Archived. You can add your 

own Project Groups by clicking on the New Project 

Group button. You can even have Project Groups 

inside Project Groups. 

 

 

Once you have a Project Group, you can 

easily add a Project to that group using 

drag-and-drop (shown right) or by right-

clicking and assigning your project to a 

group. 

 

 

 

 



 

 

Tags 
Tags allow you to assign a visual color code to your 

projects. Right-click on a project then select the 

Tags flyout menu. You can then choose an existing 

tag or click Manage Tags to create a new tag.  

 

 

 

Once you are familiar with the numbers associated with 

your Tags, you can easily add a Tag to a project by 

selecting the project, then type the corresponding 

number on your keyboard. 

 

 

 

 

 

 

 

Keywords 
 

Keywords provide the ability to add 

searchable terms to your projects, 

helping you find projects faster. 

 

 

 

 

 

 



 

 

 

 

 

 

In the example above, three projects had the Keyword “2023” add to them. When typing that Keyword, or 

even parts of that keyword into the Search box, we have filtered our results to find only those projects. 

 

You can add Keywords to your Projects when 

you first start the project or by right-clicking on 

an existing project and choosing Project 

Information. Individual keywords should be 

separated by commas. 

 

 

 

 

 

 

Project Options 
Above the project list you will find options for viewing, sorting, and organizing your projects. 

 

 Change the project list view 

between Thumbnails (shown at 

right) and Details (shown below).  

 

 

 

 



In the Detail view, you can easily change the sort order by clicking on the column header that you want to 

sort by. 

 

 

 

You can also sort the project list using one of the 

options in the drop-down menu and reverse the sort 

order using the ascending / descending icon to the 

right. 

You can Filter your projects using the previously 

detailed Tags and Keywords. 

Click the Open button to open the selected project, 

which can also be done with a double-click. 

Click the Delete button to remove the selected project(s). This will move the selected project(s) to your Trash 

group, where you will see new options at the top.  

 

Projects can be permanently deleted by selecting them from the Trash group then clicking the Delete 

Permanently button. You can also Restore a project from the Trash folder. Clicking the Empty Trash folder 

will permanently delete ALL projects in the Trash folder. 

Click the Copy button to make a copy of the selected project. This can be useful when you want to make 

significant changes to project but also want to keep the current version of the project. 

Click the Rename button to rename the selected project.  

 



 

Click the Combine button to combine 

multiple slide shows into a single 

show.  This option will bring up the 

Combine Shows window from which 

you can add / remove slide shows, 

change their order, and set other 

parameters as well. This option will 

create a single new slide show. It 

will NOT put separate shows into a 

new project. 

 

 

 

 

 

Click the Revert button to load a previously saved version of the selected project. This will bring up the 

Revert to Backup window, from which you can select the previous save you want to load. 

All available backups of the 

project, which are created 

when the project is saved, 

will be listed in this window. 

There is a date / time listed 

for each backup to help you 

narrow down which backup 

you want to load. 

 

Loading a backup in this way 

does NOT change your 

project. It is necessary to 

Save your project once the 

backup is loaded to make 

that backup the primary 

copy of the project. 

 

 

Click the Information icon, displayed as a lowercase “I”, to open the Project Information window. This 

window includes project details and the ability to set the project Group / Keywords / Tags. 



 

There is also a Search bar to search for Projects based on their name and added Keywords. 

News 
The right side of the Home Page is where you will see News from 

Photopia. This could be new tutorials, free effects for you to download, or 

new Music when it becomes available.  

 If 

you would like to remove a news item from this list, simply click on the “X” 

in the upper right corner of that item. 

You can collapse the News section of your Home Page by clicking on the 

down arrow in the upper right corner of that section. 

 

 

 

The Manage Effects Window 
 

The Manage Effects window is where you can import, categorize, and delete your effects. These include Slide 

Styles, Transitions, Wizard Themes, Show Templates and more.  

https://photopia.nl/tutorials-photopia-director/


Importing Effects (Styles, Transitions, Templates and Themes) 

 

Click the Manage Effects button from the Home Page to open the Effects window. Click the Import button in 

that window to load Slide Style, Transition, Template, and Wizard Theme files into Photopia. Once an effect 

file has been loaded in this way the effect becomes available throughout that Photopia installation. Photopia 

effect files have the STA file extension while ProShow effect files have a variety of extensions (ex. PXS for 

Slide Styles, PXT for Transitions, etc.). The Manage Effects window can also be opened from the Effects menu 

while a project is loaded. 

Once your effects have been imported, they will be listed in a Category. If you need help finding effects, use 

the Search Bar at the top of the list. If you are unsure of what Category they might be in, select the All Effects 

Category before you search. 

Removing Effects 
The Manage Effects window is also where you can remove, categorize, and hide imported effects. 

Click the Remove button to delete the selected effect(s). Unlike projects, there is no ‘trash’ system for 

deleted effects. If you need to restore a deleted effect, import it again from the original source file. 

 

 

Click the Hide button (crossed-out eye icon) to make the selected effects hidden in other areas of the 

program. Hidden effects will appear ‘ghosted’ in the Mange Effects window. Click the eye icon to Show 

(unhide) the selected hidden effects. 



 

In this example (shown above) the “Logo Opener” Slide Style has been hidden using the Manage Effects 

window. This results in that Slide Style not being shown in the Slide Style list when looking for Slide Styles to 

apply. 

Categorizing Effects 
Placing effects into one or 

more categories can make 

them easier to find.  

Click the Categorize button at 

the bottom of the Manage 

Effects window. You will see a 

checkmark by each of the 

categories that effect is in. To 

include your effects in more 

categories, select one or more 

categories you would like to 

add them to.  You can also 

remove them from categories 

by unchecking them. If you 

would like to create a new 

category, click the Add button 

at the bottom then give your 

new category a name. 

 



Starting a New Slideshow Project 
To start creating a new Slideshow, click on the New Project button on the Home Page.  This will bring up a 

new window that has three options to start a new Show Project, an option to start a new Effect Project, and 

an option to Import files from ProShow. 

The three options to start a new Slideshow are: 

1. Wizard - this allows Photopia to create a new show using a Theme or your choice.  Learn more 

about creating a show using the Wizard here. 

 

2. Blank Show – This is starting from scratch; you will add your content and built your show as you 

would like to see it. Learn more about starting a Blank Show here. 

3. Template – a pre-built show. You will add your images into placemarkers and make minor 

adjustments, as needed. 

Each of these choices have options for naming your new show, choosing an Aspect Ratio, selecting Tags, 

adding Keywords, and choosing a Save Location. 

Once you are ready to begin, click the Create button and Photopia will launch into the main User Interface 

Layout. 

Preferences 

Project Preferences 
Before you begin a new project, you may want to set appearance and show preferences. Click the three lines 

in the upper right corner of the Home Page, or use the CTRL+F1 keyboard shortcut, to access the Preferences 

window. If you are already in a Project, you can access the Preferences option from the Edit menu. Here are 

the different sections of the Preferences window. 

Appearance 
UI (User Interface) Size – This option changes the size of text and other objects in the program. 

Photopia provides five preset UI Size options, as well as a custom option. Using a larger UI Size will provide 

larger text throughout the program along with larger slides and other objects. This means you may need to 

do more scrolling to see all the slides in the Slides List, layers in the Layers list, and options in other areas. 

Using a smaller UI Size will provide the opposite effect, which can be helpful if you want to see more slides / 

layers listed at once. 

 

 

 

 

 

 



 

Color Scheme – This option lets you change the colors in various parts of the program UI. 

 

Photopia Director defaults to the Dark 

Color Scheme and Photopia Creator 

defaults to the Light Color Scheme. You 

can choose either of these schemes, 

regardless of which program you are 

using, or one of the various built-in 

presets. You can also modify color 

schemes or create your own custom 

color schemes, by clicking on 

Customize. 

         

 

 

 

 

In the Color Configuration window, 

you can change the Base Color to 

create an entirely new color scheme, 

or you can change the various color 

values of the Secondary Colors in an 

existing preset. Select the Save button 

to give your new color preset a name. 

 

 

 

 

 

 
 

 

 

 

 

 



Tool Tips – This option controls Tool Tips for slides, but not for other options in the program. 

 

Enabling the Tool Tips option allows Slide 

Information popups to appear when holding your 

mouse over a slide.  

 

 

 
 
Information included in the Tool Tips are the slide / 

transition times, Slide Style applied, and number of 

images / captions / slide sounds. 

 

If you disable the Tool Tips option, basic tool tips, 

such as descriptions of the animation tools (shown at 

right), will always be visible. 

 

 

 

Mouse Wheel Zoom – This option allows 
you to use your mouse wheel to change 
zoom layer values, in addition to scrolling 
panels up and down. Disable this option if 
you only want your mouse wheel to scroll 
panels, but not zoom layer values. 
 
 
 
 
 
Welcome Dialog – This option controls display of the Welcome Dialog when the program opens each time. 
Groups – This option controls display of project groups in the main project list. 
Long Key Press – This option controls what happens when a key is held down while entering a caption. 
Delay –This option controls the delay between holding a key down and seeing the special character pop-up. 
 



Playback 

 

Display (Use Direct X) – Direct X is enabled by default in Photopia. Direct X is Microsoft’s standard rendering 

method and only applies to the Windows operating system. Using the Direct X feature generally allows 

Windows to display things faster. When Direct X is disabled, Photopia must use older (slower) methods of 

displaying graphics on screen. This option should remain enabled unless you are troubleshooting a specific 

display issue. 

Full Screen – This option provides a message when toggling the Full Screen Playback option, letting you know 

when you have switched from playback inside the Preview window to Full Screen playback and vice versa. 

Monitor Choice – If you have more than one monitor, this option allows you to choose which monitor is used 

for Full Screen playback. 

Project Files 

 

Project Location – This option sets the target save location for new projects. The default is “Documents” > 

“Photopia Slide Shows”. You can change this location, but it is recommended that you use your local hard 

drive, not an external drive. Projects can be archived to an external drive as needed once they are complete. 

Auto Save – This option enables an automated backup of the project currently being edited, which can be 

useful if the program / computer crash. This is a single backup file used for recovery purposes. It is NOT 

related to the backup files stored in a project folder. 

Auto save projects every – This option controls the frequency of the Auto Save option. 

Backup – This option controls the number of project backups that will be maintained for each project. These 

backups are created each time the project is saved and are NOT related to the Auto Save feature. 



External Editors 

 

You can assign external editors to Photopia, allowing you to launch those programs and import files into 

them directly from inside Photopia. If you edit those files, you will be editing the duplicate Photopia saved 

in the Project location, not the original file. 

 

An external editor can be assigned on a Windows Computer by clicking the Browse button next to the editor 

you would like to choose (Image, Video, or Audio). Navigate to the Program File (exe) for the program you 

would like to use. 

 

Example: Click the Browse button next to the Image Editor option then navigate in the Browser pop-up to 

“Program Files” > “Adobe”. You should then see a “Photoshop.exe” file. Click that file then click the Open 

button and that “Photoshop.exe” program will load when you select the external editing option for an image. 

 

You can assign an external editor on a Mac by clicking on the Browse button next to the editor you would like 

to choose (Image, Video, or Audio), then choosing your program from the list of installed programs. 

 

 

 

 



Show Defaults 
Slide Settings – The first checkbox indicates 

whether you would like new slides to take on 

the slide and transition timing from the 

previous slide. You can also set a default Slide 

Time and Transition Time for your project. 

Fitting Mode – You can choose from Fill 

Frame, Fit to Frame, or Stretch to Frame. 

Motion Settings – Motion Easing determines 

how your layers will animate between 

keyframes. Curve is related to that Motion 

Easing path. 

Caption Settings – You can set defaults for 

your Caption layers for the following 

attributes: 

• Default Font – This option lets you override the default behavior, using the most recently set Font 

for new captions, to instead use a specific Font for each new caption. 

• Default Size – This option lets you override the default behavior, using the most recently set Font 

Size for new captions, to instead use a specific Font Size for each new caption. 

• Default Color – This option sets the default Color for each new caption. 

• Horizontal Alignment – This option sets the default value to Left, Right, Center, or Fill. 

• Vertical Alignment – This option sets the default value to Center, Top, or Bottom. 

Miscellaneous 

 

Automatic Updates – This option enables prompts to appear when updates for Photopia are available. You 

will still be able to choose whether to install each update. Leaving this option enabled is recommended. 

Error Reports – This option enables anonymous error reports, which are used to improve the program.  

Communication Preference – This option allows you to opt in / out of email communications from Photopia. 



Prompts 

 

Slide Styles – This option enables a warning about slide changes when applying a Slide Style. 

Delete Project – This option enables a fail-safe to ensure projects are not accidentally deleted. When 

enabled, the word “Delete” must be typed into a pop-up window to delete a project. 

Wizard – This option controls display of the introduction screen each time the Wizard is used. 

Missing Fonts – This option controls the ‘missing font’ warning message that is displayed when loading a 

project that uses fonts which Photopia cannot locate. That warning message includes an option to choose 

alternate fonts. 

Types of Content 

Images 
The main type of content used in Slides Shows is, of course, photographs. Photographs can come in many 

different file types, orientation, and pixel size. 

Photopia supports many different file types of images, including JPG, TFF, BMP, and PNG. See Appendix A for 

a full list of supported image file types. 

All image orientations can be used; Landscape (Wide), Portrait (Tall), Square, and Panoramic. The quality of 

an image depends largely on how many pixels it contains. The quality of an image in output created by 

Photopia further depends on how many pixels are in each frame of that output file. 

4K (UHD) video, for example, is 3840 pixels wide by pixels 2160 tall. That is about 8 MP (mega pixels). High-

Definition video (1080p) is 1920 x 1080 pixels. That is about 2 MP. Using images larger than these sizes is 

generally not a problem, however using a lot of very large images can negatively impact program 

performance. A good guide is to use images no greater than twice the size of the expected output format. 

Likewise, using very small images (ex. 400 x 200 pixels) can lead to poor quality output as those image layers 

get scaled up to the resolution of the output format. Generally speaking, you want to avoid using images with 

a resolution less than 80% of your intended output resolution. 

 



Fitting Mode 
Your images will appear differently inside your slides depending on the Scaling you have chosen. This will be 

most apparent with Portrait images, as you are fitting a tall rectangle (your image) into a wide rectangle (the 

slide show area).  

 

If your scaling is set to Fit to Frame (shown above), your entire image will fit inside the frame of the slide 

show. This will cause you to see the slide / show background (black by default) on the left / right sides of the 

image layer. If your image is very wide, you may see those (black) background bars on the top / bottom of the 

image layer instead.  

 

If your scaling is set to Fill Frame (shown above), your entire image will fill the screen, most likely causing 

some of your image to be cut off outside the frame of the slide show. 



 

Stretch to Frame (shown above) will cause your image to fill the slide show frame exactly but will often 

distort the image. 

 

Image Adjustments 
You can make image adjustments inside Photopia that will not alter the original file. These adjustments (ex. 

Crop, Flip, Rotate, etc.) can be found in the Content Tab, among other places. An external editor can be used 

to make permanent adjustments to the original image files. 

 

If you have an image editor set up in your preferences, 

you can right click on that image in your Layer List, then 

choose Open in External Editor, which will launch your 

chosen Image Editor and open you image into it. 

 

Note: The file that is imported into your image editor 

will be the duplicate created by Photopia, not your 

original image. 

 

 



Graphic Elements 
Other types of images, such as PNG or TIFF files, can also be used as supporting graphics in your slides.  

 

A file that has an embedded alpha channel will appear with a 

checkered background in the File Information Tab. That 

checkered background represents the transparent areas. 

 

 

 

 

 

 

 

 

Video Files 
Photopia supports many video file types including MP4, MPG, AVI, and MOV. See Appendix B for a full list of 

supported video file types. 

Video files can be used in the same places as a still image, including as the Show Background. 

Video Clip Settings 
When a video file is used in a slide you will see all the same Layer settings that are available for an image 

layer. This includes Source, Shape, Scaling, Rotation, Visibility, Local / Global toggle, Style / Template toggle, 

and Reset Layer. 

You will also see Video Clip Settings that are specific to video layers. 

 



Duration – This will show the total duration 

of your video clip. If the clip is trimmed, this 

will show both the original and trimmed 

duration. 

Timing (Trim) – This button opens a separate 

trim window, allowing you to trim the 

beginning or the ending of your video clip. 

You cannot trim out any section from the 

middle of the video. 

Speed – You can speed up or slow down your 

video clip by changing the speed setting. A 

value higher than 100% will speed up the 

video, causing to have a shorter duration, 

while a value lower than 100% will result in a 

slower video that lasts longer. Any speed 

other than 100% will automatically disable 

audio from the video layer. 

Loop – This option will cause your video to loop infinitely. This is most useful for looped video backgrounds. 

Unchecked, your video will simply stop playing, and disappear, at the end of the duration time. 

Hold – This option will hold the last frame of your video file past its duration time. Use this option when you 

don’t want your video to loop but your slide + transition times are longer than your total video duration and 

you want the video layer to remain visible until the end of the slide. 

Sound Settings – These settings will only be shown when your video file has embedded audio. 

Video Sound Settings allow you to 

control the volume of your video layer 

as well as determine fade in and out 

times. The offset setting allows you to 

move your audio forward or backward 

in time, separate from the video. 

Soundtrack During This Video allows 

you to change how the Soundtrack 

volume is affected by this video layer. 

You can determine how fast or slow the 

Soundtrack volume changes using the 

Fade In / Fade Out settings. If you want 

the Soundtrack to keep playing with no change, set his Volume to 100%. 

 

The Video Trimmer 
Clicking the “Trim” button in the Layer settings for a video layer will launch the Video Trimmer window. 



 

At the top you will find a video timeline. You can use this timeline to trim the beginning and/or ending of 

your video clip.  

 

There are three markers inside the timeline that you can click and drag: a green “Start Frame” marker, a 

fuchsia timeline marker, and a green “End Frame” marker. Each of those markers has a corresponding video 

frame seen below.  

 

The left video frame shows where your current play marker is located. The center video frame shows where 

you have placed the “Start Frame” marker and the right video frame shows where the “End Frame” marker is 

placed. 



 

Beneath the Start and End Frame 

previews are four icons and some 

information. The Step buttons allow 

you to step your trim marker 

forward or backward one frame at a 

time. The Set Trim Point Button will 

set your trim marker at the current 

location of the playback marker. 

The Reset button will move your 

Trim marker back to the beginning, 

or ending, of your video clip. 

The information at the bottom of 

the two Trim Windows give you the 

frame number and time, in minutes 

and seconds, of the exact location 

of the trim marker. 

 

 

Step Buttons     Trim Point Button     Reset Button 

 

 

You can scale, or zoom, the video timeline and reposition it to see smaller increments of time. Use your 

mouse wheel while hovering over the timeline to zoom in and out, then click and drag the timeline to 

reposition it. There are also zoom and position sliders directly beneath the video timeline. 

 



Caption Layers 
Caption Layers behave like Image / Video layers. Captions can be animated over time, move up and down in 

the Layers list (giving you the ability to put a caption above OR below an image / video), and can have several 

different adjustments applied to them. 

Fonts 
Photopia accesses all Fonts installed on your computer. If you would like to add a new font to Photopia, you 

need to install it on your computer. If you have Photopia open, close the program first, then follow these 

instructions to install new fonts: 

Windows 

Double click on the font file. This will open an installation window showing an example of the font. Click the 

“Install” button at the top. 

 

Mac 

Double-click the font in the Finder, then click Install Font in the font preview window that opens. After your 

Mac validates the font and opens the Font Book app, the font is available for use. 

 

After the font has been installed on your computer, relaunch Photopia and you should see it in your Font List 

 

Adding a New Caption Layer 
You can add a new caption layer by clicking the “T” icon at the top of the Layers list. A new Title Slide can be 

added using the “T” icon that has a box around it, located at the top of the Slides List. 

 

 When adding a new caption layer or Title Slide a window will appear allowing you to type in your text, 

choose a Font, and enabled the Bold / Italic settings. Directly to the right of the Font dropdown menu are 

three icons for using a Font Browser, adding Macros, and Inserting Symbols. 



 

 Font Browser – The Font Browser window gives you a visual representation of all the fonts installed 

on your system.  There are categories on the left side to help narrow down your search, including 

Recently Used, Used in this Show, and Favorites.  To add a font to the favorites category, click on the star to 

the right of the Font name. 

 

 

 

 Macros - Macros are 

keystrokes that tell 

the program to display a 

specific set of information in 

place of the keystrokes. All 

Macros will start with a 

backslash (\) then a letter 

(some are lowercase, some 

capital). 

 

 

 

  

 

 

 

 

 



 

 

 

 

 

 

 

 

If you know the keystroke for the Macro you would like to use, you don’t need to open the Insert Macro 

window. You can simply type the keystroke into the text field. 

Backslash lowercase “f,” (\f) for example, will display the file name of the top-most image in the Layers List. 

 

 

 Insert Symbol – This option gives you a visual 

representation of the symbols and special 

characters that are available in the font selected.  Please 

note that each font will have different symbols and 

characters available.  For fonts that have hundreds of 

symbols, such as Arial, use your mouse wheel or the 

scrollbar at the left to see more symbols. 

You can add one or more symbols to your caption by 

selecting the symbol in the list, then hit Add at the bottom 

of this window to add the symbol and stay in this window 

to choose another symbol or hit Add & Close to add the 

symbol and exit the window. 

When a symbol is selected you will also see the Keyboard 

Shortcut for that symbol below the example at the top of 

this window.  This can be useful if you plan to use that 

symbol often, as you can simply use those keystrokes 

(alt+233, in this example) instead of opening this window. 

 

All other caption settings, such as Font Size, Alignment, and Line and Character Spacing can be set after you 

have entered your text and clicked the Ok button. 

 

 

 



Basic Caption Settings in the Content Tab 
 

In the Content tab you can change the text, Font, Bold / Italic settings, and Color / Texture for the selected 

caption layer. The Caption Size is by percentage of the Font Size. You can only set the Font Size directly from 

the Caption Settings tab of the 

Advanced / Compact UI Layouts. 

 

You can change the color of your 

text by clicking on the color swatch, 

then use the hue and saturation 

wheel to pick another color. You 

can also use a gradient in your text 

by going to the gradient window 

instead of the solid color window. If 

you would like to use an image (or 

texture) inside your text, click on 

the folder icon. This will open the 

Browser and you can search for an 

image to be shown inside your text. 

For all other Caption Settings, you 

will need to be in Advanced Mode 

(or Compact Mode). 

 

 

Advanced Caption Settings from the Layers List 

 

With your Caption Layer selected in the Layer List, you will find more settings in the Caption Settings tab of 

the Options Panel. 

The Caption section is identical to the Add Caption window, with options for Font choice, Bold/Italic, the Font 

Browser/Macro/Symbol options, and a text field. 



Format 
The first setting under the format heading is your Horizontal and Vertical alignment. These settings use the 

position of the caption layer as a reference point. 

 

Horizontal Alignment controls how the text in your caption layer aligns horizontally to the layer position 

value. The options are Left, Right, Center, and Fill. 

 

Changing the Horizontal Alignment from Center to Left (or right) will cause all the text in the caption layer to 

move. Using the Left alignment option will cause the left-edge of that text to align to the layer Position value 

and thus flow to the right. 



 

If we enable a two-by-two grid to show where the center of the preview window is, the reason becomes 

clear. When the Horizontal Alignment option is set to “Left” each line in the caption layer becomes aligned on 

its left side. In this case, that causes the left-edge of the caption to be in the center of the slide show frame, 

because that is where the layer Position value is located. You can always click and drag your text layer to 

another location be on the screen. 

 

Conversely, setting the Horizontal Alignment option to “Right” will cause the caption to be aligned at the end 

of each line, on the right side. 

 



 

Setting the Horizontal Alignment option to “Fill” will cause the caption text to fill up the available space, in 

much the same way “Justify” would do in a text editing application. Extra spaces may be added to achieve 

this effect. 

Vertical Alignment works in much the same way but there are only three settings for this option: Top, Center, 

and Bottom. The layer Position is still used as the reference point for this alignment option. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Font Size 
While the Font Size option may seem self-explanatory, it is important to note that Font Size is relative to the 

applied Font rather than the slide show frame size or playback / output dimensions. 

 

This is “Tahoma” at a font size of 30. 

 

 

This is "Dragon is Coming” at a font size of 30. 



Line Spacing 
Line Spacing is only used when there are multiple lines of text in a single Caption Layer and, like Font Size, is 

relative to the applied Font rather than the slide show frame size or playback / output dimensions. 

 

This is “Tahoma” with a line spacing of 100. 

 

 

This is "Dragon is Coming” with a line spacing of 100. 



Character Spacing  
Character Spacing changes the space between characters and is also affected by the applied Font. 

 

 

Color/Texture 
Captions can have three basic types of Color / Texture applied. 

 

 

Click the color swatch to open the Browser window to the Solid Color option. You can use the Hue / 

Saturation wheel in this window to change the color of your caption text. 

 



Alternatively, you can choose the Gradient Window in the Browser to select a gradient for your Caption. How 

the gradient is displayed may depend on the Mapping Mode, which can be very subtle. 

 

You can also choose a ‘texture’ (i.e., an image file) to apply to your caption text. This is done from the same 

Browser window that appears when clicking the Color / Texture swatch. Click the ‘computer icon’ in the 

upper-left corner of the Browser window to find / open the image you would like to apply. 

 

 



Mapping Mode 
The different Mapping Modes can result in subtle differences with a big impact. 

       

The difference between Fill and Fill Frame is more apparent using a rainbow gradient. When Fill mode is used 

(above left), the gradient fills the text box, allowing all the colors to be seen inside the text. 

 

When the Fill Frame mode is used (above right), the gradient fills the entire slide show frame. In this case, 

the colors that are shown in the caption text depend on where that text is positioned in the slide show frame, 

because the caption texture is filling the slide show frame NOT the caption.  The blues and greens at the 

outer edge of the gradient aren’t seen inside the text layer. 

 

If we use a portrait-

oriented texture, we can 

see the image fills the text 

box horizontally, but the 

top and bottom of the 

image is cut off by the 

text. 

 

 

 

 

 

 



Using the Stretch mapping mode will force your image to fit the caption text exactly, which will ensure the 

full image is used but may cause distortion in that image as it is mapped to the aspect ratio of the caption 

text. 

    

 

Using the Stretch to Frame mapping mode will force the image to exactly fill the slide show frame, which may 

also result in image distortion. 

    

 

 

 

 

 

 

 

 

 

 

 



Text Box 
 

 

The Text Box option allows you to define the area in which your text is shown. When the Text Box settings 

are not used (shown above), Photopia will use your text, as entered, for the defined area. This is shown as a 

dotted line around your text.  

 

Typing text, without hitting the 

enter key, will result in a straight 

line of text, possibly extending 

beyond the viewing area.  This 

could be used to pan the text 

horizontally. 

 

 

 

 

 

  

 

Pressing the Enter key after “BOX.”, “TO”, and “TO” results in the caption shown above. 



 

 

If the Box Height setting in the Text 

Box option is checked and left at the 

default of 50, you can see that the 

top and bottom lines of the box are 

now solid, but we are also missing 

the last line of our text. When the 

Box Height is defined, your text 

inside will not adjust to fit (this is not true for Text Width). You would either need to lower your font size or 

raise the Box Height, as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

With both the Box Width and 

Box Height checked you can 

define an area for your text. 

This area might match the 

area of a portrait image 

(shown left) for instance. 

However, if Word Wrap is 

not enabled your text will not 

be constrained to the width. 

For all your text to fit within 

your defined Width and Height of the Text Box, you must also have Word Wrap enabled (shown below). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Using the Shrink to Fit option you can make sure your text fits in the Text Box area by setting a minimum 

Font Size for your caption text. The program will start at the original Font Size the reduce that size, to a 

minimum of the listed Shrink to Fit size, stopping when all characters in the caption fit in the Text Box area. 

 



Beneath the Text Box Settings is a Name field. You can use this to rename your Caption Layer in the Layers 

list. This will not affect the Caption itself, just rename the Layer in the Layers list. You can also rename your 

layer by right clicking on it and choosing “Rename Layer.” 

 

 

 

Caption Layer Settings 
 

The last settings in the Caption Settings 

Tab are the Layer Settings. These function 

in the same way for Caption Layers as 

they do for Image Layers. You can make 

the caption layer visible or hidden, keep it 

local (on this slide only) or Global (apply 

that caption layer to all slides), and reset 

all your settings for the Caption Layer. 

 

 

 

 

Beneath that is a text field for Layer Notes. These 

notes do not appear anywhere in your slide show or 

on the layer itself. When you enter text into the 

Notes field a speech bubble icon is displayed in that 

layer in the Layers list indicating that the layer has 

notes. 

 

 

 

 

 



Caption Slices 
 

Photopia Director also gives you the 

ability to animate your words and 

individual letters and characters 

separately. These are Word and 

Character slices. To access the caption 

slices, open the dropdown menu 

arrow to the left of your Caption 

Layer in the Layers Tab.  

When the Words slices layer is 

selected, you will see a dotted line 

around each individual word, as 

opposed to the entire caption. This indicates that each word can be animated as a single unit. Selecting the 

Characters slices layer shifts the dotted lines to be around each letter or character, indicating that you can 

animate each individual character. 

 

To animate any of these slices individually, click on the icon on the right side of the slices layer. This will give 

you a list of each slice. You can now select any of these slices (either words or characters), and you can 

animate that slice the same way you would an image layer. 

 



Solids and Gradients 
Solid and Gradient layers are created internally within Photopia. The following images show examples of how 

you can use Solid and Gradient Layers in your slides. (Solids and Gradients are created in the Browser Tab) 

Masking Layers 
Masking Layers work the same way as a stencil. They can mask (hide) parts of your slide while letting other 

parts comes through (show). In the example below, a gradient masking layer is used to hide the outer edge of 

the image, while allowing the center to be seen. 

Learn more about Masking Layers here. 

 

 

 

 

 

 

 

 

 

 



Adjustment Layers 
Adjustment Layers work the same way that Masking Layers do, but instead of hiding parts of your slide, they 

allow you to add image adjustments to parts of the slide. In the example below, a gradient adjustment layer 

is used to desaturate the outer parts of the image, while keeping the center in full color. 

Learn more about Adjustment Layers here. 

 

Special Effects (using Transparency) 
 

You can create partially 

transparent layers using 

gradient keyframes. In this 

example two keyframes on 

the left side of the gradient 

have zero transparency 

while two keyframes on the 

right have a transparency 

set to 100. Use the RGB 

Colorspace for best results. 

 

 

 



 

Lines 
You can create thin lines using either Solid or Gradient Layers. Using either the Horizontal or Vertical 

Resolution text boxes, change one of the numbers to something small. In the example below, the Vertical 

Resolution was changed to 10, resulting in a horizontal line.  

 

It is important to note that the Scaling for these layers must be set to Fit to Frame or your “thin line” will fill 

the frame. 

 

Shapes 
Shapes can be applied to any image layer, Gradient, or Solid. 

Learn more about Shapes here. 

 



Under Text Layers 
Solids and Gradients can be used to make text layers more readable when they are over an image. (Shown 

below) 

 

 

Audio 
Photopia supports many different audio file types including M4A, MP3, WAV, and OGG. See Appendix C for a 

full list of supported audio file types. 

Audio files can be used in the Show Soundtrack or as a Slide Sound in individual slides. Audio from video files 

also interacts with audio from the Show Soundtrack and Slide Sounds. 

 

Show Soundtrack (Music) 
 The most common audio used in a slide show is 

music. Click the Add Audio button directly above the 

Slide List to add audio to the Show Soundtrack. This 

will launch the Music Library, but you can choose to 

navigate to a location on your computer to choose a 

song of your own instead. 

 

 

 



You can also add music to your Soundtrack by opening the Music Library from the Browser. Double-click an 

audio track to add it to the Show Soundtrack, or click the Add Audio button in the Show tab.  

Once you have added a song to the Soundtrack, you will find it listed under the Show Tab in the Navigation 

Panel. If you click on that audio track two tabs appear in the Options Panel: Audio Settings and Soundtrack. 

The Audio Settings  
This tab controls the base audio settings for the entire slide show. 

 

Master Volume – This is the volume 

for all songs in your soundtrack. 

Fade Soundtrack – This option forces 

your soundtrack to fade out at the end 

of the slide show. You can set the 

Duration of that fade to match the last 

transition / slide or use a custom 

duration. 

Defaults For Slide Sounds – This sets 

the Volume and Fade In / Out for all 

Slide Sounds in your slide show. 

Soundtrack During Other Sounds – 

This sets the Volume and Fade In / Out 

for the Soundtrack during Slide Sounds 

and video layers with sound. 

 

The Soundtrack Tab 
This is where you will find information related to each individual 

soundtrack file in your slide show. 

The Song Title and total length of your sound file is listed at the 

top, along with a play button to preview the song.  

Track information is listed below the waveform, including the 

original file location, song duration (with trimmed time if 

applicable), and other details as well. 

Track Settings allows you to set the Volume level for this 

individual audio track, along with Fade In / Out times. 

Offset allows you to create space between songs or to have 

them overlap. A positive number will move this song further 

down the timeline, creating space between the previous audio 

track. A negative number will move this song earlier on the timeline, creating a crossfade with the previous 

audio track. 

Trim allows you to remove part of the beginning / ending of the audio track but remove middle portions. 



Audio Trimmer 
Clicking the Trim button in the Soundtrack Tab for an audio file will launch the Audio Trimmer window. 

 

At the top you will see an audio waveform with Left and Right channels. If your audio file is Mono, you will 

only see a single waveform. There are four markers inside the timeline that you can click and drag. The two 

top markers are your Start and End points, trimming the beginning or ending of your audio clip. The two 

bottom markers control the fades. 

 

Directly beneath the audio waveform are two 

timelines; one showing the time of this 

individual audio track and the second shows 

where this audio track falls in the entire 

show. 

You will also see standard playback controls. 

You can also play, pause, and stop playback 

using your spacebar. 

The two arrow icons are for setting your Start 

and End trim points. You can play your 

soundtrack, then click on either the Start or End trim buttons to set the trim point while listening to the 

playback. The total duration and trimmed duration are also listed here. 

 

Zoom in on the audio timeline to see smaller increments of time. You can use the zoom slider to zoom into 

the timeline or use your mouse wheel while hovering over the timeline, then click and drag the timeline to 

reposition it. There are also Start / End and Fade In / Out number boxes which can be set by typing in a new 

number. Reset buttons are included for each option. 



Audio Sync Options 
Under the Tools Menu at the top of the 

Photopia Interface, you’ll find four 

options for quickly syncing your slides to 

your music. 

 

 

 

 

 

 

Sync show to audio provides all the 

audio syncing options in one 

window. In the example to the left, 

there is over 4 minutes difference 

between the slide times and the 

soundtrack time. With the current 

settings checked, Photopia will 

adjust both the Slide and Transition 

times to fit both soundtracks, keep 

proportions the same as they 

currently exist (longer slides will 

remain longer, but with different 

times), and transitions will be 

adjusted to a maximum duration of 

3 seconds. 

 

The three Quick Sync options will automatically sync your slides to the chosen option:  

Quick Sync - Entire Show will change slide / transition times to match the full show the full soundtrack.  

Quick Sync - Selected slides will set slide / transition times for selected slides to match the full soundtrack.  

Quick Sync - Selected slides to track will sync only the audio track of your choosing to the selected slides. 

 

 

 

 

 



Slide Sounds and Narration 

 

You can add your own Slide Sound or Narration to any slide. Click on the Slide Tab in the Navigation Panel 

and this will open the Slide Sound Tab in the Options Panel. To add a sound file from your computer, simply 

click on the Select Button. 

 

 
Once you have added a sound to your slide a red waveform will appear in the Slide Sound tab and Track 

Information and Settings will become available. 

 

 

The Sound Timing settings allow you to set an offset for this Slide Sound; allowing you to start the sound 

before the slide starts or move it further down on the timeline. 

Enabling the Continue Playback option allows the Slide Sound to continue playing after the slide has ended. 

You can also lock the slide time to the sound length, changing your slide time to fit the sound file you have 

added. Clicking the Edit Fades and Timings button will open the Audio Trimmer. 



 

The Custom Slide Sound Setting option allows you to set a Volume and Fade In / Out for this individual Slide 

Sound. 

The Custom Soundtrack During This Sound option allows you to bypass the normal Soundtrack During Other 

Sounds option for this individual Slide Sound. Set the Volume to 100% to keep the Soundtrack at full volume. 

 

 

Narration can be added to a slide if you have a microphone connected to the computer AND there is not a 

Slide Sound in that slide. Each slide can contain only one audio track. Slide Sounds and recorded narration are 

both audio tracks. In the Slide Sound tab, click the Record button to bring up the Record Audio window. 

 

 

The Record Audio Window 

gives you options to change 

the save location, the 

recording device and quality 

of the recording. 

When you are ready to 

record, hit the Record 

button at the bottom. 

 

 



When you are done recording, the 

Cancel button will change to a 

Discard button. If you would like to 

record again, without saving your 

previous recording, simply click the 

Record button again. If you would 

like to save your recording, click the 

Save button. If you would like to 

discard the recording and exit the 

window, click the Discard button.  

Video File Sound 
Video files can, and often do, have sound embedded in them and there are similar Sound Settings for them as 

well. Those sound settings are in the Layer tab for each video layer. 

 

 

User Interface Layouts 
There are four UI Layouts to choose from: 

1. Advanced – This layout provides access to all features, making it the most complete UI. 

2. Compact – This layout also provides access to all features but in a more compact space. It is designed to work 

better on lower resolution monitors, like laptops, than the Advanced layout.  

3. Basic – This layout is a great place to start if you are new to Slide Shows. You will have access to everything 

you need to create a great show, without the more complex features getting in the way. When you are ready 

to take on more control, and more complexity, switch over to Advanced. 

4. Light – This layout looks more like a lightbox (or Lightroom) layout than the linear editing UI in the other 

layout modes. Slides are grouped in a grid on the left-hand side of the window, rather than in a horizontal 

row at the bottom. This layout is good for rearranging slides and getting a good look at slide arrangement. 

The User Interface Layouts do not affect your show. You can start in Basic, then jump over to Advanced to 

adjust a keyframe, then go back to Basic. 

All four Layout Modes include these components: 

1. Preview Window 

2. Browser  

3. Slide List (as a lightbox in the Light layout)  

4. Slide Style List 

5. Content List 

6. Audio Settings (including the Trim window) 

 

 

The Advanced and Compact Layouts also include: 



1. Layer List 

2. Adjustments Tab 

3. Animations Tab 

4. Effects Tab 

5. Timeline View 

6. Keyframe View 

 

Light 
This layout most closely resembles the Lightbox view in ProShow. Your slides appear in a left-to-right / top-

to-bottom grouping, instead of in a horizontal row. The Light layout only has two panels: 

 

• The list of slides is on the left, where you can adjust your content / timing and rearrange slides. 

• The Options Panel is on the right and includes the Preview, Browser, Slide Style, Content, Audio, and 

Show settings tabs. 

 

The Light layout does 

not include the Layers 

list, Adjustments tab, or 

Animations tab. This 

makes it most useful for 

quickly putting together 

a show using pre-built 

Slide Styles and 

Transitions, but not 

building or customizing 

your own slides. 

 

Basic 
This layout has all the same features as 

the Light layout, is still missing the 

advanced features, but the has three 

panels instead of two. The Preview / 

Browser tabs share space on the left 

side of the window while the Slide 

Styles, Content, Audio, and Project tabs 

are in the Options Panel on the right. 

Slides are in a horizontal linear list at 

the bottom of the window. 



Advanced 
The Advanced layout is where all the animation tools are located. If you are coming from ProShow and you 

are looking for the keyframe timeline or the Layers list, this is where you will find them. The Advanced layout 

is where you will have access to all the tools within Photopia. This makes the Advanced layout the most 

feature rich layout and the most complex.  

There are four panels in the Advanced layout. 

 

1. Navigation Panel - This panel includes the Project, Show, and Slide tabs. 

2. Brower / Preview Panel - The panel includes the file Browser and main Preview tabs. 

3. Options Panel - This panel includes most of the settings you will be using. It changes what is shown 

based on what is selected in the other panels. 

4. Slide List Panel - This panel includes the horizontal list of slides in two modes: Slides and Timeline. It 

also includes a slide-specific Keyframe interface for more precise keyframe layout control. 

Compact 
The compact User Interface layout is identical to the Advanced layout, but the tabs and panels are thinner for 

better use on lower resolution monitors, like many laptops. 

Customizing Your Layout 

Closing, Adjusting, and Resetting the Panels 
 

Closing the Navigation and Options Panels gives you the ability to increase your workspace and “hide” tabs 

and panels that you may not be using. Both panels have arrows that point down when the panel is open 

(shown below left). Clicking on that arrow closes the panel and the arrow turns to the side (shown below 

right). Click on it again to open that panel. 



        

 

 

You can also adjust the size of each panel by 

hovering your mouse over the line where two 

panels meet. When your mouse turns to a 

double arrow click and drag to resize those 

panels. 

 

Panel sizes can be reset using the Reset 

Window Layout option in the View menu. 

 

 

Center the Main Preview 
You also have the option to swap your Preview and Options Panels. Click the Center the Main Preview option 

in the View menu to enable this change. The default is to have the Main Preview window in the center of 

your screen and the Options Panel on the far right (shown below). 

 



If you plan to work on multiple layers in the Layers List and their Adjustments or Animations in the Options 

Panel, you may want those two panels to be right next to each other for easier access (shown below). This is 

the UI shown when the Center Main Preview option is disabled. 

 

 

The Navigation and Options Panels 
The Navigation Panel on the left side of the interface is connected to the Options panel on the right side. 

When an option is selected in the Navigation Panel, the Options panel will show settings related to your 

navigation choice. 

(All screenshots have changed the View to have “Center the Main Preview” unchecked This allows the 

Navigation and Options panels to be adjacent.) 

Navigation Panel – Project Tab 

Project Settings 
 

Selecting Project Settings in the 

Navigation Panel (left) will open 

the Project Settings tab in the 

Options Panel (right) 

The Project Settings tab in the 

Options Panel allows you to 

1. Rename 

2. Add Notes 

3. See Project Details  

4. Manage Tags 

5. Manage Keywords 

6. Manage Project Groups 

 



 

Shows List and Show Settings 
The Shows list in the Navigation Panel is a list of all the slide shows in your project. When a show is selected, 

the Show Settings tab will appear in the Options Panel. 

You can add a new show to your 

Project using the new icon at the top 

of the Shows list. This will give you 

the same options as starting a show 

from the Home Page (Blank, Wizard, 

Template, Import). You can also 

remove a show from your project, 

duplicate a show, and rearrange the 

slide show order by clicking and 

dragging a show up / down in the 

list. Selecting a slide show in the 

Project tab will also open the Show 

Settings in the Options Panel. 

 

Adding an existing slide show to your project can be done by 

clicking the Import Show into Project option from the File 

menu. This will bring up a list of all your Projects, from which 

you can pick the slide show you want to add to your current 

project. 

 

Note that this option puts a copy of the selected slide show 

into the current project. It does NOT remove / modify the 

selected slide show in its original location. 

 

 

 

 

 

 

 

 

 

 



Navigation Panel – Show Tab 
The top of the Show Tab in the Navigation Panel gives you three navigational tools to open settings in the 

Options Panel. 

 

 

Show Settings  
Selecting Show Settings in the Navigation Panel 

opens a Show Settings tab in the Options Panel. 

This is the same tab that is shown when a Show 

is selected in the Project Tab. 

In this tab you can: 

1. Rename your Show 

2. Add Notes 

3. Change the Show Thumbnail 

4. Change the Aspect Ratio 

5. Set Slide and Transition time defaults 

6. Set a Fitting Mode Default 

7. Adjust the Safe Zone 

8. See Details for this Show 

 

 

 

 

 

 

 



Watermark 

 

Watermarks are seen on every slide and are commonly used to display a business name. 

 

If you have an image file that you would like to use as a Watermark, click the folder icon under the 

Watermark thumbnail in the Options Panel then choose the desired file from the Browser pop-up and click 

the Ok button. 

 

Watermark images can be adjusted like other image layers, although they cannot be animated. 

 

Any adjustments made to a Watermark are global and appear on every slide. 

 

You can also create a caption Watermark. Add a caption layer to any slide then drag it above the word 

transition in the Layers list. Make any adjustments to this layer, including size, position, color, etc. then 

enable the Global Layer checkbox in the Caption Settings tab. 

 



Show Background 
The Show Background is also Global. It can be any type of image, video, solid, or gradient layer.  

 

 

Click the folder icon under the 

background thumbnail to 

change the Show Background. 

This will bring up the Browser 

window. Navigate to the image 

you want to use, select it, then 

click the Ok button. You can also 

choose a Solid / Gradient for the 

Show Background. 

 

Once you have added a Show 

Background image, you can 

adjust it just like any other 

image layer.  These 

adjustments will be Global and 

applied to every slide. Show 

Background images cannot be 

animated. 

 

 

 

 

If you would like to change the background for a specific slide, this can be done by adding a layer to that slide 

then bring it below the word background in the Layers list, but above the Show Background layer. These 

background image layers CAN be animated. 



Soundtrack 
The Soundtrack list in the Show Tab is where you will see all the audio tracks in the Show Soundtrack. You can 

add, copy, delete, edit, and rearrange songs from this tab. You can also open songs from this tab in an 

external editor for more sophisticated editing. 

 
When a song is selected in the Soundtrack list the Options Panel will show two tabs: Audio Settings and 

Soundtrack. The Soundtrack tab (shown above) allows you to preview the selected song, gives you 

information about that song, and allows you to set track settings / trim options. Learn more about 

Soundtrack Settings here. 

 

Audio Settings are for all songs in your Soundtrack. This is where you will set Global Audio Settings including 

a Master Volume, Defaults for Slide Sounds, and Soundtrack During other Sounds. Learn more about  Audio 

Settings here. 



Navigation Panel - Slide Tab 
The Slide tab in the Navigation Panel provides 

access to everything you need to create and 

manage your slides. The three options at the top of 

the Navigation Panel will open new tabs in the 

Options Panel. 

 

 

 

 

Slide Settings 
The very top of the Side tab in the Options panel shows an 

image / thumbnail of the selected slide. Beneath the 

image is a text field where you can name your slide. The 

name will show at the bottom of the slide itself and inside 

the Slide Settings tab at the top of the Navigation Panel. 

 

 

 

 

 

 

 

You can also set your slide timing here. Manual 

allows you to type the desired slide time directly into 

the Slide. Automatic is used when you Quick Sync 

your slides to your music. You can also choose to Lock 

your slide to a video layer, the Slide Sound, or a 

specific time of your choosing. If you choose the Lock 

to option, your slide time cannot be changed 

manually until the Timing mode is switched back to 

Manual or Automatic. 

You can also change your transitions and their times 

in this tab. 

 

 



In the Settings area of this tab you can Flag your slide as well as Hide either the watermark or the 

background for this specific slide. Flagging a slide puts a yellow flag at the top right corner of your slide in the 

Slides List and the Navigation Panel. 

 

Reset Slide will remove any Slide Style, keyframe animations, or other adjustments currently applied. This is 

effectively the same as choosing the “No Style” slide style. 

Slide Style List 
 

When the Slide Style option is selected in the Navigation Panel your Slide Style List will open in the Options 

Panel. This is a list of all installed Slide Styles, organized into Categories. Learn more about applying Slide 

Styles here. 

 Slide Style Information 
Directly above your Slide Style list is more 

information about the currently selected 

Slide Style, including its name, 

recommended times, description, 

categories, and any variants it may have.  

 

 

 

 

 

 

 

 

A Variant determines whether the Style can be 

used with more than one image orientation. 

 



Clicking on the “i” next to the Variants brings up more 

information about those variants, including which 

image orientations they work with, and which ones 

they do not. You do not need to do anything to have 

the correct variant applied. Photopia will 

automatically detect your image orientation and 

apply the correct variant. 

 

 

 

 

 

 

 

 

Slide Style Categories 
The Slide Style list provides a thumbnail of the 

Slide Style, its name, and recommended Slide 

/ Transition times. Clicking the star icon on 

the right-hand side of the list will add that 

Slide Style to your local Favorites category. 

You are also shown how many Caption and 

Image layers are in each Slide Style. 

The Search bar at the top of the Slide Style list 

allows you to find Slide Styles more easily. 

The Category option is listed at the top-left 

corner of the Slide Styles list. You can click the 

link next to the Category label (shown left) for 

a drop-down category list OR click the double-

left-arrow icon (just left of the Search bar) to 

include the Category list next to the Slide 

Styles list. The numbers on the right-hand 

side of the Category list show how many Slide 

Styles are in each category. Slide Styles can be 

in more than one category. 

 

 

 

 



Slide Style Filter 
You can filter the Slide Style list, hiding any Slide Styles that do not fit 

the selected filters, by clicking the link next to the Filter label. If you 

only want to be shown Slide Styles that have two images and one 

caption, choose those options from the Slide Style Filter window. All 

other Slide Styles will then be hidden from the Slide Styles list. 

 

Be sure to click the Reset button in the Slide Style Filter window when 

you are done. Leaving a Slide Style filter enabled can cause confusion 

next time you look for a Slide Style that does not happen to match the 

currently applied filter settings. 

 

 

 

 

 

Sorting the Slide List 
You can Sort your Slide Style list based on Name, Layers, or Captions. 

 

Slide Sound 
 

When the Slide Sound option is 

selected in the Navigation Panel, 

three tabs will appear in the Options 

Panel: Audio Settings, Soundtrack, 

and Slide Sounds. The Audio 

Settings and Soundtrack Tabs are 

the same tabs seen when selecting 

an audio file from the Soundtrack 

List in the Show Tab. The additional 

Slide Sound tab is where you can add a sound file or record a voice narration. Learn more about adding Slide 

Sounds or recording your own Narration here. 



Layers and Content Tabs 
Beneath the top three options in the Slide Tab in the Navigation Panel are tabs for Layers and Content 

(Advanced / Compact layouts only). Each of these lists show the content inside your slide, but in different 

ways. When a Slide Style is applied, the Layers list shows all content, including construction layers, such as 

Groups, Masks, and other layers that you may not need to adjust. In the Content tab you will see only the 

content you might need to adjust, including content you have added to the slide and any layer placeholders 

added by the applied Slide Style. 

Click these links to learn more about the Layers tab and Content tab. 

Layer Settings 
With your image layer selected in the Layer List in the Navigation Panel, you will see some basic Layer 

Settings in the Layer Tab in the Options Panel. 

 

Source – This option shows a thumbnail of the image in this layer along with the Select Source (folder icon), 

Open in External Editor (folder with arrow icon), and Information (lowercase “i” icon) buttons. 

Shape – This option allows you to apply a Shape to your image / video layer. Use the Select button to change 

the selected shape from a dropdown menu. Click the Browse option in that menu to see thumbnail examples 

of each shape. Once you have a shape applied you can Edit that shape. Learn more about Shapes here. 

Scaling – This is where you can choose between Fit to Frame, Fill Frame, or Stretch to Frame. Learn more 

about Scaling here. 

Rotation – This option provides quick layer rotation in 90-degree increments. This change is applied before 

layer animations. There is also a separate Rotate option in both the Adjustments Tab (also not animated) and 

in the Animations Tab (using Keyframes) which provides more granular rotation control. 



Visibility – This option provides a quick way to hide the selected layer, which can be helpful when editing 

complex layer sequences. 

Local/Global – Unchecked, this is a “local” layer, meaning it is only in the current slide (the default for most 

layers). Checked, this becomes a global layer, meaning it will be present in every slide. 

Reset Layer – This will remove any changes that you have made, such as scale, position, or rotation, and reset 

your image back to the default settings. 

Name and Notes – Below the 

thumbnail for your image are 

Name and Notes text fields. 

The Name field will replace 

the image file name in the 

Layers list. Notes will only 

appear in the Layer tab, but a 

Notes “speech bubble” icon 

will appear to the right of the 

Layer Number in the Layers 

list, indicating that it has 

notes attached. 

 

 

You can change which layer 

is selected by clicking 

another layer in the Layers 

list from the Navigation 

Panel or by clicking the 

dropdown menu at the top 

of the Layer tab in the 

Options Panel and clicking a 

different layer. 

 

 

 

 

 

 

 



The Browser 
The main function of the Browser is to facilitate adding content to your slide shows. It supports adding files 

from your local computer, the royalty-free Music Library, and select third-party services. This is also where 

you can add / modify Solid Colors and Gradients. The different access points are represented by different 

icons at the top of the Browser. 

 

Computer File List 
This icon gives you a file tree that allows you to search through your computer to find 

images, video, and audio files that you have on your local computer. 

 

Once you navigate down to 

the folder that has your 

files, you have more options 

to search, view, and sort 

your media. Folders in this 

list can be added to the 

Favorites list by right-

clicking on the folder and 

choosing the Add to 

Favorites option. This is 

done with ALT+click on the 

Mac platform. 

 

Search 
If you know the name 

of the file you are 

looking for, start typing 

the name in the Search 

Box and files that match 

what you are typing will 

begin showing in the 

File List.  

 



Sort 
You have several options to Sort your images using 

the Sort dropdown menu. Once you have chosen a 

variable to sort by, you can reverse the sort order 

by clicking on the arrow to the right of the 

dropdown menu. 

 

 

 

 

 

 

View 
You can toggle between a Thumbnail View and List View in this section of the browser. When selecting an 

image, in either view, the Options Panel will display information related to that image. 

      

                            Thumbnail View               Details View 

You can sort by the column categories in the Details view by clicking on the column heading. 

Right-Click (Windows) and CTRL+Click (Mac) 
Both the Thumbnail and Details Views give you the same options when you right-click (Windows) or 

CTRL+click (Mac). 

• Add to Show adds selected images to the show 

• Add as One Slide adds selected images as one slide 

• Add to Selected Slide(s) adds to pre-selected slides 

• Go to Slide takes you to the slide an image is used in 

• Preview opens an image information window 

• Change the view between Icon and Details 

• Change the Sort by option 

• Show Columns set visible columns (Details View) 



 

The Music Library 
This is a collection of 550 of Royalty Free songs that you can use in your slide shows, 

whether they are for personal or commercial use. The Music Library browser window 

functions in a similar way to the Computer File List in terms of Search, Sort, and View. 

 

Categories and Subcategories 
 

Songs in the Music Library are organized into categories and subcategories, listed 

on the left side of the window. When a song is selected, information about that 

song is displayed in the Options panel on the right.  

 

 

 

 

 

 

 

 

 

 

Favorites 
The Special Selections section of 

the Category list includes the 

Favorites and Used in Show 

categories, both very useful. Click 

the star icon on an audio track to 

add that track to your Favorites 

category. 

 

 

 

 

 



Search, View, and Sort 
The Search bar and Thumbnail/Details Views in the Music Library work the same as the Computer File list. 

Choose the Details View to sort your music and click on any of the columns at the top to sort by that 

category. Right-click (or CTRL + click on Mac) then choose Sort By to sort by a column that is not listed. Right-

click (or CTRL + click on Mac) and choose Show Columns to add or remove columns from the Details View. 

      

Previewing Songs 
ll songs in the Music Library are initially stored remotely (in the cloud). Songs and song previews (30-second 

preview clips) will need to be downloaded before they can be played. This will start automatically when you 

click the Play button for either the Preview 

or Full Track. 

If you have not downloaded a song yet, you 

will see a little cloud icon next to the star in 

the Thumbnail view, and the download icon 

will be available. 

 

 

 

 

    

If you previously downloaded a song, the 

cloud icon will be missing and the download 

icon will be ghosted.  

 

 

 

 



Solid Colors 
 

The Solid Color window is where you can create Solid Color layers using presets, the Hue / 

Saturation wheel, or the eye dropper. The Alpha option lets you specify the amount of 

transparency for the layer. You can also give a Solid Color layer a specific resolution, which 

can be helpful if you need a Solid Color layer at a specific aspect ratio. 

There are five different ways to choose a specific color for your Solid Color Layer: 

 

Preset Colors 
There is a large selection of preset 

color swatches available for you to 

choose from on the left side of the 

Solid Color window. Simply click 

on a preset color, then click the 

apply button.  

 

 

 

 

 

 

 

Hue and Saturation Wheel 
The Hue / Saturation Wheel consists of two elements; the Hue 

Circle on the outside (a gradient that covers all the colors of the 

rainbow) and the Saturation Triangle on the inside (the intensity 

/ darkness of the hue). The triangle in the upper right corner 

shows the current color. 

 

Click anywhere in the Hue Circle to select a Hue. Once that is 

done, click anywhere in the Saturation Triangle to set the 

intensity of the selected Hue. 

 

 

 

 



Eye Dropper 
 

The Eye dropper tool allows you to pick an exact color from any part of the 

screen, including inside other applications. If you want to choose a specific color 

from an image you have in your slide show, there are three different ways to 

achieve this.  

 

 

 

 Select your image from the 

Browser first, producing a 

large thumbnail of that image 

in the File Information tab.  

 

 

 

 

 

 

Once your image is 

available in the Options 

Panel, use the eyedropper 

tool to select your color.  

        

 

 

 

 

 

You can also select a color directly 

from your Layers list, or the Slides List 

below.  

 

 



 

The Magnifying Tool can help you 

see exactly which colors you need 

from your slide thumbnails.  

First, click on the Magnifying tool in 

the far upper-right corner of the 

screen. Then, click on the Eye 

Dropper tool and choose your color 

from anywhere on the screen. 

 

 

 

 

RGBA number 
The RGBA numbers are a standardized way to reference colors (with transparency). If you have an exact 

RGBA color value you would like to match, simply type it in and your colors will be a perfect match. 

 

RGBA Sliders 

The RGBA sliders are located beneath the Hue / Saturation Wheel. RBGA stands for Red, Blue, Green, and 

Alpha? Alpha is the layer’s transparency. If you set this solid layers Alpha to 0, it becomes completely 

transparent, noted by the checkerboard thumbnail instead of a solid color. Unlike changing a layer’s opacity 

to 0, you can still add an outline to this layer, which can be seen.  

 

 



 
This gives you more options for creating frames with a transparent center; something you could not do if you 

changed the Layers opacity to 0. 

Re solution – The resolution is in pixels. The default 

resolution is 1920 by 1080, the High-Definition standard.  

You can use these numbers to create other types of 

solids, such as a square by making both height and width 

numbers identical, or you could create a thin line, by 

changing one of the numbers to something very small, 

like 4.  The left number box is the width, and the right number box is the height. You can always reset your 

resolution back to the default by clicking on the Reset button. 

 

 

 



Recent Colors – A list of the 

most recent colors you have 

chosen is shown at the 

bottom of the screen. 

 

 

 

 

 

 

 

Gradient Layers 
Gradient Layers are like Solid Layers, but instead of having only one color you’ll have a 

minimum of two that blend together.  You can add as many colors to your Gradient layer as 

you would like and blend them in different ways using the tools inside the Gradients 

window. 

 

Presets 
 

The Gradient window comes with many presets you can choose 

from. Start by choosing a category from the dropdown menu, 

then select one of the gradient choices within that category.  

 

 

 

 

 

 

If you have created your own unique gradient, or customized one of the 

presets, you can add that gradient as a new preset using the add button 

at the bottom. You can also remove a preset you do not want by 

selecting it and clicking the remove button 

 

 

 



Gradient Type and Settings 
Whether you are starting with a preset or creating your own gradient, you can change the look of your 

gradient using the settings on the right. You can change the Gradient Type and Resolution (how many pixels 

vertically and horizontally your gradient layer will be). The Position, Angle and Seed options will be ghosted 

for some of the Gradient Type choices, and available for others. 

 

Gradient Type 

 

Linear – Creates a straight path through your color choices. The Position and Seed options will be ghosted for 

Linear Gradients 

 

You can change the direction of the linear path by changing its Angle by either entering a number in the text 

box or by clicking inside the preview window and dragging your mouse. 



 

 Radial – Creates a circular path through your color choices. The colors are blended from the center point 

outward. The Angle and Seed options will be ghosted for Radial Gradients. 

 

 

You can change the Position of the center of the Radial by either entering numbers in the vertical and 

horizontal Position boxes or by clicking inside the preview window and dragging your mouse. 

 

 

 

 

 

 

 



 

Angular – This creates a combination of the Linear and Radial types. It has a center point like the Radial type, 

but Angular does not move through the colors from the center point outward. Instead, it moves through those 

colors around the center point, in a linear fashion, creating a hard line where the first and last colors meet.  The 

Seed option is ghosted for Angular gradients. 

 

 
 

You can change the Position for the center of the Angular gradient by either entering numbers in the vertical 

and horizontal Position number boxes or by clicking inside the preview window and dragging your mouse. 

You can also change where the first and last colors meet by changing its Angle. 

 



 

  Rectangular – This creates a gradient effectively identical to the Radial gradient except in a rectangular 

shape instead of a circle. The Angle and Seed options are ghosted for rectangular gradients. 

 

 

 

You can change the Position for the center of the rectangular gradient by either entering numbers in the 

vertical and horizontal Position number boxes or by clicking inside the preview window and dragging your 

mouse. 

 

 

 



 
 

Diamond shaped – This creates a gradient identical to the Rectangular gradient but in a diamond shape. The 

Angle and Seed options are ghosted for Diamond gradients. 

 

 

 

You can change the Position of the center of the Diamond by either entering numbers in the Vertical and 

Horizontal number boxes or by clicking inside the preview window and dragging your mouse. 

 

 

 



 

Plasma – This creates a randomized ‘flowing’ look through your color choices. Plasma is the only Gradient 

Type that uses the Seed option. Clicking the Randomize button next to Seed will give you different results in 

the look of the plasma effect, as will clicking on the gradient preview area. The Position and Angle options 

are ghosted for Plasma gradients. 

 
 

Resolution – This is the size of your gradient layer. It will default to a standard video resolution size. Unlike 

the Solid Color option, a larger resolution can be helpful when making sure a Gradient layer appears smooth. 

 

 

 



 
 

 

You can change the resolution of your gradient to make other shapes, such as a square, a thin line, or a tall 

rectangle instead of a wide one. 

 

 

Color Keyframes 

 

Color Keyframes create a Start and End point for gradient layers. 

 

Colorspace – This option changes the way 

gradient color keyframes blend. If you 

toggle back and forth between HSV and 

RGB you will see that they create different 

gradients, despite having the exact same 

color keyframes. 

 

 

 



 

RGB (Red, Green, Blue) – This Colorspace blends the colors you have chosen and only the colors you have 

chosen. If you have one red keyframe and one blue keyframe, the blend in the middle will be red and blue 

blended together. 

 

HSV (Hue, Saturation, Value) – This Colorspace does not blend your chosen colors together, but instead goes 

around the color wheel from your first keyframe to your last. So if you have one red keyframe and one blue 

keyframe the resulting ‘blend’ will go around the color wheel from Red through Purple to Blue, including all 

hues between. 

 

 

 



 

To get a simple blend from either Black or White to a color keyframe, set the Colorspace option to RGB. 

                       

 

Adjusting Color Keyframes – Color keyframes are the “pallet” for creating your gradient. You can 

add new keyframes, choose their position within the gradient, and set opacity for individual color keyframes. 

 

  

Choosing the color – Start by selecting the color 

keyframe, then click on the Color swatch above the Color 

Keyframes. This gives you the same Hue and Saturation 

color wheel as found in the Solid Layer window. You can 

use the eyedropper tool to pick the color from another 

keyframe or anywhere else on your screen. 

 

 

 

 

 

 



 

Opacity – Changing the opacity of a single color keyframe can give you transparent effects, such as giving the 

center of a radial gradient an opacity of 0, while the outer keyframe remains at 100% 

 

 

Position – The position of your color keyframes changes where that color is placed inside the gradient. If you 

move one of the outer keyframes in, a new outside keyframe is created, using the same color. 

 

 

Add, Remove, Reverse – You can add a new Color Keyframe by double-clicking above the gradient keyframe 

area or by clicking the add color stop button. You can remove color keyframes by selecting them then clicking 

the remove button. The reverse button will flip your keyframes from left to right. 

 

 

 

 



 

Favorites 
This window is for folders that you might access often while creating a show. This Favorites 

list might change for each show you work on. You may have regular folders that you access 

frequently, and you may have some folders that you need to access quickly for only one 

show. You can add and remove folders from your Favorites list easily.  

 

Use the Computer Icon in the Browser to find the folder you 

need to add to the Favorites list. Right-click (or CTRL+click for 

Mac) on that folder and click the Add to Favorites option. 

 

 

Right-click (or CTRL+click for Mac) on a folder in the Favorites list to 

remove it from the list using the Remove from Favorites option. 

 

 

 

 

Social Media 
These windows give you access to files you have stored on social 

media and Cloud sites.  Click the Login button to go through the 

login process for the selected social media site. You must allow 

Photopia access to the account through the subsequent prompts. 

 

 

 

 

 



 

Once you have granted access 

permission you will see a root folder 

with all your subfolders for that 

service. You can now add content to 

your slide show from this social media 

site in the same way you would add 

content from your local computer, 

using drag-and-drop or double-click 

actions. 

 

 

 

The Preview Window 
The main function of the Preview Window is to show you your slide show as it plays back, but it is so much 

more. It is an interactive window where you can manipulate your layers, either globally or by using 

keyframes. First, we’ll go over all the tool sets that are displayed around the outside of the Preview Window, 

then show you how, and when, you can use them. 

Player Controls 
There are standard player controls located at the bottom left corner of the Preview Window. 

 

A. Go to Start (the first slide in your show) 

B. Go to Previous (the beginning of the slide before the one selected) 

C. Play / Pause (plays your show from the current position then becomes the Pause button) 

D. Stop (stops playback) 

E. Go to Next (the beginning of the slide after the one selected) 

F. Go to End (the last slide in your show) 

G. Current Timecode (displays the time at which the timeline marker is currently located)  

H. Total Run Time (displays the total run time of the slide show) 

I. Audio (mute toggle) 

J. Go to Slide (jump to a specific slide number) 

K. Full Screen Playback (full screen toggle) 

L. Play Slide (plays only the slide that is selected, including both in and out transitions) 

 

There is also a slider above the player controls. You can use this to “scrub” through your entire show. This 

slider will be in sync with the slider in the Slides List. 



Preview Modes 
 

When viewing your slide show in the Animations Tab, you’ll see three 

different preview layouts and an optional keyframe thumbnail view 

in the upper left corner below the tabs. 

 

The slider beneath the Preview shows the time for the Transition In and Transition Out, as well as the Slide 

Time, in a single timeline. 

 

Single View 

In this view you will only see 

what your audience sees. 

The Preview window will 

always show the current 

location of the playback 

slider. You can scrub your 

scrub the playback slider to 

see your slide show at a 

particular time or select a 

keyframe to see the slide 

show at that precise point. 

 

 

 

 

Double View 

This view provides two adjacent 

keyframe Previews. It is best 

used for simple animations that 

only use two keyframes, giving 

you a basic “Start” and “End” 

view. This view can be used 

with more than two keyframes, 

but the two preview windows 

will only show adjacent 

keyframes, not the start and 

end of the selected layer. 

 

 



Triple View 

In this view the main preview window 

shows either the current playback 

position or the currently selected 

keyframe. If there is a keyframe prior 

to the selected keyframe, you will see 

a small thumbnail of that on the left. If 

there is a keyframe after the selected 

keyframe, you will see a small 

thumbnail of that on the right. When 

there are no adjacent keyframes, that 

area will be blank. You can adjust the 

relative size of these previews using 

the zoom slider next to the View icons. 

 

 

Keyframe Thumbnails 

When the keyframe 

thumbnails option is enabled, 

you will see small thumbnails 

directly above each keyframe 

marker. Those thumbnails 

show what the slide looks like 

at that exact keyframe. If the 

keyframe is moved, the 

thumbnail will change to 

match the new keyframe 

position. 

 

 

 

 

Layer Adjustment Tools 
When a layer is selected in the Layers List a set of animation tools will appear in the lower right corner of the 

Preview window (these tools disappear during playback and “scrubbing,” ) so if you do not see them, click 

on a layer in the Layers tab and they will appear).  

 



When a tool is enabled, it will be blue. When it is disabled, it will be dark grey.  

 

These tools determine how you can manipulate layers using the mouse inside the Preview window. If 

multiple layers are selected at one time and any of those layers is adjusted, each of the selected layers will be 

adjusted by the same amount. Changes here are applied to the whole layer OR the layer animation (i.e. 

keyframes) based on which tab is active at the time the tools are used. Make sure the Layer / Caption 

Settings tab, or the Adjustments tab, is selected to make changes that apply to the whole layer duration. 

Make sure the Animations tab is active, with a keyframe selected, to make changes that apply to that specific 

keyframe. 

 

 Selection Tool – With this tool enabled you will be able to select any layer in your preview window 

by clicking on it. Holding the CTRL key while clicking allows you to select multiple layers at once. If 

this tool disabled, you must select the layer you want to manipulate from the Layers list first. This 

can be useful if you have layers that overlap, and you want to avoid accidentally selecting a different layer 

than you intended when clicking inside the Preview window. 

 

Position Tool – With this tool enabled you will be able to click and drag a layer within the preview 

layer to move it.  

 

Rotate Tool - With this tool enabled you will be able to rotate a layer 

within the Preview window by using the rotate handles. The rotate handles 

will appear as curved arrows in each of the four corners of the layer. Click 

on one of these handles and drag to rotate the layer. 

 

Skew Tool - With this tool enabled you will be able to skew a layer within the 

preview layer by using the skew handles. The skew handles will appear as 

straight arrows along the sides of your layer. Click on one of these handles to 

skew your layer.  

 

Tilt Tool - With this tool enabled you will be able to tilt a layer within the 

Preview window by using the tilt handles. The tilt handles will appear as 

curved arrows at the mid-points along the sides of the layer. Horizontal tilt 

handles are at the left / right with vertical tilt handles at the top / bottom.  

 

 

 



Motion Path Tool  

With this tool enabled you will be 

able to see the path your image 

will take across all keyframes. 

 

 

 

 

 

 

 

Bezier Handles – Small yellow dots will appear in between all keyframes directly on the Motion Path when 

this tool is enabled. These are Bezier handles. They allow you to create a curved path between two 

keyframes by moving the Bezier handle. 

      

 

 

When using Bezier handles, a 

Smoothness Slider will appear in the 

upper left corner. This determines the 

severity of the curve. A smoothness 

value of 100 will cause the curve to be 

pulled far away from the keyframe 

points. A smoothness value of 0 will 

result in a straight line. 

 

 

 

 

 



Preview Tools 
 

The tools in the upper-right corner allow you to 

view or hide certain guides in the Preview window. 

None of them are seen in a final rendered video, 

they are simply visual guides to use as you create 

slide shows. These tools are also found in the right-

click menu in the Preview window. 

 

 

 

 

 

Safe Zone – This tool provides 

a visual guide of the outer 

areas of the preview screen, which can 

get cut off on older TVs. This is not 

relevant on modern TVs or when 

sharing videos on the internet. 

 

 

 

 

 

 

 

 

Toggle Grid - This tool enables 

(or disables) a visual grid on 

the Preview window. It can be used as a 

visual reference for image placement 

using concepts such as the “Rule of 

Threes” (shown right).  

 

 

 

 

 

 



 

Define Grid – This tool 

changes the grid Size and 

Color. Changing the Grid Size to 2 x 2 

provides a basic crosshair, which can be 

useful to mark the center of the slide 

show frame. 

 

 

 

 

 

Show Inactive Layers – This 

tool makes all layers appear at 

full opacity in the preview window. The 

layer you have selected in the Layers list 

will be seen with a dotted line around 

its edges. 

 

 

 

 

 

Darken Inactive Layers - 

This tool makes only the 

layer selected in the Layers list appear 

at full opacity. All other layers will be 

slightly darkened. 

 

 

 

 

 

 



Hide Inactive Layers 

– This tool makes 

only the layer selected in the 

Layers list visible. All other 

layers will be hidden. 

 

 

 

 

 

 

 

Show Keyframe Markers – This tool makes keyframes 

visible in the Preview window. Keyframes are a great 

visual reference in this space, letting you know which keyframe 

you have selected while also indicating where the layer will be at 

other keyframes. 

 

 

 

 

 

 

Show Motion Path – This tool shows a line 

between all your keyframes. Show Motion Path 

also provides access to the Bezier handles between 

keyframes, allowing you to create curved paths. 

 

 

 

 

 

 

Center Point Tool – This tool toggles the visibility of the 

layer Center Point marker. 



The position of the Center Point is controlled with the Rotation Center option (shown above). This is the point 

your layer will Rotate and Tilt around, like an anchor. 

 

Zoom Slider - This option controls the scale of the 

canvas, allowing you to zoom in and out. This can 

be helpful when you need to find layers that are 

out of view. When an image layer is positioned off 

screen you might need to zoom the canvas out to 

view the layer outside of the visible canvas. 

 

 

 

 

Canvas Pan Tool – This tool allows 

you to move the entire canvas by 

clicking and dragging in the Preview area, 

making it easier to find layers outside the 

slide show frame. With this tool enabled, 

selection tools are disabled to prevent 

unintended layer changes. 

 

 

 

Reset Canvas – This tool resets the 

canvas Pan and Zoom to their default 

values. 

 



Under the Right Click 

There are two additional features in the right click menu in the Preview window, along with all the features 

represented by icons in the top tool bar.  

 

Capture a Frame – This tool captures a still image from the currently 

displayed frame of your slide show. Scrub the slide show to find the 

exact frame you would like to capture before using this tool. The 

default resolution is 1920 x 1080, but you can set a different 

resolution for each capture. 

 

 

 

 

 

 

 

Set Frame as Show Thumbnail – This tool sets the show 

thumbnail based on the currently displayed frame. The 

default thumbnail for your Show and Project is the middle of 

the first slide. Use the Set Frame as Show Thumbnail to 

change that to any 

other frame you 

want. This is also the 

thumbnail used on 

the Home Page. 

 

 

 

 

 

 

 

 

 

 

 



 

The Slide List 
Now that you know where to access your images and how to preview them, you are ready to start adding 

them to your show. Your Slides are shown to the Left of the Browser / Preview tabs in Light Mode and 

beneath the Preview and Browser tabs in both the Basic and Advanced Modes. 

 

Light Mode 

                      

 

 

 

 

 

 

 

 

Basic Mode 

 

 

 

 

 

 

 

 

Advanced Mode 

 

 

 

 

 

 



 

Your Slides will all show the following information, regardless of the User Interface you are in. 

Slide Number – This is the numerical order of your slides. 

When a slide changes position in the list its Slide Number 

changes. 

Slide Name – When a Slide Name is set it will show in the 

Slide. This could also be the name of an applied Slide 

Style, or it will be empty if no name is set, or Slide Style 

applied. 

Slide Time – The length, in seconds, of the slide.  This 

does not include transition times. 

Slide Timing Mode – This can be set to Manual (a time you set), Automatic (a time the program sets; music 

syncing), or Locked (time is ‘Locked to’ a video layer duration or a custom time). 

Transition Used – The thumbnail shown tells you which transition is being used after the slide. 

Transition Time – The time for the transition, not including the slide time. 

Transition Timing Mode – This can be set to Manual (a time you set) or Automatic (a time the program sets; 

music syncing). 

 

The slide thumbnails can show different things. 

In the Advanced UI Layout they show a 

preview of your slide as it is seen in the slide 

show (shown above). In the Light and Basic 

Layouts they show the slide content only 

(shown left). When the slide is selected the 

images will expand (shown below) 

 

 

 

 

 

 

 

 

 

 



Adding Images to your Slides 
There are six different ways to add a single image or video to a slide: 

 

Drag and Drop from Browser – You can create a new slide by dropping an image at the end of your slide list 

or by dropping it between existing slides. Dropping an image onto an existing slide will add that image to the 

slide where it was dropped. 

 

A blue line surrounding a slide indicates you will be adding 

your image to that slide. (Shown right) 

A single blue line indicates you will be adding your image to a 

new slide in between two existing slides. (Shown below) 

 

 

 

 

 

 

 

 

Right Click – Right-click on an image in the Browser and 

choose “Add to Show.” This will add that image to your 

slide show as a new slide. Choosing “Add to Selected 

Slide(s)” will add that image to any slides selected in the 

Slides List / Lightbox.  

 

 

 

 

 

 

Add Blank slide – This option will add a blank slide directly 

after the currently selected slide. Blank Slides are useful 

for title slides and to create visual space between sections 

of a multi-part slide show. 

 

 

 



Add Photo / Video (Green button) – This button will open a 

Browser pop-up. Images added through that pop-up window 

will be inserted after the currently selected slide. 

 

  

 

Add Photo or Video (Advanced / Compact Layouts) – This 

option will add a new image at the very top of the Layers list in 

the currently selected slide.  

 

 

 

 

 

 

 

Drag-and-Drop (from OS) – You can add image / 

video files to your slides directly from the 

Operating System (OS). Files can be dragged in 

from “File Explorer” on Windows and “Finder” 

on Mac. The ‘drop’ part of the process works in 

the same manner as dropping image / video files 

into the Layers / Slides lists from the Browser in 

Photopia. 

 

 

 

 

 

 

Adding multiple images 
You can add multiple images to your slides at one time, either all in the same slide, or all in different slides. 

 

CTRL / SHIFT + Drag-and-Drop – Select 

multiple images from the Browser. Click 

on the first file you want to select then 

hold down the SHIFT key and click on the 

last file you want to select. This will 

provide a continuous selection. Use the 

CTRL key instead for a non-continuous 

selection.  



Release the SHIFT / CTRL Key then drag-

and-drop the selected slides onto the 

Slides List. Drop at the end of the slide 

show, or where there is a blue line shown 

for the insertion point, and the selected 

image / video files will be added as 

individual slides. Drop onto an existing 

slide, while there is a blue outline around 

that slide, and the selected image / video 

files will be added to that slide as new 

layers. 

 

 

 

 

Press + Hold the CTRL Key just before 

the selected slides are dropped into the 

Slides List, making sure to keep the CTRL 

key held through the drop action, and 

the dropped image / video files will be 

added as a single new slide (or dropped 

into an existing slide, if one is 

highlighted).  

 

 

 

 

 

 

 

 

 

 

Right-Click – With several images / video files 

selected in the Browser, right-click, and choose 

either “Add to Show” (adding each image / video as 

a new slide), “Add as One Slide” (adding all selected 

images / videos to a single new slide after the 

currently selected slide), or “Add to Selected Slide” 

(adding all selected images / videos to each 

currently selected slide).  

 



 

 

Add Photo / Video (green button) – Adding multiple images 

using the Add Photo / Video button (above the Slides List) will 

always add those images / videos as multiple new slides.  

 

Add Photo or Video (Layers List – Advanced / 

Compact Layouts) – Adding multiple images using 

the Add Photo or Video option in the Layers list will 

always add those images / videos to the selected 

slide.  

 

 

 

 

 

 

Used in Show – A green circle with a white number 

will appear on files in the Browser that exist in the 

project, even if they are in other slide shows within 

the project. This indicates the number of slides that 

contain that file, for images / videos, and does not 

count duplicates in a single slide.  

 

 

 

 

 

If you see a number by an image and would like to 

go directly to the slide that the image is in, right 

click on that image and choose Go to Slide. 

 

 

 

 



Moving Images Between Slides 
You can move or duplicate images / videos from one slide to another.  

 

In the Basic and Light layouts, you can move an image from 

one slide to another by clicking on that image’s thumbnail in 

the Slides List and dragging it to an existing slide or into a 

new slide (look for the thin blue line to indicate the ‘drop 

action’ will create a new slide).  

 

 

 

You can duplicate an image from one slide to another 

in the Basic and Light layouts by holding down the 

CTRL key as you click and drag the image from one 

slide to another or into a new slide (look for the thin 

blue line to indicate the ‘drop action’ will create a 

new slide). 

 

 

In the Advanced / Compact Layouts you can duplicate images / videos from one slide to another by dragging 

and dropping the image / video from the Content tab or Layers list directly onto the slide you would like to 

add it to, or into a new slide (look for the thin blue line to indicate the ‘drop action’ will create a new slide). 

Moving an image between slides can be done by holding down the CTRL key during the drop action in these 

layouts. 

Show Background 
A single image / video can be used as the background for your entire slide show (Advanced / Compact layouts 

only). You will see the Show Background in every slide. When you start a new show, the Show Background 

defaults to a solid black layer. 

If your image does not fill the entire slide 

show frame (ex. portrait image with “Fit to 

Frame” scaling in a widescreen slide show) 

you will see black on either side of the 

image. The background can also be a Solid 

Color, Gradient, or video file. Show 

Backgrounds are global, meaning they 

appear on every slide. 

 

 



A t the bottom of the Layers list for every 

slide you will see the word Background. 

Beneath that you will see a black solid layer 

with a G2 and eye icon on the right side. 

The G2 means that this is a Global Layer 

(appears on every slide) and is the 2nd 

Global Layer in the list (a Watermark is the 

first Global Layer, G1). The eye icon is a 

visibility toggle, allowing you to hide / show 

the background for each individual slide. 

 

 

Changing your Show Background 
Select the Background layer from a slide and you will see Show Background options appear on the right side 

of the screen in the Options Panel. 

This window shows a thumbnail of the 

current Show Background and provides a 

checkbox to hide it from the current slide (if 

you click on the eye icon in the Layers list, this 

option will automatically become unchecked). 

Click the Edit Background link at the top to 

change the Show Background. 

 

 

 

 

 

 

After clicking on Edit Background the next window 

may look very similar. The options available here 

will become clearer once we’ve added a different 

type of background. Click the folder icon beneath 

the Show Background thumbnail to open the 

Browser. 

 

Navigate through the Browser to find a still image 

to add as your new Show Background. 

 

 



Once you have chosen an image 

for your Show Background, you 

will see it appear in any slide 

where the background is visible. 

 

Note: You will not see the show 

background in slides where your 

image fills the slide show frame 

or when a typical Slide Style has 

been applied. 

 

 

 

 

 

 

Show Background Image Adjustments 
 

Now that you have an image set as the 

Show Background, the Adjustments Tab (to 

the right of the Background tab) becomes 

relevant. 

You can make many of the same 

adjustments to your background image 

layer that you can make to any other layer 

in your show. Any adjustments made here 

will be applied to the background for the 

entire show. 

 

 

Show Background Video File 
 

You can also use a video file as the Show 

Background. It is recommended to only use 

looped video backgrounds for this purpose. 

Looped video backgrounds are designed to 

have their last frame and their first frame 

match, so when the video file loops back to 

the beginning, the viewer will never notice. 



Once you have chosen a video file as your Show Background you will see these Video Clip Settings options. 

• Trim the beginning or ending of your video (not recommended if it loops) 

• Change the Speed of the video 

• Loop the video (should be left enabled, even with videos not designed to loop) 

• Hold Options 

Using a Different Background in Individual Slides 
If you would like an individual slide to have a different background than the Show Background, you can add a 

new layer to the Layers list, then drag that new layer below the word Background, but above the Show 

Background (G2) layer. 

Slide Styles 
Slide Styles are pre-generated slides that can be applied to existing slides, replacing the layers / captions 

therein with layers / captions that have been setup to create a specific effect. Slide Styles can be applied to 

blank slides or slides that already have images / videos. 

 

Slant Left Title – Bundled with Photopia 

Photopia has many built-in Slide Styles ready to use. You can also import Slide Styles created by others. 

 

 

 

 

 



The Slide Style List 
Slide Styles can be accessed from the Slide Style list. In the Basic and Light layouts, click the Slide Style tab in 

the Options Panel.  

 

Basic and Light Modes 

In the Advanced layout, click the Slide Styles tab in the Navigation Panel.

 

Advanced Mode 

 



Applying Slide Styles 
You can apply Slide Styles to slides that already have images / videos or to blank slides. If a Slide Style is 

applied to a blank slide, and uses image layers, placeholders will appear for you to drop your images into. 

In the example below, two images of different orientations are added to a blank slide and a Slide Style is 

previewed before applying, to ensure the images are placed in the correct place holder. 

 

First, add your images into a blank slide. Select from the Slide Style list the Slide Style you would like to see 

then click the Preview button. 

 

 

If the preview shows your images in the wrong placeholders, change the order of the images in the Content 

Tab then preview the Slide Style again. 

 



 

When you are happy with the way the preview looks, click the Apply button. 

 

 

You can also apply Slide Styles to Blank Slides. This is most useful for applying Title Slides that have no images 

in them, but you can also apply Slide Styles that have image layers to blank slides. 

 



 

The layers from the applied Slide Style will appear as placeholders. You can then drag images into the 

Content tab and drop them into those placeholders. Note the blue outline around the placeholder (sample 

above) indicating the dropped image will end up inside that placeholder. 

 

Simple image customizations can be applied from the Content Tab after the Slide Style is applied. 

Transitions 
Transitions are effects that transform one slide into the next. The default transition is a simple blend, or fade.  

Choosing a Transition 
  

You can choose a different transition for each slide by clicking 

the transition icon between slides (shown left). 

 

This will open the Transitions window where you can find 

new transitions, see a preview, and choose several options 

that will affect how the transition is applied. 



 

The layout of this window is like the Slide Style window.  Categories are on the left, Transitions are on the 

right, and a search bar is above the list of Transitions. The list of recently used Transitions is in the bottom-

left of this window, providing quick access to Transitions you may use frequently. 

Note: Transition categories and Side Style categories are different, although category names may be similar.  

To preview a transition, select it in the list, then hit the play button beneath the preview window. 

Click the star icon on the far right of the Transition to 

add it to your Favorites category. 

Above the list of transitions is a thumbnail of the 

selected transition, a recommended time for that 

transition, and the transition categories. 

 

Beneath that are two checkboxes for options that you 

can enable or disable if you choose to apply this 

transition. If you leave “Use duration specified by the 

effect” checked, your transition time will automatically 

be changed to the recommended time shown beneath 

the transition thumbnail. 

 

 



Excluding Backgrounds from Transitions 
 

“ Include background in transition” can create an interesting effect, 

depending on your show or slide background and which transition you 

are using. 

For our example, we have the Push Left transition selected and we are 

using a ‘wood grain’ Show Background. 

If we leave this option checked, to include the background in the 

transition, the entire background will move along with the transition. In 

our example below, you can see the right-edge of the background on 

the first slide as it pushes out to the left, we can also see the left-edge 

of the background on the second slide as it comes in from the right. 

 

If we uncheck “Include background in transition,” it means we want 

out background to be ignored by the Transition, so it does not move 

with the Transition effect. 

In our example below you can see the image from the first slide 

pushing off to the left and the image from the second slide pushing in 

from the right while our Show Background image remains still. 

This creates an effect that looks like your images are floating above the 

Show Background.  

 

 



Changing the Transition Time 
You can easily change the time of your transitions by clicking in the 

number box beneath the transition thumbnail and entering a new 

time. 

You can also change the transition time in Timeline View.  

 

 

 

 

Timing Mode 
When the Timing Mode is set to Manual, you can change the 

transition time to any number you would like.  

 

 

 

With the Timing Mode set to Automatic, the number box will be locked, 

and your transition times will be calculated to fit your Soundtrack. 

 

 

 

 

The Layer List  
 

Every slide consists of layers. When you add an image to a slide, for example, that becomes a layer. There are 

several other types of layers in addition to your photos, videos, and captions. Solid Color Layers, Gradient 

Layers, and Groups are all examples non-image/video layers. 

The Layer List Structure 
The Layers list is more than a list of content inside your slides. Its structure provides specific guidance for how 

your content will interact. 

 

 

 



 

Each slide will have two Global layers by default. There is a 

Watermark layer (G1) and a Show Background layer (G2), along 

with Transition and Background dividers.  Global means that 

the layer will be seen on every slide in your show. Local means 

the layer will only be seen in the selected slide. 

From top to bottom, your Layers list will include: 

1. Global Watermark (empty by default)  

2. A Transition divider  

3. Your slide content layers 

4. A Background divider 

5. Global Show Background (black Solid Color layer by default) 

 

 

If a Layer includes other layers underneath it, such as 

Groups, Masking Layers, or Adjustment Layers, you will see 

the container layer as collapsible, and the layer numbers on 

the far-right side may appear to skip those inside of the 

container layer when it is collapsed.  Those layers are still 

there and active, they are just inside the collapsed container 

layer, and the container layer will show how many sub items 

are inside. 

 

 

 

 

When a container layer is open, you will be able to 

add or remove layers from inside it by dragging the 

double arrow line up or down. Dragging it up will 

bring the last layer out of the container group. 

Dragging it down will add the next layer to the 

container group. 

 

 

 

 

 

 



If your layer has the Slice Effect applied to it, you will see an 

Open Slices icon on the right which will open a list of individual 

slices for that layer that you can then animate individually. 

 

 

 

 

 

 

 

 

Layer Information 
Each layer in your Layers list will have a thumbnail, 

layer name, layer type, layer number, and visibility 

icon (the eye icon). 

The Layer Name is the top text line, and the Layer 

Type is the bottom text line. Image files will 

automatically have the filename as the layer name 

and “Image” as the layer type. If a Shape is applied to 

a layer, that will be added on the layer type line.  

In the example to the left, Layer 3 has the image file 

name “BrownPaperTexture” as the Layer Name, the 

word “Image” as the Layer Type, and the words 

“Banner 2” next to the “Image” label, showing that 

this image has the “Banner 2” Shape applied. 

 

 

 

Layers that are generated inside Photopia, such as Groups, 

Solid Color Layers, and Gradient Layers will show the same 

text for both Layer Name and Layer Type. You can easily 

change the layer name, for any layer, by right-clicking on the 

layer and choosing Rename Layer (shown right). Enter your 

new layer name and you will see it appear above the layer 

type. 

In the image to the right, the Group Layer has “Group” as the 

Layer Name and “Group Layer (2 sub items)” as the Layer 

Type.  



In the image below, we have changed the Layer Name to Text Banner Group. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Working with Layers 
 

 

All Layers stack on top of one another, like a deck of cards. The layers at the very top of the Layer List will be 

in front of the layers beneath it in the slide show preview window. Top = Front; Bottom = Back. (Note: this is 

not true in the Content Tab) 

 



 

You can change the order of your layers by clicking on them 

and dragging them up or down in the Layer List.  

 

The Layers are also interchangeable, meaning you can also 

swap out any layer, with any other type of layer.  

 

 

 

 

 

 

 

You can drag-and-drop a new 

image right on top of an existing 

layer, getting a blue line all the 

way around the layer, and the 

image in that layer will be 

replaced by the image you just 

dropped in its place. 

 

 

 

 

 

 

If you see a single blue line, you 

will be adding a new layer. 

 

 



 

You can also swap a layer for a different type of 

layer, turning an image (photograph) into a 

Gradient for instance. Right-click on the layer you 

want to convert then choose Select Source. This 

will open the Browser, giving you access to 

images from your computer as well as Solid 

Colors / Gradients. Choose the new content you 

want to use then click the Ok button and the 

layer will begin using the new content. 

 

 

 

Layers List Tools 
The icons at the top of the Layers list provide ways to add and modify slide content. 

 

The first four icons add new layers to the list. Any new layer added using these icons will be added directly 

above the currently selected layer. The remaining icons will apply effects to selected layers. 

Add:   This is a drop-down menu broken into three sections. The top section includes different 
types of layers that can be added. The second section includes Masking and Adjustment layers 
options and layer duplication. The third section is a list of effects that can be added to the 

selected layer 

Add Photo/Video: The second icon opens the Browser, allowing you to add a photo / video or even 
a Solid Color / Gradient layer. 

Text Layer: This icon adds a Caption Layer. In the window that pops up you will be able to add your 
text, choose a font, apply Bold / Italic effects, view a font browser, and apply macros. 

 

Group Layer: This option puts the selected layers in a Group, which can be expanded / collapsed in 
the Layers list. Grouped layers can also be manipulated as though they were a single layer. 

 

Add Effect: This is one way that you can add Fly Ins, Fly Outs, Behaviors and Filters to layers. 

 

Add Slices: This will apply the Slice Effect to your selected layer. Text Layers already have Word and 
Text Slices, so there is no need to apply a separate Slice Effect to text Layers. 



Add Masking Layer: This icon adds a Masking layer to the selected layers. You will get to choose if 
you want this to be a Solid Color, Gradient, or Image Mask. 

Add Adjustment Layer: This icon adds an Adjustment layer to the selected layers.  You will get to 
choose if you want a Solid Color, Gradient, or Image Adjustment Layer. 

Split color Channels:  This effect will split your selected layer into four color channels: Red, Green, 
Blue, and Alpha. Once the color channels are separate, you can animate them individually.  

Channel Mixer: This effect allows you to shift the individual color channels, red, green, and blue, 
within an image.  

Add Follow Filter: This will add a Follow Filter to your selected layer. Click here to learn more about 
the Follow Filter. 

Delete: The trash icon deletes the selected layer or effect. 

 

Three Lines (Hamburger): This provides a drop-down menu that has many of the same options as a 
right click. 

 

Under the Right Click 
If you right click on a layer, you will get a new fly out menu. The options in that menu depend on the Layer 

Type that is selected. 

All Layer types will have the following options in the right-click menu: 

• Duplicate Layer 

• Add Effect (with flyout sub-menu) 

• Use as Masking Layer 

• Use as Adjustment Layer 

• Rename Layer 

• Copy (with flyout sub-menu) 

• Remove Layer 

• Reset Layer 

Image Layers include: 

• Select Source 

• Open in External Editor 

Solid Color and Gradient Layers include: 

• Edit / Change Source 

Group Layers cannot be used as Masking or Adjustment Layers, so while you may see those options in a 

Group Layer fly out, they will be ghosted. 

 

 



Copy Settings between Layers 
Under the right-click for any layer in the Layer list is an option in the Copy fly-out menu for Copy Settings 

Between Layers. This brings up a new window that allows you to copy one or more settings from a layer in 

one slide, to one or more layers in any other slide. 

 

This window has three columns: 

1. From Layer – This the source layer for the copy action. (Choose only one) 

2. What to Copy – These are the settings that will be copied. (Choose multiple) 

3. To Layer(s) – These are the destination layers for the copy action. (Choose multiple) 

Once all your selections are made, click either the Copy & Close or Copy button at the bottom of the window. 

Clicking the Copy button will copy the selected settings from the source layer to the destination layers, 

leaving the copy window open. After clicking the Copy button all selections will be cleared, making it easier to 

setup a new copy action. Clicking the Copy & Close button performs the same copy action then closes the 

copy window.  

 

 



Content List 
 

The Content tab includes a list of all the images, videos, and captions in the selected slide. The content order 

is not stacked in the same way as the Layers list. If you have a Slide Style applied, the Content list may show 

fewer layers than the Layers list since things like layers added by the Slide Style, Solid Color / Gradient layers, 

and duplicate layers are not included in the Content list. Changes to Content objects can be made from the 

Content Settings tab in the Options Panel. 

 

In the Basic and Light Layouts, the Content list is shown at the top the Options Panel with settings shown 

directly below. (Shown above) 

 

In the Advanced and Compact Layouts, the Content list is on the left, next to the Layers List in the Navigation 

Panel, with the Content Settings tab shown in the Options Panel on the right. 



There are several icons available at the top of the 

Content List, as detailed below. 

1. Add Photo – This icon opens the Browser window, 

from which photo / video files can be added to the 

slide. If a Solid / Gradient is added it will appear in the 

Layers list but not the Content list. 

2. Add Caption – This icon adds a new caption layer. 

3. Folder – This icon opens the Browser window so you 

can change the source file for the selected content. 

4. Trash Can – This icon deletes the selected content. 

5. Folder with Plus – This icon eliminates duplicate 

content by combining entries that use the same 

source file. 

6. Folder with Trash Can – This icon eliminates content that is not used in the slide, which can happen after 

applying a Slide Style. 

7. Up / Down Arrows – These icons change the Content order, which changes the Layers where the Content is 

included in the slide. 

 

 

Content Settings 
The Content Settings tab provides basic adjustments that you can apply to a Layer. Since the Content List 

only shows a single image, even if it has duplicates in the Layers Tab, you may see tabs for each instance 

allowing you to give each duplicate its own crop settings.  

Crop 
The image preview in this tab doubles as a Crop tool. Click and drag the yellow knobs at the edge of the crop 

region to change the size of the crop area. Click and drag anywhere else in the preview to change the position 

of the crop area within the image. Use the mouse wheel while hovering over the preview to change the size 

of the crop region while maintaining its shape. 

 

Changing the size / position of the Crop region, while keeping the same shape, will not change the size / 

position of the associated Layers in the slide. However, changing the shape of the Crop region can change the 

shape of those Layers. 



 

Uncropped 

 

Cropped 

(same shape with different size / position) 

 



 

Cropped 

(different shape) 

 

Below the image preview area is an Aspect Ratio combo box that includes several cop presets, along with a 

Reset button to the right. 

 

If your image exists in Layers with different Shapes / Scaling, you will see a tab for each variation just above 

the Crop preview area. These tabs only apply to the Crop setting.  



          

This allows you to position your crop separately for each duplicate. 

 

 

Directly beneath the Aspect Ratio combo box are the 

Filename label, Select Source icon, Information icon, and 

Description text box options. 

Below the Description text box are the Image Adjustment 

options. Keep in mind that changes made here are applied to 

each instance of the image in the slide. 

 

Clicking the Auto Correct button at the bottom will change 

Image Adjustment options to correct basic image flaws.  

 

 

 



 

Colorize Settings are collapsible. If you do not see them, click the arrow next to Colorize. Checking this box 

will turn your image to Black and White by default. Select the Mid Color box and choose a new color to give 

your image an overall color change. You can also colorize the highlights / lowlights using the High Color / Low 

Color options. The Strength and Mid-Point of your color choice are also adjustable. 

 

 

Directly beneath the Colorize options are Rotation and Flip options. 

 

 

Caption Layers 
When a caption Layer is selected in the Content 

List you will see Bold / Italic, Font, Caption Size, 

and Color / Texture options along with the edit 

text box. 

 

 

 

 



Video Layers 
When a video layer is selected in the Content List you will see Duration, Trim, Speed, Loop, and Hold options.  

 

Adjustments and Animations Tabs 

Static versus Animated Attributes 
The Adjustments and Animations tabs look similar and perform similar functions, so it important to 

understand how they are different. 

                 

            Adjustments Tab                    Animations Tab 

Options in the Adjustments Tab, such as Position / Zoom / Rotation, are applied to the layer but NOT 

animated over time. Changing the Zoom option from 100 to 50 in the Adjustments Tab, for instance, will 

change the size of the image (or layer) for the entire layer duration. Changing the Zoom option from 100 to 

50 in the Animations Tab will change the size of the image (or layer) at ONLY the selected keyframe. Given 



that the Zoom option is at a different value at other keyframes, this will result in the image (or layer) 

changing size over time. You can learn more about Keyframes in the Animations Tab chapter. 

Some settings can be seen in both the Adjustments and Animations tabs (ex. Position, Zoom, Rotation, etc.). 

These options are connected. When an option has been modified in the Animations tab that option is now 

‘animated’ and thus can no longer be changed from the Adjustments tab. The two are mutually exclusive. The 

animation for each option can be removed from the Adjustments tab using the trash can icon located next to 

the option label. 

 

The Adjustments Tab 

The basic function of the Adjustments tab is to change any of the listed attributes for the selected layer. This 

is where you will find the most common layer options like Position, Zoom, Rotation, Outline, and Drop 

Shadow along with other less common options like Skew and Chroma Key. 

. 

 

The selected layer combo box is at the top of this tab, 

providing another way to select layers, in addition to the 

Layers list and the Preview area.  

The options listed below have either have a value that 

can be changed using number boxes and slider bars (ex. 

Position, Zoom) or an on / off checkbox (ex. Outline, 

Drop Shadow). Options with checkboxes reveal 

additional settings when enabled. 

 

 

The drop-down menu on the right will show slices if you 

have the Slide Effect applied. You will see No Slices 

when a layer does not have the Slice Effect applied to it. 

Individual slices can have adjustments and animations 

applied to them. Learn more about Slices here. 

 

 



Adjusting the Values 
There are several ways to adjust the value of options with slider bars. 

 

Click the ‘handle’ in the middle of the slider bar and drag it left / right, good for quick adjustments. 

 

Click the Minus / Plus buttons on either end of the slider bar, good for small incremental adjustments. 

 

Click between the ‘handle’ and the Minus / Plus buttons, good for large incremental adjustments. 

 

Click in the associated number box to type in an exact value. 



 

If you are changing an attribute that is also in the Animations Toolbar (such as Position), you can click and 

drag your image inside the preview area and your attribute will change with better precision. 

Position 
The layer Position numbers refer to the placement of the layer center point. A value of 0 for both the 

Horizontal and Vertical Positions will put the center of the layer at the center of the slideshow frame. A value 

of 50 (or -50) will place the center of the layer at the edge of the screen. 

 

As shown above, negative Vertical Position numbers move a layer up in the slideshow frame while positive 

numbers move the layer down in the frame. Horizontal numbers are negative to the left of center and 

positive to the right of center. 

If you are clicking-and-dragging in the preview area to change the layer position, hold the SHIFT key to 

constrain the movement in either a horizontal or vertical direction. This will constrain the Position change 

horizontally or vertically, depending on which direction the layer is dragged. 



Zoom 
Zoom (or ‘scale’) is the only attribute that can be changed inside the Preview area that does not have its own 

icon in the Layer Adjustments Toolbar. Use the mouse wheel to change the layer Zoom value. 

 

Lock Aspect Ratio determines whether the Vertical and Horizontal Zoom values will remain locked, meaning 

they will have the same value (shown above). 

 

With this option unchecked, you will be able to change the Horizontal and Vertical Zoom values 

independently (shown above), which will inherently stretch / compress the image in the layer. 

 



Rotation 
The slider bar for Rotation goes from -360 to 360, but you can enter lower / higher numbers (-7200 to 7200) 

in the number box. This has no effect in the Adjustments tab, since the Rotation there is static, but it can be 

necessary when setting up an animation where you want more than two full layer rotations.  

 

 

Rotation Center 
The Rotation Center is represented by a crosshair icon. If you do not see this icon, make sure the Center Point 

is active in the top tool bar. If you are having trouble seeing it with your keyframe icons visible, you can turn 

off the keyframe icons to see the Rotation Center icon easier.  

 



 

The Rotation Center position does not affect layer position. Instead, it sets the position around which the 

layer rotates / tilts. If you wanted an image to rotate at its lower left corner, for example, you would need to 

enter -50 for the Rotation Center X (Horizontal) and 50 for the Rotation Center Y (Vertical) value boxes. The 

layer would then rotate around its bottom-left corner. 

Rotation Center coordinates are like layer Position coordinates, except the Rotation Center coordinates are 

mapped to the layer area instead of the slideshow frame area. The top of the layer is -50 while the bottom is 

50 and the left side of the layer is -50 while the right side is 50. This remains true even for layers of different 

aspect ratios / orientations. 

 

This option also affects Tilt. If you wanted a layer to tilt on its left edge, like a page turning in a book, the 

Rotation Center X needs to be -50, while the Rotation Center Y should be zero (but can be any value).  

Tilt 
This setting is separated into Horizontal and Vertical Tilt, much like Position / Zoom. It uses the Rotation 

Center option as a reference point for both axes.  

There are special settings for Tilt that are only necessary for imported ProShow slideshows / effects. The 

Disable Perspective Correction, Horizontal Pan, and Vertical Pan options are used to ensure the integrity of 

Tilt effects from imported ProShow slideshows and Slide Styles, where the Tilt option behaved differently. 



Skew and Flip 
Skew will slant layers horizontally / vertically. This option has handles that can be enabled / disabled in the 

Layer Adjustments Toolbar. 

Flip reverses a layer, horizontally or vertically, which is necessary to create mirror effects. Note that this 

option is available in the Adjustments tab but not in the Animations tab. 

Color Adjustments 
This section of the Adjustments / Animations tabs is a bit of a ‘catch all’, including options from Brightness to 

Opacity and Blur. Some of the most used adjustments are included under this heading. 

Brightness affects the tonal values and image highlights. Moving the slider to right increases tonal values and 

expands image highlights while moving it to the left decreases values and expands shadows.  

 

             Brightness at -50         Original Image            Brightness at +50 

Contrast changes expand or shrink the overall range of tonal values in an image. 

 

             Contrast at -50         Original Image            Contrast at +50 

Gamma adjusts mid tones more heavily and leaves low and high tones unaffected. In most situation, gamma 

will give better results when adjusting images that are too dark or bright. 

 

             Gamma at -50         Original Image            Gamma at +50 

White Point increases / decreases the white (or light) values in an image. 

Black Point increases / decreases the black (or dark) values in an image. 

 



Hue refers to the colors in an image. Moving the Hue slider will shift all the 

colors in an image counterclockwise around the ‘hue circle’. 
 

 

 

    

The image on the right has the Hue value set at 35 (less than halfway around the color wheel). This has 

shifted the red in the tomatoes to blue and the green in the pepper to red. The white of the Garlic remains 

unaffected. 

Saturation is the intensity of the hues / colors in an image. Bringing the Saturation all the way up makes all 

the hues / colors in an image much more intense. Bringing the Saturation all the way down results in a black 

and white image. 

 

             Saturation at -80         Original Image            Saturation at +80 

 

Opacity represents the transparency of a layer. Reducing the Opacity increases transparency. 

   

                  Opacity at +100                       Opacity at +70 

 

 



Blur reduced image clarity, which can be helpful in certain effects. 

           

                  Blur at 0                          Blur at +40 

 

Sharpen effectively intensifies the contrasting lines in an image, creating a ‘sharper’ look. 

       

Colorize 
This is an option that needs to be enabled to adjust its settings. 

 



You can colorize the Dark, Mid, and Light colors of an image separately. Use the Mid Color to change the 

overall color of an image. The default here is grey, which will turn your image black and white.  

 

Click the color swatch next to each Color option to change it to a different color. 

 

Once you have a color selected, you can then adjust its Strength (how much of the original colors will come 

through) and its Mid-Point (which colors are Low, Mid, and High Ranges) 

Compositing 
This setting determines how a layer is composed on 

top of another layer. Depending on the two images 

that you want to composite together, you may not 

see a difference between compositing modes. In our 

examples we have used a solid orange layer above an 

image of a red ornament to show how each 

compositing mode might affect your images. 

 

Default and Normal 

The Default and Normal settings work together when an extra effect is applied to a layer, but there will be no 

difference between the two when a layer has no effect applied. 



         

If a Layer has a Multiply compositing mode set (above left), then the Slice Effect is added, each individual slice 

can then be set to either Default (also above left) which will continue to use the Multiply Compositing mode 

on that slice, or Normal which will revert the chosen compositing mode for just that slice (above right). 

 

Lighten (Maximum) 

Lighten takes the color information in each channel and selects the base or blend 

color—whichever is lighter—as the result color. Pixels darker than the blend color 

are replaced, and pixels lighter than the blend color do not change. 

In our example, all the red in the ornament, which is darker than the orange layer, 

is being replaced by the orange layer, whereas the lighter areas, the swirls in the 

ornament are not being changed. 

 

 

Darken (Minimum) 

Darken takes the color information in each channel and selects the base or blend 

color—whichever is darker—as the result color. Pixels lighter than the blend color 

are replaced, and pixels darker than the blend color do not change. In our 

example, all the red in the ornament, which is darker than the orange layer, is 

unchanged, whereas the lighter areas, the swirls in the ornament are changed to 

our orange color. 

 

Multiply 

Multiply takes the color information in each channel and multiplies the base color 

by the blend color. The result color is always a darker color. Multiplying any color 

with black produces black. Multiplying any color with white leaves the color 

unchanged. The effect is similar to drawing on the image with multiple marking 

pens. 

 

 

 



Screen 

Screen is, essentially, the opposite of Multiply. It takes the color information and 

multiplies the inverse of the blend and base colors. The result color is always a 

lighter color. Screening with black leaves the color unchanged. Screening with 

white produces white. The effect is similar to projecting multiple photographic 

slides on top of each other. 

 

 

 

Linear Dodge (Add) 

Linear Dodge brightens the base color to reflect the blend color by increasing the 

brightness. Blending with black produces no change. 

 

 

 

 

 

Subtract 

Subtract removes the blend color from the base color. 

 

 

 

 

 

Difference 

Difference subtracts either the blend color from the base color or the base color 

from the blend color, depending on which has the greater brightness value. 

Blending with white inverts the base color values; blending with black produces 

no change. 

 

 

 

Overlay Luminance 

Overlay Luminance creates a result color with the hue and saturation of the base 

color and the luminance of the blend color.  

 



 

 

Overlay Per Channel 

Overlay Per Channel multiplies or screens the colors, depending on the base 

color. Patterns or colors overlay the existing pixels while preserving the highlights 

and shadows of the base color. The base color is not replaced but mixed with the 

blend color to reflect the lightness or darkness of the original color. 

 

 

 

Soft Light 

Soft Light darkens or lightens the colors, depending on the blend color. The effect 

is like shining a diffused spotlight on the image. If the blend color (light source) is 

lighter than 50% gray, the image is lightened as if it were dodged. If the blend 

color is darker than 50% gray, the image is darkened as if it were burned in. 

Painting with pure black or white produces a distinctly darker or lighter area but 

does not result in pure black or white. 

 

 

Color Dodge 

Color Dodge looks at the color information in each channel and brightens the 

base color to reflect the blend color by decreasing contrast between the two. 

Blending with black produces no change. 

 

 

 

 

Divide  

Divide looks at the color information in each channel and divides the blend color 

from the base color. 

 

 

 

 

 



Color Burn 

Color Burn looks at the color information in each channel and darkens the base 

color to reflect the blend color by increasing the contrast between the two. 

Blending with white produces no change. 

 

 

 

Linear Burn 

Linear Burn looks at the color information in each channel and darkens the base 

color to reflect the blend color by decreasing the brightness. Blending with white 

produces no change. 

 

 

 

 

Extract Color Channel  

This setting will bring forward one of a set of color channels or other attributes, such as an alpha channel, 

shadows, mid-tones, and highlights. 

             

                  Extract Green                               Extract Alpha 

            (Similar to a Transparency Inverted Mask) 

Multiply 

This will multiply a color of your choosing over your image. The result is like Colorize 

             

                  Original Image                      Multiplied with a light blue 



Outline  
 

This setting adds a color or 

textured outline to the outer 

edge of a layer, or to the edges 

of a caption. 

Outlines cannot be applied to 

Group Layers, but they can be 

applied to layers inside the 

Group. 

 

The default settings for Outline will create a 

solid white line around a layer with rounded 

corners. Each of these settings can be 

changed. 

 

 

 

In this example, we changed the 

outline color to green, the size to 

20, the opacity to 50 and 

unchecked Rounded Corners.  

The opacity setting is what gives 

the outline the double color 

look. The outline is centered at 

the edge of your layer, so when 

the opacity is brought down the 

inside of the outline reveals the 

image, and the outside reveals the layer beneath 

(in our example, our image is above a solid white 

layer). 

 

 

 

 



 

 

 

You can also use a Gradient or 

Texture as the outline around a 

layer. Clicking on the black box that 

says “None,” or the folder icon 

next to it, will bring up the 

Browser. You can then choose to 

add a Gradient layer, as we did in 

this example. 

 

 

 

 

You can also add a texture, which 

is simply an image file. 

When using a Gradient or image as 

an Outline texture, the Mapping 

Mode drop down determines of 

that Gradient / image fills the 

screen, fills the layer, or stretches 

to fit the layer / screen. 

 

 

If you would like to remove the Gradient / image 

and go back to a solid color, click the reset icon on 

the right. 

 

Outlines on Caption Layers work the exact same way 

as image layers, but the outline will be around each 

individual letter, instead of the outer boundary box. 



Shadow  
Shadows can be applied to any image or caption layer but cannot be applied to Groups. You can apply 

shadows to layers inside of Groups. 

S hadows, in real life, are the result of an object blocking a light source. The position of the light source 

determines the direction and strength of the shadow. In Photopia there is no light source, but if you can 

imagine one, using and animating 

shadows becomes easier. 

The default shadow settings imply 

there is a light source above and to 

the left of the layer, creating a 

shadow that appears down and to 

the right. The X Offset adjusts the 

horizontal position of the shadow 

while the Y Offset adjusts its vertical 

position. 

 

 

 

 

 

Using a negative number for the X 

Offset results in a shadow that appears 

on the left side of the layer, giving the 

illusion that the light source is above 

and to the right. 

 

 

 

 

 



The e Blur and Opacity settings give 

the illusion that an image is farther 

away from the object that the shadow 

is being cast on. In this example, we 

increased both the X and Y Offset 

values, giving the shadow distance, 

but we also made the shadow more 

transparent and more blurred to give 

the illusion of distance. The closer a 

shadow is to the object it is cast on, 

the sharper and darker it should be. 

The farther away, the blurrier and 

lighter it should be. 

 

 

 

 

 

Shadows can also be used as a highlight 

/ glow effect by modifying their Color 

attribute. 

In this example, we used a 0 value for 

both the X and Y Offsets and increased 

the Blur and Opacity values.  When 

using a white color instead of black 

with these settings, it gives the image a 

glow. 

 

 

 

 

 

 

 



Vignette   

Vignettes create a distinctive border around your layer. They can only be applied to image layers (Photos, 

Videos, Solids, and Gradients). They cannot be applied to Groups or Caption Layers. 

 

Enabling the Vignette feature creates a faded ellipse border around the layer. You can create several distinct 

types of Vignettes by clicking on Edit and going into the Vignette Settings window. 

Shape 
The Shape dropdown menu gives you a choice of an Ellipse or Rounded Rectangle. 

        

Type 
There are three Type choices; Transparent (this gives your image the faded edge look), Solid Color, and 

Gradient. While both the Solid Color and Gradient give an image a border, Gradient gives more depth. 

 

 

 



 

 

Choosing a solid color without the Solid 

Borders option checked will result in a gradual 

fade, from the outside in, around the edge of 

the layer. 

 

 

 

 

 

 

Choosing a Gradient can give the border 

some depth. In this example, the Solid 

Borders option is enabled so you can see the 

fade of the gradient from dark blue to light 

blue. 

 

 

 

 

 

 

 

 

 

Choosing a Metallic Gradient gives the 

border a 3D effect. 

 

 

 

 

 

 



 

Vignette Size 
Use the Size option to set how much of the effect you want to see applied to the layer. 

 

In this example, the 

Transparent Vignette size 

is set to only 5, resulting in 

a very small, feathered 

edge. 

 

The corner size is also set 

to 65, just to see the 

effect easier. 

 

 

 

 

 

 

 

In this example, the Transparent 

Vignette size is set to 65, 

resulting in a much larger 

feathered edge. 

 

The corner size is still set at 65, 

but with a much larger Vignette 

size, the corners are less 

defined. 

 

 

 

 

 

 

 



 

Corner Size 
Corner Size determines the curve between adjacent edges, resulting in a rectangle at its lowest setting and an 

oval at its highest setting. 

 

The above image shows a Corner Size of 15. 

 

The above image shows a Corner Size of 65. 

 

 



Border Size 
Border Size behaves like Crop.  It determines where the outer edge of the vignette is applied. 

 

 

Solid Borders 
Solid Borders does not work with a Transparent vignette. When using a Solid Color / Gradient vignette the 

effect fades out as it moves towards the center of the layer (left image). Enabling the Solid Borders option 

changes the effect to be more like an outline with a width based on the vignette Size option (right image, 

Solid Borders is checked, with Size set to 30) 

 

      

 

 



Fill Corners 
Fill Corners cannot be used with a Transparent vignette. Checking this option gives the vignette sharp corners 

instead of rounded corners at the outer edge. 

 

Presets 
The left side of the Vignette Settings window includes many predesigned vignettes. You can select one of 

these options by clicking on it then either use it as-is or make further modifications from the normal Vignette 

Settings options. 

 

You can also add your own custom vignettes to this list. After creating a vignette, click the Add button 

beneath the list of presets to and your current vignette settings to the bottom of the list as a new entry. 

 



Chroma Key 

The Chroma Key option allows you to select a color from your image to become transparent. It cannot be 

used with Groups or Caption Layers. 

Click the Edit button next to the Chroma Key option 

to bring up the Chroma Key Settings window. The first 

step is to choose which color you would like to ‘key 

out’. Click the black color swatch next to the Key 

Color label to bring up the color picker. 

 

 

 

 

 

 

The best way to ensure that you are matching the 

color from your image exactly is to use the 

eyedropper tool. Select the eyedropper in the upper 

left corner of the color picker, then click on your 

image to choose the color to be keyed out. 

 

 

 

Next, use the sliders at the bottom to adjust the key 

threshold, or amount. Start with the Hue Threshold, 

then adjust the Light and Dark thresholds until your 

color is keyed out appropriately. 

 

 



 

With the chosen color keyed out, you should now see through the areas of the image that contain that color. 

Crop 

There are two places for you to crop an image and each has slightly different settings. Using the Crop window 

from the Content Tab will crop all instances of an image in the slide. Using the Crop settings in the 

Adjustments Tab will crop only the selected layer, even if there are multiple instances of it in the Layers list. 

There are also a few extra settings in this window. 

 

Clicking on edit next to Crop will open the Crop Settings window 

with the image from that layer loaded. The image will have an 

overlay that includes yellow nodes on the corners / sides that can 

be clicked and dragged to change the crop area, along with guides 

dividing the crop area 

into thirds. 

Beneath the image is a 

dropdown menu of 

preset aspect ratios 

(shown right). 

 

 

 

 

 

 

 



The crop area can be zoomed in / out using the mouse wheel and 

the position can be changed by clicking / dragging anywhere in 

the crop preview area (shown left). 

The crop area can effectively be rotated using either the Rotation 

slider or by typing a number into the Rotation number box. This 

will rotate the image within the crop window, rather than the 

crop area (shown below). 

 

 

 

 

 

 

 

 

 

 

 

 

The numbers at the bottom define the crop 

area relative to the image. The left edge is 0 

while the right edge is 100.  The top edge is 0 

and the bottom edge is 100. 

 

Changing the Top number from 0 to 50 

brings the top edge of the crop down to half 

the height of the image.  Changing the Right 

number to 50 brings the right edge of the 

crop to half the width (shown left).  The 

result is a crop that is perfectly in the lower 

left quarter of the image. 

 

 

 



Animations Tab 
The attributes in the Animations tab generally work the same way they do in the Adjustments tab, but here 

they are associated with Keyframes to create animation over time. 

Understanding Keyframes 
Keyframes are what makes animation / motion happen.  

Video files use the term “frame rate”, where 30fps, for example, means “30 frames per second”. A frame is a 

single image. In a 30fps video there are 30 images, or frames, shown every second. When an image is on the 

left side of the screen on the first frame, then on the right side of the screen on the 30th frame, there will be 

28 still frames at different positions between the 1st and 30th frames, but the start and ending positions are its 

key frames. 

There are three keyframe timelines in the Advanced User Interface; one at the top of the Animations tab, one 

at the bottom of the Preview window (when in the Animations tab only), and one as an alternate to the Slide 

List at the bottom. The first two are identical, but the Keyframes tab is slightly different. Learn more about 

the Keyframes Tab here. 

The Keyframe Timeline 

 

Time Ruler 
The time ruler shows the entire time your slide is visible. This includes both the Transition In and Transition 

Out times. Transitions overlap two slides, which means transitions will be shown in two slide time rulers. A 

transition is shown as the Transition Out for one slide and the Transition In for the next slide. 

The keyframe timeline above shows a 12 second slide. It has a 3 second Transition In, 6 second Slide 

Segment, and 3 second Transition Out. 

You may also see green or blue numbers in the keyframe timeline. Blue numbers are used for the selected 

keyframe. Green numbers indicate the current preview position, as seen when playing / scrubbing a slide. 

 

Keyframe Markers 
Above the Time Ruler in the Keyframe Timeline there will be at least two Keyframe Markers (or Keyframes); a 

starting keyframe with the number 1 and ending keyframe with the number 2. New keyframes can be added 

by double-left clicking in the Keyframe Timeline just above the Time Ruler, or by right clicking in that area and 

choosing Add Keyframe. Each option in the Animations tab can be set at each keyframe to create animation 

for that option. If the Zoom option is set to 80 at the first keyframe and 100 at the last keyframe, for instance, 

the layer will grow from 80 to 100 percent Zoom over the course of the slide. 



First and Last Keyframe Effects (Fly in and Fly out) 
The first and last keyframes are the only keyframes where Fly In and Fly Out effects can be set. These are like 

slide transitions but are applied to individual layers, rather than a whole slide. An icon representing the Fly In 

effect is shown under the first keyframe while the Fly Out effect is shown under the last keyframe. There is 

also an interactive length indicator for each effect. Click and drag the line at the end of the effect to make it 

longer / shorter. Click the effect icon to change the effect from the Keyframe Timeline. 

 

In the example above there is an effect length indicator on the Crossfade effect at the last keyframe but no 

length indicator for the Cut effect at the first keyframe since the Cut effect has no duration. Use the Cut 

effect when you want to remove a Fly In / Fly Out effect. 

Under the Right Click 
There are two Right Click Menus for the Keyframe Timeline; one If you right click on a keyframe and another 

if you right click an empty space above the Time Ruler. 

Right-Click on Keyframe: 

• Add Keyframe – Add a single keyframe halfway between the clicked keyframe and the next keyframe. 

• Set Time for Keyframe – Set a specific time for the current keyframe.  

• Add or Remove Time – This will add or remove a specific amount of time after the clicked keyframe, leaving 

all keyframes before it unaffected. If the selected keyframe is in the slide time, the slide time will change. If 

the selected keyframe is in the Transition In / Out time, that Transition time will change. 

• Cut – Copy the clicked keyframe to the clipboard then remove the clicked keyframe. 

• Copy – Copy the clicked keyframe to the clipboard (without removing the clicked keyframe). 

• Paste – Replace the settings of the clicked keyframe with those of the keyframe in the clipboard. 

• Delete – Remove the clicked keyframe. 

• Copy to Next Keyframe – Copy the settings of the clicked keyframe to the next keyframe. 

• Copy to Previous Keyframe – Copy the settings of the clicked keyframe to the previous keyframe. 

• Reset Keyframe – Reset all options on the clicked keyframe to their default values. 

• Delete All Keyframes – Reset the first / last keyframes to their default values and remove other keyframes. 

• Time Format 

o Minutes and Seconds – Show times in minutes and seconds. 

o Seconds – Show times in seconds only. 

o Show Keyframes as Slide Time – Show times relative to the start / end of the slide. 

o Show Keyframes as Show Time – Show times relative to the start / end of the slideshow. 

Right-Click in Empty Space: 

• Add Keyframe – Add a single keyframe at the clicked position. 

• Add Multiple Keyframes – Add multiple keyframes between the currently selected keyframe and the next 

keyframe. A pop-up window appears to specify the number of keyframes to be added. 

• Paste Keyframe – Paste the keyframe from the clipboard at the clicked position. 

• Delete All Keyframes - Reset the first / last keyframes to their default values and remove other keyframes. 



• Reset All Keyframes – Reset all options in all keyframes to their default values, effectively removing all 

animation from the layer without removing the number / positions of the current keyframes. 

• Time Format 

o Minutes and Seconds – Show times in minutes and seconds. 

o Seconds – Show times in seconds only. 

o Show Keyframes as Slide Time – Show times relative to the start / end of the slide. 

o Show Keyframes as Show Time – Show times relative to the start / end of the slideshow. 

Creating Animation 

Basic Animation 
The most basic animations use only two keyframes but can incorporate more than one attribute. You can 

Zoom an image forward and rotate it, for example, using only two keyframes. 

 

1. Click on the layer you want to animate, from the Layers list, to select it. 

2. Click on the Animations tab. 

3. Click on the first Keyframe. 

4. Hover over the Preview area then use the mouse wheel to change the layer Zoom value. 

 



 

5. Click and drag one of the Rotation handles from the corners of the layer in the Preview area to rotate the 

layer. Note that you must have the Rotate Tool enabled in the toolbar below the Preview area. 

 

6. Click on the second Keyframe. 

7. Hover over the Preview area then use the mouse wheel to change the layer Zoom value. 

8. Click and drag one of the Rotation handles to rotate the layer in the opposite direction than you did in step 5. 

If you cannot see the corners of the layer, use the Zoom Slider at the top of the Preview area to reveal more 

of the canvas. 



When you play this slide back, you may find that the Zoom / Rotation is faster / slower than you want. This 

can be adjusted in one of two ways: 

• Change the Slide time. 

o The speed of any animation is directly affected by the duration of the layer, which is initially determined 

by and tied to the Slide time. A longer layer duration will slow the animation down because the same 

animation will happen over a longer amount of time. A shorter layer duration will make the animation 

faster for the same reason. 

• Change the Zoom / Rotation values. 

o Changing the values of the animated layer options while keeping the same slide / keyframe times will 

inherently change the speed of the animation. If the Zoom option goes from 50 at the first keyframe to 

100 at the second keyframe, for instance, then reducing the Zoom value at the second keyframe to 75 

will reduce the speed of that Zoom animation by half. 

Intermediate Animation 
Once you start adding more layers and use more than two Keyframes on a layer you’re moving into more 

complex animations. The time between Keyframes inherently changes when slide / transition times change, 

so it is best to get those times as close to final as possible before diving into a multi-keyframe animation. 

In this example, we are going to Zoom an image back then have it sit still while a Caption layer appears next 

to it. We will then add a background image that will only be seen on this slide. We will use a 6 second slide 

time with 2 second transitions, in and out. 

 

1. Start by selecting your 1st Keyframe and Zoom your image forward. Adjust the Position and Rotation, if 

desired, as well. 



 

2. Select the 2nd keyframe then Zoom it back and move your image over to the right side of the slide frame.  If 

you want to ensure that your image is centered vertically, click the reset icon next to the Vertical Position, or 

enter 0 into that number box. 

 

3. Move the 2nd Keyframe in to around half of your slide time 

4. Double click the timeline after this second keyframe, creating a new 3rd (and now last) keyframe, then drag it 

to the end of the timeline. 

a. This new keyframe will automatically have the exact same attributes as the 2nd keyframe.  When 2 

adjacent keyframes have all identical attributes, no change will occur between them.  This is how you can 

make a layer “sit still” after it has been animated. 



5. If you play this back, you may notice that your image “slams” into place. You can make this motion softer by 

changing the Motion Easing for the option that changed (ex. Zoom / Position).  

 

 

Click on the triangle next to each attribute on the first 

Keyframe that was changed and choose Smooth. 

Learn more about Motion Easing here. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. Create a new Caption Layer, using whatever text and Font size you want.  

 

 



 

7. Use the timeline marker above the slides so the Preview shows your image on the right side of the screen. 

Click the Adjustments tab and place your Caption layer on the left side of the image. 

 

You DO NOT want to make this change from the Animations tab as it will animate the Caption layer. 

 

8. Go back to the Animations tab and move the 1st Keyframe of this Caption Layer to approximately the same 

time the Zoom motion stopped on the image layer.  This does not have to be exact. 



 

9. Click the “Cut” icon below the 1st keyframe of the Caption layer and choose “Elastic Left”, then click Apply. 

 

10. Adjust the timing of the Elastic Left effect by clicking and dragging the end of the effect line. This can be done 

in either timeline.  You can change when the Caption layer appears by moving its first Keyframe left / right in 

the Keyframe Timeline. 



 

11. If you would like to add a colorful background to just this slide and not the whole show, simply add a new 

layer above the Background layer. You can do this by dragging and dropping the Layer from the Browser 

(make sure you see that solid blue line directly above the Background Layer when dropping it into the Layers 

list) OR by selecting the Background layer and choosing Add > Photo or Video (or Gradient, or Solid Layer) 

from the top of the Layers list. 

 

12. Once your background is added, you may want to add a (drop) Shadow to your image and caption layers, to 

make them stand out more on the background. This can be done easily in the Adjustments tab. Once the 

Shadow is applied, you can adjust the settings to your liking. 

 



Advanced Animation 
 

 

In this animation we are going to create an image with a reflection using a gradient layer as a mask. We will 

move and tilt the image, along with its reflection, using Groups and Keyframes then add a Caption Layer that 

comes out from behind the image. 

 

• First, add an image to a slide. It can be any orientation, but make sure that the scaling in the Layer tab is set 

to Fit to Frame.  



 

• Make your slide time 6 seconds with 1 second Blend transitions in and out.  If this is your first slide, you will 

not have a transition in. You will need to add a blank slide before this slide to create a transition in. Right click 

on the slide with your image and choose Insert > Blank Slide, then click and drag that new blank slide so that 

it comes before the slide with your image in it. 

 

 

• Right click on your image in the Layers List and choose Duplicate Layer. 



 

• Right click on the top image layer and choose Rename Layer.  Name this Layer something like Main 

Image.  Right click on the bottom image layer, choose Rename Layer, and name this layer Reflection. 

         

 

• Select the duplicated layer in the Layers list (Layer 2, 

Refection), then go into the Adjustments tab and 

Flip this image Vertically. You will not see this 

change initially because the Main Image layer is on 

top, hiding the Reflection layer. 

•  

 

 

 

 

 

 

 

 



 

• Stay in the Adjustments tab and change the Vertical Position to 100 (this will drop your image all the way 

to the bottom of the screen. You can Zoom the Preview canvas out to see things better. 

 

• In the Color Adjustments dropdown, change Opacity to 70 and Blur to 20 

 

• Add an outline to both image layers. Keep the color white, make the size 6, and uncheck rounded corners. 



 

• Change vertical position to 101 because adding the Outline increased the perimeter of our images. 

 

• Select the Reflection layer, click the Mask icon, and choose Gradient. The default is a black and white linear 

gradient, which is what we want. Change the Angle to 90 then click the reverse button because we want 

white on the top. Learn more about Masking Layers here. 

 

• Move one of the white keyframes in so you are creating a line in the lower third of the gradient. Use 70 for 

the Position, although this doesn’t have to be exact. Move the black keyframe in a little, so the grey faded 

area is minimized, around 90 for the Position.  Click the Ok button. 



 

• Move this masking layer down so that the top of the white line is at the bottom edge of the Main Image 

layer. This should be around 27-28 for the vertical position of the Masking Layer. 

 

• Select the top image layer and the Mask Layer (holding down your Ctrl key), then hit the Group icon (shown 

above left). All your layers, including the image inside the Masking layer will automatically be added to the 

group (shown above right).  



 

• With the Group selected in the Layers list, make sure the Adjustments tab is selected and use your mouse 

wheel in the Preview window to reduce the size of the Group layer to around 60. Click and drag the Group 

up, just a little (you can hold down the SHIFT key to constrain the movement to Vertical only). 

 

• You can keep the background black or add a color gradient. Use a Linear gradient with any colors you choose 

but be sure to move the keyframes so the line between the colors also aligns with the bottom of your image. 

This creates a better “floor” illusion. 



 

• This new Gradient layer can either be below the word background in the Layers list or above it, but it must be 

below the Group for it to be behind the Group. 

 

• In the Animations tab, select the 1st Keyframe of the Group layer, move the Group to the left (holding down 

the SHIFT key so you do not accidentally move it up or down).  



 

• Make sure your Tilt tool is enabled in the Layer Adjustments Toolbar, then tilt the Group so that it is facing 

the right side of the screen. Something between -20 and -30 for the Horizontal Tilt should work.  

 

• Select the 2nd Keyframe, move the Group to the other side of the screen (holding the SHIFT key) and Tilt it in 

the opposite direction. Play your slide back to see what you have done so far! 



 

• Move the second keyframe in a bit, around the 6 second mark, then double click after it to add a 3rd 

keyframe and drag it to the end.  This can be done on either of the Keyframe Timelines. The intention here is 

to keep the image still at the end of the slide. 

   

• If you find your motion to be a bit harsh, click on the triangles for the 1st and 2nd keyframes for the both the 

Position and Horizontal Tilt settings and change their Motion Easing to Smooth. 

 

 

 

 

 

 

 

 

 

 

 



 
 

• Finally, we will add a Caption Layer that comes out from behind our image. Create a new Caption Layer, add 

anything you would like.  If this Caption Layer is at the top of your Layer List, click and drag it down so that it 

is beneath the Image Group. (Caption above the Group is shown above, Caption below the Group is shown 

below). 

 



 

• With your Caption Layer selected in the Layers List, click on the Effects Icon (it looks like a Magic Wand). Find 

Fade Fold in the Fly-in Tab then click the Select button. 

 

• In the Effects Tab, on the right side of the screen, change the Duration to around 3 seconds (this can be 

adjusted later), the Overlap to 20, and the Order dropdown menu to Left-Top to Right Bottom Horizontal. 



 

• Select the Caption Layer in the Layers List (the main Caption Layer, not the Fade Fold Effect) then click the 

Animations tab. We are going to work through the Keyframes from the end to the beginning, because our 

Caption Layer is hidden at the beginning. Select the 2nd keyframe and move the Caption Layer to the left side 

of the screen.  You should see the Position checkboxes become checked and gray. 

 

• Move this 2nd keyframe back on the timeline, then double click after it to create a new 3rd keyframe and 

move it to the very end. 



 

• Move the 1st Keyframe in on the timeline, to the 2 second mark so that the Fly-in Effect doesn’t start until 

you can just see the caption start to “peek” out from behind the image.  Now, move your Caption Layer over 

to the left, so that it is just behind the left edge of your photo. This will cause your caption layer to both move 

to the left and have a Fly In at the same time. 

• Play your slide back and then adjust the position of the keyframes and the timing of the Fly In until your 

animation looks just right. 

Motion Easing 
 

Motion Easing controls the rate at which layers move 

between keyframes (any two keyframes). The default 

value for Motion Easing is Linear, which tells the layer to 

move at the same rate between those two keyframes. 

Other options, like Accelerate and Decelerate, tell the 

layer to start / stop at a different speed. This can result in 

significantly different motion over time, leading to 

different visual effects. 

 

You can access the Motion Easing choices by clicking on 

the triangles that are next to all the attributes in the 

Animations Tab. Position is the only attribute you can 

assign both Horizontal and Vertical Motion Easing 

together, using the Select button. All others are assigned 

individually. 

 

 

 



 

 

The Easing window gives you more than 40 choices, but the first four will be your “go to” Easing settings for 

most of your animations. As you look at the graphs for each of the Easing choices, imagine that the beginning 

of the line on the left side is the Keyframe going into the motion and the end of the line on the right side is 

the end of the motion. 

Linear – This is constant motion, neither speeding up or slowing down. 

Accelerate – The animation will start of slow then increase speed until the next keyframe is reached. 

Decelerate – The animation will start off quickly then decrease speed until the next keyframe is reached. 

Smooth – The animation will start slow, increase speed to the midpoint, then decrease speed until the next 

keyframe is reached. 

Easing applies to a particular option at a particular keyframe and controls the rate of change for that 

animated option until the next keyframe, at which point the Easing for the next keyframe takes over. While 

the Easing option can be set on the last Keyframe of a layer, it has no effect since there is no animation 

coming out of that Keyframe. 

 

 

 



Layer Effects 
 

Predesigned effects can be applied to individual layers. 

These effects include animations for how a layer is first 

displayed on screen (Fly In), how it ends (Fly Out), how 

it behaves in between (Behavior), general modifications 

(Filter), and how it behaves relative to changes in other 

layers (Follow Filter). 

These effects can be accessed by selecting a layer in the 

Layers List then clicking on the wand icon OR the Effects 

tab in the Options Panel. Fly In and Fly Out effects can 

also be accessed by clicking on the corresponding effect 

icon under the first / last keyframe in the Keyframe 

Timeline. 

 

 

 

 

 

 

Fly-In and Fly-Out Effects 

Fly-In and Fly-Out effects provide the same basic set of animation choices. Fly-In effects are applied to the 

first keyframe of a layer and Fly-Out effects are applied to the last keyframe of a layer. Once applied, you can 

adjust the speed of the Fly-In / Fly-Out using either the slider bar in the Effects tab OR by clicking and 

dragging the bar at the interior edge of the effect icon in the Keyframe Timeline. 

. 

 

 

 

 

 

 

 



Behavior Effect 

This type of effect adds an animation to a layer independent of any keyframes. You can choose start and end 

times for a behavior in the Effects tab. 

 

An example of a Behavior Effect is the Full Pan Up effect, applied to a Caption Layer (shown above), which 

creates a ‘scrolling credits’ effect (Caption Layers have a separate set of Effects, but are applied the same 

way). If you did not want the credits to start right away, you could change the Start Time. 

 

Filter Effects 

These are image filters, like what you might find in Photoshop or Instagram.  You can adjust the strength of 

the filter in either the Filter Effects window OR after from the Effects tab. 

 



Follow Filter 

 This effect lets you assign a layer to follow one or more attributes of another layer. 

 

 

To assign a Follow Filter you must 

first set a Target Layer. This is the 

layer that your layer will be 

following.  

Next, select one or more attributes 

for your layer to follow. If you want 

two layers to move in unison, for 

example, select the Follow Position 

attribute.  

Once you have chosen an attribute, 

you may want to change the Offset, 

or the difference, between the two 

layers. If you are following position, 

for example, and you do not set a 

Position Offset, your layers will be in 

the exact same position, and one of 

them will be covering the other.  

Once you set a position offset, your 

layers will be separate on screen, but 

they will move in unison. 

After setting your Follow Filter, you 

will only need to animate your 

Target Layer for the attribute chosen. You will still be able to animate other attributes that are not using the 

Follow Filter separately. 



 

Timeline View 
The Timeline View gives you a more visual representation of your slides, transitions, soundtrack, and slide 

sounds. More importantly, the Timeline view shows you how they all work together. 

 

The basic components of a slideshow are displayed in separate horizontal sections within the Timeline 

view. 

• Slides and Transitions 

• Slide Sounds 

• Video (only shown when at least one video layer exists in the slideshow) 

• Soundtrack 

Working in Timeline View 
 

The most important advantage of the Timeline view is being able to see how the Soundtrack audio relates to 

the slides / transitions. It can also be easier to adjust slide / transition times to align with audio changes. 

 

Use the mouse wheel to zoom in / out when working in the Timeline view to see things better. Scale is very 

important in this view. 



 

The height of the Timeline view can be adjusted by grabbing the top edge of that panel and dragging it up / 

down. Hover the mouse over the divide between the Browser/Preview panel and the Timeline panel until you 

see a double-sided arrow. Click and drag that line up / down to increase / decrease the panel size. Select the 

View > Reset Window Layout option to reset all the panels. 

 

 

 

 

 

 

Timecode – At the top of the Timeline view is a timecode for your show. You will see two different time 

stamps floating above the timecode, one blue and one green. The Green time stamp shows the time code for 

what is being shown in the Preview area. You will see this time stamp when playing the slideshow. The Blue 

time stamp shows where the mouse is hovering. 

Adjusting Slide and Transition Times 
Slides and Transitions have the same thumbnail in the Slides view as they do in the Timeline view. You will 

only see the Slide Number in the Slides view while the Timeline view is necessary to see slides / transitions 

based on their relative durations. 

You can hover over a slide or transition to see its exact time. You can change a transition here the same way 

you can in the Slides view; click on the transition icon to open the Transitions window. 

 



 

Hover the mouse over the right side of a slide / transition until you see a double arrow. Click and drag that 

line to change the duration of that slide / transition. (before edit shown above, after edit shown below) 

 

All the slides / transitions that come after the adjusted slide / transition will be shifted forward / backward in 

time, depending on how the adjusted slide / transition duration was modified. Earlier slides / transitions will 

retain the same relative position in the show. This is important when considering how a slide / transition 

duration change will affect slide / soundtrack alignment. 

 

 

You can also perform a rolling edit, where the slide / transition times are adjusted relative ONLY to each 

other, leaving other areas of the show unchanged. Hold the CTRL (or CMD) key as you click and drag on the 

line between the slide and transition you want to edit. Notice in the above images that the start of the slide 

and the end of the transition did not change. This can be helpful when you only want a shorter transition. 

(before edit shown above, after edit shown below) 

 

 



 

 

When performing a sliding edit, the two slides or two transitions on either side of your mouse will adjust, but 

the slide or transition in the middle will not. Hold down the SHIFT key then click and drag for a sliding edit. 

The slide or transition that will not change its time will always be directly to the left of where you click the 

mouse. (before edit shown above, after edit shown below) 

 

Moving the timeline 
If you are zoomed into your timeline, you may need to move the entire timeline to see more slides.  

 

You can do this either by clicking the mouse on the Timeline and dragging to the left / right OR by using the 

scrollbar at the bottom. 

 

 

 

 

 

 

 

 



Audio Tools 
The bottom three tracks are all for audio files (you will only see a video track if you have a video file 

in your timeline). You will be able to edit your sound files using the Audio Tools on the right side of 

the Timeline view. Each tool can be enabled (blue) or disabled (grey) to avoid using a tool 

accidentally. 

 

Volume 
Adjust the volume 

of any audio track 

by clicking the green line 

and dragging it up / down. 

 

 

Fade 
 Adjust the fade in 

/ out by clicking 

the vertical green line and 

dragging it left / right. 

 

 

 

Move 
Adjust the track 

position by 

holding CTRL (or CMD) while 

you click and drag the track 

left / right. 

 

 

Trim 
Trimming here 

works like it does in the 

Audio Trim Window.  Since 

the Trim feature works in 

the same manner as the 

Fade Tool, it is 

recommended that one is 

disabled while the other is 

enabled. 



 

Volume Control Points 
Volume Control Points are a tool that allows you to create individual volume reference points for an 

audio track. This can be useful if you want to create a fade in the middle of your sound file, which 

cannot be done with the normal Fade In / Out tools. You may notice that some Volume Control Points 

already exist if you have a Slide Sound or Video layer with sound and the Soundtrack During Other Sounds 

option is set to a lower volume (under 100%). Volume Control Points can be added by double-left clicking on 

the audio waveform in the Timeline and removed by right-clicking on an existing Volume Control Point.  

 

There are black Volume Control Points, created from the Soundtrack During Other Sounds feature, that 

cannot be moved in the Timeline. There are also blue Volume Control Points, created from the Custom 

Soundtrack During This Sound / Video, options for slide sounds / video layers. These blue nodes, which 

always exist as a pair, can be moved, and always move as a pair. 

The main Volume Control Points are yellow. These are the control points that can be added / removed from 

the Timeline. Click and drag these yellow control points up / down or left / right to change the Soundtrack 

volume at that point. Note that at least four of these control points are needed to fade the Soundtrack down 

then back up to normal volume. It’s also helpful to think of these Volume Control Points as being applied to 

the Soundtrack, as they are not tied to specific audio tracks in the Soundtrack. 

 

 

 

 

 

 

 

 



Keyframes View 
The Keyframes view is a combination of the Layers List and the Animations Tab. This allows you to see 

multiple layers and their keyframes all at the same time.  

 

If you have more than 4 or 5 layers (including those inside other layers, such as Groups or Masks), you will 

want to extend this panel. Hover the mouse at the top of the Keyframes panel until you see a double arrow, 

then click and drag up. 

Keyframes View Layout 
 

The Layers list on the left side works in the same 

way as the Layers list in the Navigation Panel. 

Some of your layers may initially be hidden if 

they are inside a Group or under a Mask. Click 

the arrow on the left side of those layers to 

reveal the layers within, or any effects that are 

applied. 

 

 

 

 

 



Adjusting Keyframes on Multiple Layers 

 

In this example we have three images that all have a Push Right Fly-In applied to them. We want to stagger 

them on screen so the far-right image appears first, then the center image, then the left image.  This is done 

easily in the Keyframes View as we can see the first keyframe for all three layers at the same time. Keyframes 

and Fly-In / Fly-Out effects can be moved / adjusted in this Keyframe Timeline just like in any other Keyframe 

Timeline.  

Selecting Multiple Keyframes 

 

Click in an empty space within the Keyframe Timeline area then drag the selection box around the keyframes 

you want to select. If there is a keyframe that you would like to include that is not adjacent, hold the CTL key 

as you click on that additional keyframe. Once the selection is complete, click on any of the selected 

keyframes then drag the selected set of keyframes left / right. They will move as a single unit. 



Aligning Multiple Keyframes to a Specific Time 

 

Multiple keyframes can also be aligned to a single position. Select the keyframes you want to align, one 

keyframe per layer, then right-click at the point where you want those keyframes aligned and choose the 

Align Here option (results shown below). 

 

Shapes 
The Shape feature allows you to cut layers 

into a variety of shapes, like a stencil / 

mask. 

Applying a Shape 
The settings for applying a Shape to a layer 

are in the Layers tab. The Default option is 

the original shape of the layer. 

There are two ways that you can select a 

shape. Clicking on Select next to the Shape 

option displays a fly out menu with 

descriptions of shapes from which you can 

choose. 



If you prefer to see a visual example 

of the shapes, click on Select, then 

Browse.  

The Shapes window will default to 

showing all shapes, but there is a 

Category drop down menu for you to 

view only the shapes in a chosen 

category. 

 

 

 

 

 

 

Once you have selected a shape, you will see that information in two places. The layer information in both 

the Layers list and the Layer drop down menu will display the name of the shape that has been applied and 

the shape icon in the Layer tab will now display the applied shape. 

 

   

Unlike a masking layer, you cannot animate a layer independently from the shape. For example, you cannot 

zoom an image behind the shape of a heart and have the heart stay still while the image zooms inside it. You 

can create that effect by applying the heart shape to a solid layer then use the solid layer as a mask over your 

image. Learn more about Masking Layers here. 

 

 

 

 

 



Adjusting Shape Position 
You may want to adjust where your image is within the applied Shape. This is done with the Crop Tool in the 

contents tab, not the Edit button next to the Shape selection. 

    

Select your Layer, then go into the Content tab. You will see the applied shape over the image. Use the 

mouse wheel to resize the shape then click and drag to position it on the image. You can always click the 

Reset Crop button to have the shape fill the image. 

 

Editing the Shape 
 

The Edit button next to the Shape Selection is to edit the 

shape itself, it does not determine where the shape is 

positioned on your image. 

 

 

 

In this example, we 

have applied an oval 

shape to this image of 

a skyline. The oval 

shape is vertical, but 

we want it to be 

horizontal.  



 

If you use the rotate setting in the Adjustments tab, your entire image will rotate, not the shape itself. This 

is not the result we want. 

 

Use the Edit button for the Shape option to rotate the shape. If it does not fill your image, increase the zoom 

settings here. This is not used for placement on your image, just for editing the shape. 



 

Once you have edited the shape, you can adjust the scale and position of it on top of your image in the 

Content tab. 

Shapes can be used for more than just images, as you will see below. 

 

In this example we have added a solid white layer, applied a Speech Bubble Shape, flipped it horizontally, 

added a black Outline and a Shadow. You can add a text layer above this and even put both the text layer and 

speech bubble layer into a group to animate together. 

 

In this example we have used three duplicates of a blue radial gradient then applied a snowflake shape to all 

three. You can then animate each snowflake to fall from the top to the bottom at different speeds and 

rotations to give a stylized ‘falling snowflake’ effect. 



Groups 
Groups allow you to put multiple layers together (in a container) which can then be animated as a single unit. 

Creating a Group 
You can add Layers to a Group in a couple of ways.  

First, select one or more layers in the Layers list (hold down 

the CTRL or Alt key to select more than one layer), then 

click the Group Icon (shown left). 

 

 

The new Group information will include how 

many layers, or sub items, are inside (shown 

right). 

With the Group closed, the layer numbers 

will skip over the layers within the Group. 

You will not see these layers in your Layers 

list until you open the Group by clicking on 

the arrow to the left of the Group.  

 You can add Layers to a Group by dragging them into the Group (shown left), or by clicking the arrow at the 

bottom of the expanded Group indicator and dragging it down to incorporate lower layers in the Layers list 

(shown right). 



           

You can remove Layers from a Group using the same methods. Dragging the double arrow up will remove the 

bottom-most layer(s) from the Group. If you drag a layer down to remove it from the Group, pay close 

attention to the blue line; if it does not go all the way to the left past the Group Container Line, you are 

simply moving that Layer to the bottom of the Group (left image above). If it goes all the way to the left edge, 

you will be removing it from the Group (right Image above) 

 You can rename a Group the same way you would rename a layer; right click and choose Rename Layer. 

Animating a Group 
You can animate a Group in almost every way that an ungrouped layer can be animated. The layers within 

the group will be animated as a single unit.  

 

For example, this Group is animated to move and tilt from the left side of the screen to the right side. All 

layers inside move together. 

 



 

You can also animate individual Layers inside a Group and animate the Group itself. Using the previous 

example of our Group moving from the left to the right, you can also make each individual layer do 

something else, such as move up / down or rotate, all while the Group is moving from left to right.  

There are a couple of things that you cannot do with Groups. You cannot add Shadows or Outlines to a 

Group and you cannot use a Group as a Mask or an Adjustment Layer.  You can, however, do all those things 

to the Layers inside a Group. 

You can remove a Group using the Trash Can icon at the top of the Layers list OR by right clicking on the 

Group layer and selecting Remove Layer.   

A window will pop up giving you two Delete 

options. Delete All will delete the Group AND 

all the layers within. Delete This Layer Only 

will remove the Group from the Layers list 

but leave all the layers within. 

 

Masking Layers 

What is a Masking Layer? 
 

Before you can use a Mask, you should understand what they are and how they are used.  Masks are like 

using a Stencil. Stencils can be any shape or size, and so can a mask. The goal of a Mask is to allow parts of an 

image to be visible, while simultaneously hiding other parts.  

 

 



 

In a Stencil, visible areas are defined by the open areas. If you 

paint over a stencil, you will see what was left behind through 

the holes but any area that was blocked by the solid parts will 

remain blank or empty.  

Masks work in a similar manner but have the added ability of 

allowing you to choose a range of how much is seen though the 

mask…as if giving you the choice to use a lot of paint or just a 

little bit.  Those choices are made using the Channel dropdown 

menu, which includes Grayscale / Transparency options and 

their Inverted equivalents. 

 

 

 

 

Adding a Masking Layer 
You can add a Masking Layer by 

selecting the image layer you 

want to mask from the Layers list 

then clicking the Mask icon.  

The Browser window will open so you can 

choose the Masking Layer source. Masks can 

be anything; other images, images with 

transparencies (such as PNGs), Gradient 

Layers, or Solid Layers. The type of source you 

choose for the Mask will determine whether 

you want the Mask to be Grayscale, 

Transparency, or an Inverted variant. 

 

Grayscale Masks 
Grayscale Masks reveal and block parts of 

your image based on the amount of white 

and black in the mask. White reveals, black 

conceals, and tones of gray result in different 

levels of your image being revealed. 

If we choose a Linear Gradient that goes from 

solid white to solid black as our masking layer 

(shown left) the result may not be what you 

expect.  



With only two color keyframes, the gradient 

layer is only fully showing the image for just a 

small area all the way to the left, and only 

completely hiding it for a small area all the 

way to the right. Everything in between is 

just shades of gray. 

 

 

 

 

You would need to have more solid white 

and more solid black in the gradient layer to 

get more of the image seen and more of the 

image blocked. (shown left) 

 

The result (shown below) is that you can see 

more of the image on the left and less of it 

on the right, with a blend in the middle 

where all the gray tones are. 

 

 

 

 

 

 

 

The default for Masking layers is Grayscale. 

You can change the type of mask, or channel, 

by selecting the masking effect in the Layers 

list (not the Masking Image layer, but the 

Masking Effect Layer), then use the drop-down 

menu in the Options Panel to change the 

channel. If you choose Grayscale Inverted, it 

simply changes the visible sections to black and 

the hidden sections to white. 

 



You can use full color images as masking layers using the Greyscale Channel, as well. This method will result 

in more of a texture overlay, than fully masking off parts of your image. It is best to find images that have 

extreme contrast and keep in mind that any color will be discarded for shades of gray. If you would like to use 

an image that is already in your Layers list as a Masking Layer, right click on that Layer and choose Use as 

Masking Layer.  

Below are three examples of using sharp contrast images as Grayscale Masks:

 



Transparency Masks 
Transparency Masks use the levels of Opacity in a Masking Layer, instead of levels of gray. Using a Solid Layer 

with a Shape added to it as a Transparency Mask (shown below) shows the parts that are opaque (the Oval 

Shape in this example) and block the parts that are transparent (everything outside of the oval shape).  

 

You can achieve the same effect using images that have Alpha Channels (or transparency) in them, such as 

the heart PNG image used below. 

 

Using that same Heart PNG as a Grayscale Mask gives you a more textured look. 

 



Using Adjustments with Masks 
Masking Layers have the same Adjustment and Animation options as an image layer. Keep in mind that you 

will be applying the Adjustment to the Masking Layer, not the image layer underneath. 

 

One adjustment of note is Shadows. Applying a shadow to the image underneath a mask will only work if 

your image is smaller than the mask itself. If you are using a Mask as a stencil (shown above), the shadow on 

the image layer will extend beyond the image and will be hidden by the mask. If you apply a shadow to the 

Masking Layer itself, however, you will see a shadow in the shape of the mask. 

 

Masks vs Shapes 

 

You may notice that using a mask that has a shape applied to it gives you the same result as applying that 

same shape directly to the image. Which method you choose will depend on what you plan to do with your 

image.  



 

If you want to animate the image including the shape that it is in, it is best to apply the shape directly to the 

image (above right). If you plan to animate your image but not the shape, such as zooming your image while 

the shape remains the same, you will want to use the masking method (above left). 

Masks also allow you to have multiple images under a single mask. This allows you to animate multiple 

images, or dissolve from one image to another, all while under the same Masking Layer. 

 

Video Files as Masks 
Video files can also be used as masking layers, but they must have been designed for that purpose. 

 

 If you have a video file and a separate Alpha video file that came with it, use the Alpha video file as a mask 

over the color video file. 



 

You can also use black and white video files as masking layers over solid or gradient layers. In this example, a 

video file of animated text is used as a masking layer over a green Solid Color layer. 

Adjustment Layers 

What is an Adjustment Layer? 
Adjustment layers are like Masking layers, but instead hiding or revealing parts of your layers, Adjustment 

Layers add Image Adjustments to all layers that are inside of it in the Layers list.  They work the same way as 

masks, applying the adjustments depending on the channel chosen (grayscale or transparency).  

Applying Adjustment Layers 
Adjustment Layers are applied the 

same way as masks. Select a layer 

in the Layers list then click on the 

Adjustment icon. The Browser will open for 

you to choose any type of Adjustment Layer. 

In our example, we are going to create a Radial 

Gradient with black on the inside and white on 

the outside. Knowing that ‘white reveals and 

black conceals’, this means that any 

adjustments we change will only be applied to 

the outer circle of our images. 

. 

 



Using Adjustment Layers 
At first, after your Adjustment Layer is added, you will see no difference.  

 

This is because none of the Adjustments for the Adjustment Layer have been changed. Select the Adjustment 

Layer Effect (shown above in the Layers List), and you will see two tabs appear in the Options Panel; Effect 

and Animations (shown below). 

 

In the Effect Tab, the first option is the Channel. Since we created a black and white gradient as our 

Adjustment Layer, we are going to choose Grayscale. 



 

If you open the Adjustments menu, you will see image adjustments that you can change. If we bring the 

Saturation down and the Blur up, you can see that the outer edge of our image has been changed to reflect 

those effects, but the inside has not. That is because we used a black and white Radial Gradient as a 

Grayscale Adjustment Layer. 

 

Animating Layers under the Adjustment Layer 
You can have as many layers under an Adjustment 

Layer as you would like and animate them in / out of 

the Adjustment Layer.  

If you want to have multiple images pan across your 

screen, turning from black and white to color, you will 

create a linear gradient Adjustment Layer (shown 

right), with solid black on one side, solid white on the 

other, and shades of gray in the middle. 

In the Effects tab for the Adjustment Layer, bring the 

Saturation all the way to zero, then pan your images 

from the dark side of your Adjustment Layer (no 

effect) to the light side of your Adjustment Layer 

(Saturation effect applied). 

 



Animating the Effects of Adjustment Layers 
You can animate the Effects of Adjustment Layer over time, as well. 

Next to the Effect Tab, you will see an Animations Tab. This is not for motion, but to animate the effects of 

your Adjustment Layer. 

 

If we create a solid white adjustment layer, crop the layer into a square, then add a large ellipse vignette, we 

will get a very fuzzy circular Adjustment Layer (shown above). If we place this over one of the flowers in this 

image, then use the Animations tab for the Adjustment effects to go from 0 Hue on the first keyframe to 100 

Hue on the second keyframe, our single sunflower will change colors throughout the slide time. 

 

 

 

 



Animating the Adjustment Layer Itself 
You can also animate the Adjustment Layer itself, not just the effects that it creates. In this example, we will 

use an animated adjustment layer over a Caption. 

 

We have a solid white line for our adjustment layer that is over a 

Caption Layer that has a black color (shown left).  

 

In the Effects tab for the 

Adjustment Effect Layer, 

we make the Black Point 

100 (turning black into 

white).  

 

Using the Animations tab for the Solid Color layer of the 

Adjustments Layer to pan from left to right over our Caption, you 

will see each letter shift from Black to White as the line moves 

across the Caption Layer. 

 

 

 

 

 

 

 

 

 

 

     



Slices 

Adding the Slice Effect 
 

To add slices to a layer, select the layer in the Layers 

List, then click on the Add Slices Icon. 

 

 

 

 

 

With the Slice effect applied, the Image and 

the Slicing Effect will have different layers in 

the Layers list. To view the Slicing Effect 

options, you must have the Slicing Effect Layer 

selected in the Layers Tab, not the image layer. 

 

 

 

 

 

Slices Options 
With the Slicing Effect layer 

selected in the Layers list, 

you will see a Slices tab in 

the Options Panel. The first 

option you can customize is 

the number of Horizontal 

and Vertical Blocks, as well 

as the Shape of the Slices, 

including Rectangles, 

Triangles, Hexagons, and 

Puzzle Pieces.  

 

 

 

 



 

 

The number of blocks, both horizontally and vertically, can be set as low as 1, which will give you bars when a 

Rectangle shape is selected.   

 

For the other shapes, it’s best to choose a Horizontal and Vertical ratio that keep the shapes intact. 

 

Slice Animation and Timing 
The settings found under the Animation Timing are directly related to keyframes applied to all slices as a 

single unit in the Animations Tab. (These settings don’t apply to animating individual slices). 

• Order – Determines the order in which the slices will perform the animation. 

• Overlap – Determines when each slice will begin its individual animation. 

• Start Offset – Determines when, in the total Slide time the animation will start. 

• End Offset - Determines when, in the total Slide time the animation will end. 



Example 1 – Animate puzzle pieces coming together 

1. Add an image to a slide, set the scaling to Fill Frame, then apply the Slicing Effect  

2. Select the Slicing Effect Layer in the Layers list 

3. In the Slices tab in the Options panel, choose Puzzle Pieces for the Shape. 

4. Set the Horizontal blocks value to 5 and the Vertical blocks value to 3 

5. In the Animations tab (still on the Slicing Effect layer), move the layer off screen to the right on the first 

Keyframe (Horizontal Position value should be around 100); leave the 2nd Keyframes position centered. 

6. Go back to the Slices tab and open the Animation Timing options. Under the Order drop-down options 

choose Left-Top to Right Bottom Horizontal. 

7. Set the Overlap to 20 

8. Change the End Offset to reflect 1 second less than your Slide time plus the Transition in time. For example, 

in a Slide that has a Slide time of 8 seconds, with a 2 second Transition in, that would be a total of 10 seconds, 

so the End Offset should be set at 9 seconds. This will allow your image to be seen in full for 1 second before 

the slide transitions out. 

 

Play your slide back and you should see individual puzzle pieces coming on screen from the right, from the 

top left of the image down to the bottom right of the image, coming together and remaining on screen for 

the last second of the slide time. 

Example 2 – Randomly fading blocks 

1. Add an image to a slide, set the scaling to Fill Frame, then apply the Slicing Effect 

2. Select the Slicing Effect in the Layers List 

3. In the Slices tab in the Options panel, choose Rectangles for the Shape. 

4. Set the Horizontal blocks value to 5 and the Vertical blocks value to 4. 

5. In the Animations tab (still on the Slicing Effect layer), select the 1st Keyframe and open the Color 

Adjustments options  

6. Set the Opacity to 0 on this 1st Keyframe, keeping the Opacity at 100 for the 2nd Keyframe. 

7. Go back to the Slices tab and open the Animation Timing options. Set the Overlap to 20 

8. Change the End Offset to reflect 1 second less than your Slide time plus the Transition in time. 



 

The result will be block slices of your image randomly fading on screen, then holding for the last second 

before it transitions into the next slide. 

Animating Individual Slices 
 

Individual slices can also be animated. To 

select a slice, click on the Open Slices icon to 

the right of the Slice Effect, then select your 

slice from the list. You can also select an 

individual slice by using the drop-down menu 

at the top of either the Adjustments or 

Animations tabs. 

The default slice names are Shape (Column Number, 

Row Number). Rectangle (3,1) would be the 

rectangle slice in the 3rd Column, top row. 

You can rename the slices by right clicking on a slice 

layer and choose Rename. 

Once you have selected a slice, you can make 

Adjustments and create Animations in the same way 

that you would an image layer. 

 

 

 



Slices in the Keyframe Timeline 
 

The Keyframe Timeline can be an important tool 

when animating individual slices.  This view 

allows you to see all keyframes for all slices at 

one time. You can Rename slice layers here and 

change their layer order. 

 

 

 

 

 

Clicking and dragging up or down on a 

slice will change its layer order. This 

can be useful if you plan to have 

individual layers animate on top of 

other slices, but in a different order 

than the default. In the image to the 

left, the “Last Puzzle Piece” slice is 

underneath other slices as it flies in, so 

it isn’t visible. After rearranging the 

slices so that the “Last Puzzle Piece” is 

the top layer, it becomes visible (shown 

below) 

 

 

 

 

 

 

 

 

 

 

 

 



Caption Slices 
 

Caption Slices work in a similar way to image 

slices.  Instead of shape choices, you have the 

option to slice Words in your text layer or 

individual Characters. 

You do not need to apply Slices to your Caption 

Layer, this is done automatically each time you 

add a Caption. Click the arrow on the left side of 

your Caption Layer to see the Words and 

Characters slice options.  The same Open Slices 

icon is shown on the right, allowing you to 

select individual slices to adjust or animate 

(shown below). 

 

 

 

 

When viewing the Words and 

Character Slices in the Keyframes 

View, notice that there is a “slice” 

added for the space in our Character 

Slices. 

 

 

 

 



Creating Your Own Effects 

Slide Styles 
Photopia Director provides the ability to create your own Slide Styles.  Slide Styles that you create will have 

their own project files.  

You can create a Slide Style from a blank 

project, or from an existing slide inside a 

Show. 

To start with a blank Project, choose New 

Project from the Home Page, then select 

the Effect option and Slide Style from the 

list below. 

This window also gives you options to add 

Tags and Keywords to your Slide Styles. 

 

 

 

 

 

 

 

To create a Slide Style from an existing slide in a 

Show, right click on the Slide, then choose Create 

Style. This will create a new Slide Style Project to 

build your Style in. 

 

Both methods for starting a Slide Style Project will 

launch the New Slide Style Window. This is where 

you can Name your Style, give it a Description 

(optional), and if desired the Author, Website, and 

Copyright information. 

 



The Style Project Window 

 

The Slide Style Project window looks like the UI layout when building a show.  The first noticeable difference 

is that there is only one slide an no transitions. If you came into this window from an existing slide in a show, 

all your layers, keyframes, animations and any other adjustments you made transferred with it. The final 

steps in creating your Style are to ensure that the Replaceable Layers are selected correctly, and Variant and 

Style Settings are correct. (Continue reading to learn about Place markers and Variants) 

 

If you came into this window from a New Project, you’ll use this window in the same way you would a regular 

slide to create your Slide Animation.  You can add layers, adjust them, animate them, put them into Groups, 

use Masks and Adjustment Layers. Every tool that you can use in a Slide, you have here in the Slide Style 

Project window. 

 

 

 

 

 

 

 

 

 

 



Place markers and Style Content 
To understand the two main components of a Slide Style, look at an existing Style applied to a blank slide: 

 

When viewing this Style in the Layers list, you can see two place markers (empty layers) and one Style 

Content image (the balloons). 

 

Viewing this same Style from the Content tab, we only see one place marker and no Style Content. The 

Content tab will not show Layers included in the Style (Style Content) and if the same file is used more than 

once in a Slide Style, the Content Tab will only show one placemark for all instances of the file. This makes 

using the Content Tab easier when applying Slide Styles as it only shows content that the user will be 

replacing. 



 

If you add an image to the place marker in the Content Tab… 

 

It will automatically fill all place markers that use that file in the Layers tab. 

 

When creating a Slide Style, the Layers will either become Style Content (the image will remain with the 

Style, like the balloons) or become a place marker (turn into a blank layer that images can be added to).  This 

is determined by enabling the content as Replaceable or not. 

 

 



Replaceable Layers 
 

The Replaceable Layer checkbox is in the Layer 

tab for each individual layer. 

If this is checked, your layer will be replaceable, 

and become a place marker. If this is unchecked, 

your layer will remain as Style Content, and stay 

with the Slide Style. 

Some layer types will always be Style Content and 

will not have this option, such as Caption Layers 

and Groups. 

 

Naming Layers and Content 
Naming Layers becomes an important task when creating a Slide Style. Particularly if you are creating a Style 

that uses more than one image. There are two places to name each layer: the Content Description in the 

Content tab, and the Layer Name in the Layers tab. 

 

Naming layers in the Content Tab can help the end user determine the differences between place markers.  

If, for example, you create a Style that uses two images, one on the left and one on the right, when the Style 

is applied to a blank slide, the place markers will only say “Place holder”, unless you label it otherwise. In the 

example shown above, the image on the right shows “Right Image” in the Content List as that is what was 

added to the Content Description text box. This gives the user a guide as to which place marker they may 

want to add their images into. 



 

 

Naming layers in the Layers List can be helpful if there are duplicates of the same layer, which don’t appear in 

the Content tab. One may be a foreground image, one may be a blurred background image or reflection, for 

example. 

Naming layers is an organizational tool as you build your Slide Styles, but it becomes an informational tool as 

you use those Styles. 

Variants 
Variants determine the way a Slide Style will be applied based on the image orientation it is built with. If a 

Style doesn’t need to be changed (or varied) to accommodate different orientations, then the Style will only 

have 1 Variant, that can be used with any image orientation.   

 

If a Style needs to be adjusted to accommodate a different image orientation than it was originally built with, 

you may need to add one or more variants. Variants can only be used when all place markers use the same 

image orientation. 

Creating a Variant 
To create a Variant, select the Add Variant 

button above the slide list.  You can start by 

copying the current Variant or start with an 

empty slide. Once you have your new slide 

variant, make any adjustments needed to 

accommodate the image orientation. 

 

 



Variant Settings 

In the Variant Tab you find a list of 

Supported Show Aspect Ratios and 

Supported Image Orientations. If you are 

creating separate variants for Landscape and 

Portrait Images, you will want to uncheck 

the image orientation that doesn’t apply in 

each variant slide. In the example to the 

right the selected variant slide uses only 

Portrait oriented images, so the only Image 

Orientation that is enabled is Portrait. 

 

 

 

 

 

 

 

Under the Supported Layers heading you will see how many images the Variant supports. This is a very useful 

way to detect if you have all your replaceable Layer settings correct.  

In the example above, a Slide Style is created using only one photo, but the Supported Layers shows 2 user 

photos. That means that one of the other layers is still checked as a replaceable layer that shouldn’t be. 



 

A closer look shows that the paper background layer was still checked as a replaceable layer. When this is 

unchecked, the Supported Layers now shows that it supports 1 user photo. 

Style Settings 
The Style Settings Tab is where you can 

change the Name of your Slide Style, 

Edit the Information, Thumbnail, and 

timing. You can also add your Slide 

Style to Categories here, using either 

existing Categories or by creating new 

ones. 

 

 

 

 

 

Exporting the Slide Style 
If you only plan to use your Slide Style yourself on your current computer, there is no need to export the Slide 

Style. If you plan to share the Style you’ve created or use it on another computer, you can export the Slide 

Style to be imported into another program. 

Transitions 
Photopia Director provides the ability to create your own Transitions. Each Transition you create will have its 

own project file.  

The basic concept of a transition is to have a Source Slide that will turn into a Destination Slide. The Source 

Slide image that you use will be a place marker for the outgoing slide when the transition is applied.  The 



Destination Slide image will be a place marker for the incoming slide.  Each image represents all layers inside 

a slide. Other image content can be included in a transition as well, these will be designated as Style Content. 

 

Transitions can be created from a blank 

project or from an existing slide inside a 

Show. 

To start with a blank Project, choose New 

Project from the Home Page, then select 

the Effect Category, then select 

Transition from the list below. 

This window also gives you options to 

add Tags and Keywords to your Slide 

Styles. 

 

 

 

 

 

 

To create a Transition from an existing slide in a Show, right click 

on the Slide, then choose Create Transition Effect. This will 

create a new Transition Project for you to finish building your 

Transition.  Transition Projects cannot be created from existing 

Transitions. 

 

 

 

Both methods for starting a Transition Project will 

launch the New Transition Effect Window. This is 

where you can Name your Transition, give it a 

description (optional), and if desired the Author, 

Website, and Copyright information. 

 

 

 



Starting from a blank project will automatically begin with Source and Destination Layers (A and B images).  

These will already have a Layer Type assigned in the Options Panel.  Any images that you add to your 

transition will automatically be assigned as Style Content. 

The basic concept of building a transition is that the Source Layer must start filling the screen (100% zoom, 

0/0 for the position). Then, something happens (you create an animation), and the transition ends with 

Destination Layer filling the screen (100% zoom, 0/0 for the position). 

If your Source or Destination layers don’t start or end perfectly filling the screen, the transition will jump 

when applied.  These are not layers; they are representations of slides which must start and end at 100% 

Creating a Basic Transition 
In this section we will guide you, step by step, in creating the most basic transition, where the destination 

slide comes from off screen to replace of the source slide. 

• The Source Layer will start filling the screen (100% zoom, 0/0 for the position). 

• The Destination Layer will slide in from offscreen, covering the Source Layer 

• The Destination Layer will end filling the screen (100% zoom, 0/0 for the position). 

 

 

Starting with a new Transition Effect (from the Home Page) 

you are given both the Source (A) and Destination (B) layers 

and they are set as the correct Layer Type (shown right). All 

you need to do is animate your transition. 

   

 

 

 

 

 

 

 

 

 

The default transition time is 3 seconds; you can make this longer or 

shorter to fit your transition.  For our example, we will leave it at 3 

seconds. 

 

 

 



To have the Destination Layer slide in on top of the Source Layer, we need to reverse the Layer order in the 

Layer List. The Layer List here works the same way that it does in a show.  To reverse the order of Layers, drag 

them into a different position (shown below). 

 

 

With neither layer animated, you 

will simply see the Destination 

Layer fill the screen (shown below). 

The next step is to animate it 

coming on screen. 

 

 

 

 

 

 

The Animations Tab works the same 

way here as it does when you build 

a slide.  Since we want the Destination Slide (B) to end full screen, and it’s already there, we’ll start by 

selecting the 2nd Keyframe, then check both the Horizontal and Vertical Position boxes. 

 



For this layer to start off screen, select the 1st Keyframe and move the Destination layer all the way off 

screen, in any direction you’d like. If you want this motion to ease into position, change the Motion Easing on 

this 1st Keyframe to Smooth. 

 

If you play this back, the end may seem a bit abrupt.  Remember, this is a transition, not a slide.  If your 

second keyframe ends with the Destination layer full screen, you have a good transition. 

 

The last step is to come into the Transition Settings in the 

Navigation Panel.  The Options Panel will show the Effect 

Information.  You can rename the transition here, as well 

as give it more detailed information and a new thumbnail.  

You can also choose which categories you would like this 

transition to be shown in by clicking on the pencil icon, 

then choose an existing category, or add a new category. 

 

 

 

 

 

 

 

When you are finished, hit Save.  If you plan to use this on your current computer only, that’s all you need to 

do. If you would like to transfer it to another computer or share it with others, there is an export option. 

 



After creating a Transition, it is best to test it.  Open a 

show or create a new show for testing purposes that 

you can always go back to.  Add two images to two 

slides and apply your new transition in between (they 

will always be in the Recently Added Category right 

after you create them) and play it back.  If you need to 

make any changes, your Transition Project will be listed 

under the Transition heading on your home page. 

 

 

 

 

Creating a Cover Transition 
A cover transition uses a third layer to fill the screen for at least one frame while you switch your Source to 

your Destination. This third layer will be Slide Content. 

In our example, we’ll use an internal shape as our cover layer. 

 

Start a new transition, so that you have Source (A) and Destination (B) layers to begin with. 

Add a new Gradient Layer, using the Simple preset from the dropdown menu on the left, choose the light to 

dark red preset.  Change the Gradient Type to Radial.  If you’d like, move the dark color keyframe in to 

create a more defined light area, then click and drag that light area to the upper left corner. Select OK. 



 

In the Layer tab for this Gradient Layer, choose a Heart shape from the Wedding Category in the Shape fly 

out menu. 

 

In the Animations Tab for this new Heart Shape Layer, select the 1st Keyframe and change the Zoom to 0. 



 

Select the 2nd Keyframe and change the Zoom to 300, then reposition the heart down so that the preview 

window is fully covered by the top half of the heart. The heart should be much bigger than the window, that 

extra space is used in the next step. 

 

Go into the Effects Tab and choose a Blend Fly Out for the heart layer.  Change the duration of the Fly Out to 

0.5 seconds. 



 

Go back to the Animations Tab and move the 2nd Keyframe of the Heart shape layer back, just a little, to 2.90 

seconds (this doesn’t have to be exact) 

 

Now, to hide the Source Slide (A) at the moment that the heart fills the screen, click and drag the 2nd 

Keyframe of the Source Slide (A) back to where the heart starts to fill the screen (around the 2.45 second 

mark). 

Play your transition back. 

 



Note: the Heart Shape layer is automatically set as a 

Style Content Layer Type.  This means that it will 

remain with the Transition while the other two 

layers will be replaced by the incoming and outgoing 

slides. 

 

 

 

 

 

 

 

 

 

 

 

 

Creating a Complex Transition 
Complex transitions have more layers than just the Source and Destination layers.  They can include masks, 

slices, video layers or anything else that a regular slide can include. 

For our complex transition, we’re going to add a solid white line that will travel from the top of the screen to 

the bottom, then back up again.  During its first pass, the Source Slide (A) will turn to black and white, during 

its second pass the Destination Slide (B) will be revealed. 

 

First add a Solid White Layer and make the 

Vertical Resolution 6 pixels.  If your solid layer is 

set to Fill Frame, you will see an all-white layer 

instead of a thin line.  Be sure the Scaling is set 

to Fit to Frame. 

 

 

 

 

 

 



 

We need two instances of the Source Slide (A), so right click on that layer, and choose Duplicate Layer. Select 

the bottom duplicate (Layer 3) and go into the Adjustments Tab and check Colorize.  This will turn the layer 

black and white.  (You won’t see this result as the layer above it is still in full color). 

 

 

Our white line will have three keyframes over 3 seconds.  Select the white line (Solid Color) layer and go into 

the Animations Tab.  Select the 1st Keyframe and enter -51 into the Vertical Position number box.  This will 

bring the solid white layer to the top of the preview window, just off screen. 



 

Move the 2nd Keyframe into the 1.50 second mark (the halfway point, if you have a 3 second transition) and 

enter +51 into the Vertical Position number box, bringing the white line all the way to the bottom, just off 

screen. 

 

Double click the timeline after the 2nd Keyframe to add a 3rd Keyframe and drag it all the way to the end.  

Enter -51 into the Vertical Position number box. 



 

 

Play this back and you should see your line start at the top, move to the bottom, then go back to the top 

again. To make this motion a little smoother, change the Motion Easing to Smooth for both the 1st and 2nd 

Keyframes (shown above) 

We are now going to add a Masking Layer to the top instance of the Source Slide (A) and animate it to match 

the first two keyframes of the white line.  Select the top instance of your Source Slide (A), click on the Add 

Mask icon at the top, and make it a solid white layer. 

 

In the Animations Tab for this Masking Layer, select the first Keyframe and check the Vertical Position box 

right where it is at 0.   



 

Move the 2nd Keyframe into the 1.50 second mark and change the Vertical Position to +101, bringing it all 

the way to the bottom, just off screen.  If you made your Motion Easing for the white line Smooth, do the 

same for the masking layer on Keyframe 1. 

Note: the reason the white line is off screen at 51 (or -51) and the full white layer is off the screen at 101 (or -

101) is because the numbers correlate with the center of the layer.  The white line only needed to move 51% 

off screen, as it doesn’t exist much beyond its center point.  The full white layer needed to move a full 101% 

off screen as it filled the screen. 

Now, we’ll repeat those steps for the second instance of the Source Slide (A).  Select that layer and click on 

the Add Mask icon at the top and make it a solid white layer. This Masking Layer should be Layer 4. 

 

Select the 1st Keyframe and ensure the Vertical Position box is at 0.   



 

Move the 2nd Keyframe into the 1.5 second mark and make sure that its Vertical Position box is also 

checked at 0. While you have this keyframe selected, change the Motion Eason to Smooth. 

 

Double click after this Keyframe to add a 3rd and drag it to the end.  Change the Vertical Position to -101 

and play your transition back. 



             

If your masking layers don’t move in sync with your white line, double check these two things: 

1. Ensure that the middle keyframes are in the exact same position, right down to the 1/100th of a 

second. You can right click on any keyframe and choose Set Time for Keyframe to get exact 

numbers. 

2. Ensure that the Motion Easing is the same for all keyframes on all layers. 

 

Layer Effects 

Fly In and Fly Outs 
Creating Fly Ins and Fly Outs are very similar to creating a Transition, but there will only be one layer that 

represents your image instead of two layers that represent slides.  For a Fly In, the Layer will be animated 

coming on screen and for a Fly Out the layer will be animated going off screen. 

In our examples, we’re going to use the Hexagon Slices to create both a Fly In and a Fly Out. 

 

All Layer Effect Creation Windows start with a single layer for you to animate (A). This layer is a place marker 

that represents your image. 



 

For our Fly In Effect, we’ll add the Slice Effect to the placeholder layer (A) 

 

With the Slice Effect selected go into the Options Panel, in the Slices Tab, change the Slice Shape to 

Hexagon. The Hexagons may look “squished”. This can be fixed by changing the number of blocks. 

 

By reducing the number of Vertical Blocks to 2, the Hexagon shapes appear more “normal”. 



 

To animate the Hexagons on screen, change the Zoom on the 1st Keyframe in the Animations Tab to 0. 

 

Fly Ins must end with the placeholder layer perfectly filling the screen, so make sure that the Zoom on the 2nd 

keyframe is set to 100. 



 

Back in the Slices tab, change the Animation Timing Order drop down to Random. 

 

Play back your Fly In to make sure it looks the way you want it to. 

 

In the Effect Settings tab, you can change the Name, the 

Thumbnail, Edit its Information, and put it into a Category. 

 

 

 

 



 

Double check your fly in by applying it to a layer in a slide in a show.  You can change the length of the fly in 

and there should be a fly in thumbnail showing your design. 

Fly Outs are created in the exact same way, but in reverse.  They must start with the placeholder layer full 

screen and end with it completely off screen. 

Behaviors 
A behavior effect is applied to a layer for the entire slide time.  In our example, we will have our layer 

increase its blur over time. 

 

This is a simple two keyframed effect.  On the first keyframe, check the Blur setting to keep it at 0. 



 

On the second keyframe, change the blur to 50.  That’s it!  In the Effect Settings tab, you can change the 

Name, the Thumbnail, Edit its Information, and put it into a Category. 

 

 



Filters 
Filters are Image Adjustments that are applied to your layer for the entire slide time.  The Filter effect 

creation window looks like the other Effect Creation windows, but the Animations tab is missing.  Filter 

effects do not change over time but are applied for the entire duration of the slide. Existing Filters include 

turning your layer to Black and White or giving it a color overlay. 

 

Creating Wizard Themes from Styles and Transitons 
Wizard Themes allow you to create slide shows from a pre-selected list of Slide Styles and Transitions in a 

matter of minutes. There are two places you can begin to create your own Wizard Themes in Director: 

You can start a New Project, click on Effect, then click on Wizard Theme. 

 

 

You can also open the 

Manage Effects Window 

to begin creating a new 

Theme. Click the Wizard 

Themes tab then click on 

Create at the bottom of 

the window. 

 

 

 



 

You will then be prompted to name your Wizard 

Theme, give it a Description, and Author 

Information, if desired. All of these can be edited 

later. 

 

 

 

 

 

 

 

There are three panels in the New Wizard Theme window. 

Navigation Panel on the left, where you will select the different steps of the Theme creation process. 

Options Panel on the right, where the options for each section are displayed. 

Section List at the bottom, where you can setup different sections for the resulting Slide Show. 

 

New Wizard Theme – Section List 
The Section List at the bottom of the New Wizard Theme window is broken down into sections rather than 

slides. You start with an Intro slide, then a single Dynamic Section, then an outro slide. You can add more 

Dynamic Sections and more Static Slides (sample below). 



 

Example: Creating a Wedding Theme might call for a Bride Section, a Groom Section, and a Ceremony 

Section. You can rename each section in the Effects & Options > Settings tab. Each of your Sections can have 

its own Slide Styles / Transitions assigned. 

 

You can also add more Static Slides, like the Intro and Outro. These are useful if you want your Theme to 

always start or end with a Title or Credits slide. 

 

Select the section you want to begin assigning effects to then click the Effects & Options tab from the 

Navigation Panel in the upper-left corner of the window. 

 

Effects & Options 
This is where you will choose which effects will be applied for selected section. 

Static (Title) Slides 
You can start the process of adding a Slide 

Style to a Static Slide by selecting the Static 

Slide then clicking the Effects & Options tab. 

There you will see options to rename the 

Slide, choose whether audio will be played 

with this slide, and whether you want this 

section to be optional. Click the Select 

button below the Slide Style thumbnail 

(which is blank by default) to choose a Slide 

Style for that Static Slide. 

 

 

Once you have selected a Slide Style for your Static 

Slide, it’s thumbnail will appear along with more 

options. Photo Content Prompts is where you’ll 

choose to have the program automatically choose 

images that appear before this slide (which will be 

ghosted if there is no Dynamic Section before this), 

use images that appear after this slide, or you can 

request a specific prompt for the user to choose 

photos. 



Caption Content Prompts is how the Theme will prompt the user to enter the text for their captions. You can 

change the text in the Caption Fields or leave them with the default text from the Slide Style. 

 

Dynamic Section Effects 
Styles and Transitions are added using their own tabs in the Effects & Options section for each Dynamic 

Section. Click on Add to see a list of all your installed effects.  

 

Select any Slide Styles / Transitions you want to be available for the selected Dynamic Section. 

 

Once your effects are chosen, they will be listed under the appropriate tab. If you would like to remove an 

effect, select it then click the Remove button. 



The Settings Tab for 

Dynamic Sections allows 

you to change the name of 

that Section, choose if the 

section is optional, and 

recommend a specific 

number of images for the 

section. 

 

 

 

 

Theme Settings 
There are only two options in Theme 

Settings for a Dynamic Section: 

selecting a Show Background and the 

recommended music style. 

 

 

 

 

 

 

 

Theme Information 
In this section you can change the 

name of the Theme (the entire Theme, 

not the Dynamic Section selected), 

enter a description for your new 

Theme, and a Thumbnail. The 

Thumbnail and Description is what you 

will see from the Wizard Window 

when choosing a Theme to create a 

new show with. You can also enter 

Author information here, if desired. 

 

Once you have completed creating your Theme, you can hit Save to keep it in your Wizard Theme choices in 

your current program or hit Export to share your Theme with other computers. 



 

The next time you start a new Slide Show using a Wizard Theme, you will see the Theme you just created in 

the list, in alphabetical order. 

Publishing Your Project 
DVDs used to be the most popular output option for slide shows. Most slide shows are now shared through 

social media, smart devices, and even Blu-ray. There are well over a dozen options for outputting slide shows 

from Photopia and many more resolution / quality variations therein. 

 

When there are multiple 

shows in a project, you will 

be able to choose which 

shows to include in your 

video output.  Use the 

Exclude / Include / Include 

All buttons on the right to 

select the shows you would 

like to publish. 

Multiple shows will be 

rendered, back-to-back, into 

a single video file. 

 

 



Video 
This is by far the most popular output option. Each of the choices listed here results in a single stand-alone 

video file being created for a single slide show. We strongly recommend saving this output to a local 

(internal) hard drive before copying it to any other device (ex. USB flash drive). 

Video File – A list of presets for almost any type of video output. 

Video for the Web – A list of presets designed to create video files optimized for web-based playback. 

Custom Video File – Options to output video files using your own custom parameters, from format to bitrate. 

 

Share Online 
Selecting one of the options under this heading will automatically launch your web browser so you can log 

into the selected Social Media account. There may be extra options to add a Title, Description, or Tags. 

 

Television 
The three disc-based output formats, and USB Flash Drive, are contained in this section. The Blu-ray and DVD 

options are the only ones that support a Menu. You must have the correct disc burner to output directly to a 

Blu-ray / DVD disc, however ISO image file output (which can be burned to a disc later) is also supported. 

Devices 
This option will output a video format with settings designed for the selected device. 

Other 
Standalone Show – This output also supports a Menu, like Blu-ray / DVD output. It creates a file that can be 

played through the Photopia Player application on Windows and Mac computers. The Photopia Player 

application is available from the Downloads section of the Photopia website at no charge. 

Still Frames – This option creates one or more still images based on the selected settings: Capture current 

frame, Capture one frame per slide, Capture one frame per specified time. These still images can be saved 

as JPEG or PNG files at a custom resolution. 

 

Favorites 
Photopia provides the ability 

to set certain publish settings 

as Favorites, for easier access. 

Select the Publish Option you 

want to use as a Favorite then 

click the Favorites button at 

the bottom of the window to 

add it to the list. 

 

 

 



 

 

Creating a Menu 
Three output options provide the ability to create a Menu: DVD, Blu-ray, and Standalone Show. These are 

also the only options that support publishing multiple slide shows from the same Project in a single output. 

 

There are three tabs at the top of each of these output windows. The Menu tab is where you will determine 

what your menu looks like. The Shows tab allows you to set thumbnails and titles for the shows in your 

menu. The Options tab is where you can choose settings specific to that output format. 

 

 

Themes & Layouts 
 

Beneath the preview window on 

the Menu page, you will see a 

horizontal list of Themes. Below 

that is a horizontal list of Layouts. 

The chosen Layout should match 

the number of slide shows in the 

project. You can choose to have 

your shows represented by 

thumbnails or text only. Once you 

have chosen the desired layout, 

you can choose a theme. 

 

 

 

 

Settings 
 

Settings is where you can change the Menu Title, 

which defaults to a Show Title. You can also 

change the Aspect Ratio, Background Image and 

the Highlight and Selection colors. The highlight 

color will appear around a thumbnail when the 

user has highlighted that show. The selection color 

will appear around a thumbnail when the user has 

selected to play that show. 

 



 

 

 

 

 

 

 

 

 

Music 
 

You can add music to play while your 

menu is on screen before playing a show. 

This is separate from the Soundtrack in the 

slide show(s), although you can choose 

one of the same songs. You can also trim 

the song that will play on the menu. 

 

 

 

Customizing Your Menu 
Click the customize icon beneath the Music Settings to make further customizations to the menu. This will 

launch a new window that should look familiar. 



 

You can customize everything in your menu in the same way that you would customize a slide, keeping in 

mind that your menu is not animated. There is a Layers List on the left for you to select different elements in 

your menu and customize them, add, and remove layers. The two additions to the Menu Editor Page are the 

ability to add pages to your menu (like adding slides, but they are static and not animated) and Navigation. 

Navigation 

 

Navigation is how your audience will use their remote control to move around your menu. As you select each 

layer in the Layers list, you will see options for what should happen when each button on the remote is 

pushed. You can keep the default choices or change what happens for any of those buttons. 

Output Queue 
The Output Queue allows you to set multiple shows to publish and put them in a Queue to render later.  



 

Click the Publish option from the list on the left to put a show into the publishing queue. Ensure all the 

settings are as you want them to be then click the Queue button at the bottom. The Queue list is collapsible 

and located on the right side of the Publish window. You will choose a save location and file name, depending 

on the Publish option chosen. Once a show or project is in your Queue, you can close this window, open 

another Project, and add another show to the Queue. You can also add the same show to the Queue more 

than once to render it in different formats. 

 

 

 



You will see your shows appear in the queue list on the right side of the Publish window. You can change the 

order in which your shows are published, start publishing all shows in the queue, clear the list, and see the 

Publish History. 

 

If you have shows in the Queue, you will also see this list appear on the right side of your Home Page. Once 

you have started to render shows in the Queue you can then go back and continue to work on other slide 

shows while the Queue processes that output in the background. 

 

Appendix A: Image File Extensions 
 

   bmp 

    ico 

    jpg 

    jpeg 

    j2k 

    jpeg2k 

    jpg2k 

    pbm 

    pgm 

    png 

    tiff 

    tif 

    targa 

    tga 

    psd 



    jfif 

    heic 

    heif 

    jpe 

    nef 

    cr2 

    crw 

    arw 

    fff 

    dng 

    erf 

    raw 

    kdc 

    mrw 

    orf 

    rw2 

    pef 

    srw 

    3fr 

Appendix B: Video File Extensions 
 

    mp4 

    mpeg4 

    mpg 

    mpeg 

    mpeg2 

    mov 

    webm 

    wmv 

    hevc 

    3gp 

    3g2 

    asf 

    avi 

    dirac 

    dv 

    flic 

    flv 

    gif 

    h264 

    m4v 

    mkv 

    mjpg 



    mjpeg 

    mts 

    mpegts 

    ts 

    m2ts 

    nut 

    ogg 

    ogv 

    rm 

    rv 

    vcd 

    vob 

Appendix C: Audio File Extensions 
 

    wav 

    mp2 

    mp3 

    aac 

    m4a 

    ac3 

    aiff 

    aif 

    asf 

    au 

    dts 

    flac 

    gsm 

    oga 

    spx 

    wma 

    m4p 

    ogg 

Appendix D: Keyboard Shortcuts 
 

Toggle Zoom Window : Shift+Ctrl+Alt+Z 

Close Window : Escape 

Undo: Ctrl+Z 

Redo: Shift+Ctrl+Z 

Copy : Ctrl+C 

Cut : Ctrl+X 

Paste : Ctrl+V 



Delete : Delete 

Select All : Ctrl+A 

Select None : Ctrl+Alt+A 

Select Inverse : Ctrl+I 

Preferences : Ctrl+F1 

Cycle Time View : F2 

Play Show : Space 

Play Slide : Shift+Space 

Slide Number : Ctrl+G 

Next Flagged Slide : Ctrl+Alt+G 

Previous Flagged Slide : Shift+Ctrl+G 

Help : F1 

Toggle Flag on Selected Slides : Ctrl+F 

Clear all Flags : Shift+Ctrl+F 

Insert Blank Slide : Alt+B 

Insert Title Slide : Ctrl+Alt+B 

Shift Slide(s) to Left : Shift+CommaLessThan 

Shift Slide(s) to Left : CommaLessThan 

Shift Slide(s) to Right : Shift+PeriodGreaterThan 

Shift Slide(s) to Right : PeriodGreaterThan 

Reset Slide : Shift+Ctrl+R 

Show Settings : Ctrl+H 

Edit Background : Shift+Ctrl+B 

Edit Watermark : Shift+Ctrl+W 

Soundtrack : Ctrl+M 

Open Project : Ctrl+O 

Save Project : Ctrl+S 

Save Project As : Ctrl+Alt+S 

Close Project : Ctrl+Alt+C 

 


